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INTRODUCTION 
 

EDA742 Application of Management Information Systems in Education 

is a 700 level, second semester course. It is a three credit unit course for 

all students offering M. Ed. Administration and Planning. The course is 

also suitable for anyone who wants to learn about the application and 

usage of Information Technology to everyday activities. 

 

The course exposes you to an understanding of many of the concepts of 

Management Information Systems (MIS) and its application in the 

administration of educational institutions. It will also assist school 

administrators to be able to apply these concepts to the tasks and roles 

that they perform as school heads and chief executives in the education 

sector. 

 

The course consists of sixteen units in three modules and a course guide. 

The course takes you through the meaning, overview and basic concepts 

of information systems in education as well as the meaning of computer, 

classification of computers, composition of a computer, windows 

operating system, windows screen layout, electronic word processing 

using Microsoft Word, text formatting and editing tables in word, 

formatting and editing of worksheet data, management of spreadsheet 

with the use of Microsoft Excel, the use of e-mail facilities and how to 

disseminate information with the use of internet services; the usefulness 

of database to educational institutions and how to connect computer 

systems to a network as well as the application of all these to 

educational institutions in the country.  

 

This course guide tells you briefly what the course is all about, what 

course materials you will be using and how you will work your way 

through these materials. It suggests some general guidelines for the 

amount of time you should spend on each unit of the course for its 

successful completion. 

 

The course guide also gives you some guidance on your tutor-marked 

assignment which will be available at the end of every unit. There are 

regular tutorial classes that are linked to the course at designated centers 

throughout the country. You are advised to attend tutorial sessions at 

designated centre close to you. 

 

WHAT YOU WILL LEARN IN THIS COURSE 
 

The overall aim of EDA742-Application of Management Information 

Systems in Education is to introduce basic concepts of Information 

Systems and acquaint you with some important skills needed for the 
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application of Information Technology to the day-to-day activities in 

educational organisations. 

 

An understanding of the Application of Management Information 

Systems in Education is vital because it serves as a framework for the 

application of Information Technology to administration and other 

school activities. From time-to-time, Educational administrators need to 

make decisions, which will interpret the policies and programmes of 

government of the country as they affect educational institutions.  

During this course, you will learn about Information Systems as a 

concept and the roles expected of educational administrators in applying 

information systems to daily school activities, such as school records, 

students’ enrolment, t out ratio, income and expenditure of the school. 

 

The course will expose you to an understanding of various types of 

management support systems available for educational managers which 

can assist in arriving at a decision without time wastage. Specific 

reference will be made to other uses of Information Technology.  

 

COURSE AIMS 
 

The aim of the course can be summarised as follows: to provide students 

with an understanding of the concepts which underlie the use of 

information technologies for organisations; to enable students to 

evaluate the appropriate usage of information technologies, to analyse 

the influence of information technologies to educational organisations, 

and to plan and manage the security of data and systems. The course 

also aims to: 

 

 explain the meaning of Management Information System and 

basic concepts of Management Information Systems in 

Education; 

 provide ways of reducing the complexity of information systems 

in educational organisation to the barest minimum; 

 explain information technology (IT) in relation to education; 

 describe in details the basic related IT tools such as computer, 

networks and e-mails as they affect information in educational 

management; 

 outline the methods of editing and formatting worksheet data 

using Microsoft Excel; 

 explain the meaning and uses of Window Operating System; 

 highlight the features of Microsoft Excel screen layout; 

 introduce students to how to use Microsoft Excel to draw charts 

and graphs; and 

 introduce you to how to use computer for internet purposes. 
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COURSE OBJECTIVES 

 
To achieve the aims set out, the course sets overall objectives. Each unit 

also has specific objectives at the beginning of the unit; you should read 

them carefully before you start working through the unit. You may want 

to refer to them during your study of the unit to check on your progress. 

You should also look at the unit objectives after completing a unit. In 

doing so, you will be sure that you have followed the instructions in the 

unit.  

 

Below are the wider objectives of the course as a whole. By meeting 

these objectives, you should have achieved the aims of the course. 

 

At the end of this course, you should be able to: 

 

 define management, information and systems 

 list the various managerial levels and their functions 

 distinguish between data and information 

 identify the characteristics of good information 

 define management information systems 

 mention the characteristics of management information systems 

 highlight the objectives of management information system 

 list the factors to be considered when designing management 

information systems 

 state the problems of management information systems and 

solutions to the identified problems 

 state the issues addressed by MIS 

 explain Technology for management reforms 

 identify institutional goals of MIS 

 define Information Technology 

 explain application, of IT in Information Management 

 define a computer 

 classify computers based on type, size/capacity, and nature of 

location 

 mention the structure of a computer 

 explain the component and configuration of a computer 

 lists the various parts of a computer 

 explain the meaning of a computer virus 

 define computer hardware and software 

 describe what is meant by Booting 

 list the procedure of shutting down the computer system 

 define Window Operating system 

 recognise the window environment 

 identify a computer mouse 
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 identify the basic techniques on how to use the mouse 

 distinguish between menu and menu conventions 

 explain the meaning of a shortcut and how to create shortcut 

 demonstrate how to open an icon and differentiate between 

selecting and 

 choosing an icon 

 define a dialog box 

 define windows, label its different parts, and practice how to 

minimise, restore, maximise, close and resise a window 

 explain how to use the scroll arrow and scroll box 

 change the background or wallpaper and screen saver of a 

window 

 set the date of a computer 

 define Microsoft word and how to load it 

 recognise the screen layout and the features 

 identify toolbar and how to arrange them 

 differentiate between active and inactive commands 

 explain how to set up a page before creating a new document 

 creating a new document, save and open it 

 demonstrate how to save and open a file in a removable disks 

 explain how to select text 

 format text in terms of font, size, style, alignment 

 spell check a document 

 find and replace text and find synonyms of words 

 show how to space lines of text  

 copy, cut and paste text 

 explain how to redo and undo commands 

 insert page number and create header and footer 

 insert table and enter text into a table 

 select table and other parts such as columns, rows and cells 

 insert and delete columns and rows whenever there is need 

 show how to direct text in table's cell vertically and alignment 

cells entries 

 adjust row height and column width to fit the text 

 show how to sort table, data either in ascending order 

 split/merge table’s cells to give more information 

 explain how to apply boarders to a table 

 apply colours shading to text in order to create distinctive 

emphasis 

 apply page boarder to make the document look attractive 

 create a file in word pad 

 define a recycle bin 

 rename and delete file or folder 

 print a document 
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 define spread sheet management and give the definition of             

MS-Excel 

 load Excel and recognise the Welcome Screen environment and 

features 

 define columns, rows, workbook, worksheet cells and range of 

cells 

 enter worksheet data to create a document 

 explain how to edit the content of a cell 

 adjust columns' width and rows' height 

 select various parts of a worksheet such as columns, rows, cells 

range 

 demonstrate how to delete columns and rows 

 insert rows and columns and worksheet 

 explain the term e-mail 

 mention the requirements for e-mail and e-mail sites 

 describe the procedure of how to open and activate e-mail 

 explain how to sign-in, compose a message, reply to message and 

sign out 

 list the benefit of e-mail 

 insert rows, columns into a worksheet 

 insert a new worksheet and rename worksheet 

 protect and delete a worksheet 

 hide and unhide column and rows 

 fill preset data 

 align worksheet data 

 change the orientation of text 

 practicalise how to paste, copy or cut cells entries 

 sort data either in ascending or descending order 

 show how to assign number format 

 apply border to selected cells 

 use header and footer for more information 

 show how to insert charts 

 mention the different parts of a chart 

 select chart items 

 format the different parts of a chart 

 define database and DBMS 

 identify parts of a database 

 create a database and edit it 

 define format and know types of formula in excel 

 describe samples of excel formula 

 use AutoSum to sum up 

 define Network 

 list the benefits of Network in Education 

 give brief history of internet 
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 define internet  

 highlight the types of internet connection 

 explain the addressing system on the internet 

 distinguish between internet and World Wide Web (www) 

 mention the importance of internet in MIS to education; and 

 list the various terms associated to www and internet.  

 

WORKING THROUGH THIS COURSE 
 

Apart from Module 1 which is theoretical in nature, Modules 2 & 3 are 

more of practical. This makes MIS in education to be different from 

other education courses. Therefore, you are advised to have a personal 

computer (PC) to enjoy the full benefits of the course. The practical 

exercises are organised using a simple "Desktop PC" which may be 

slightly different from other types of computers such as laptop, palmtop, 

etc. The obvious slight difference is on the use of keyboard and mouse. 

For example, using the laptop mouse to drag will not be so easy for an 

amateur. However, as the saying goes – "practice makes perfect".  

However, you can fix external mouse like that of the desktop to your 

laptop if you are finding it extremely difficult to click and drag with the 

attached mouse. 

 

 

To complete this course, you are required to read all the study units in 

the study material, read the set books and other materials provided by 

the National Open University of Nigeria (NOUN). You are also 

expected to familiarise yourself with a computer laboratory for 

necessary experience and skills needed for the course. Each unit has self 

assessment practice exercises, and at regular intervals in the course, you 

are required to submit assignments/exercises for assessment purposes. 

At the end of the course, is a final examination. The course should take 

you about 17 weeks in total to complete. Below, you will find listed all 

the components of the course, what you have to do and how you should 

allocate your time to each unit in order to complete the course 

successfully on time. 

 

COURSE MATERIALS 
 

The major components of the course are: 

 

1. Course guide 

2. Study units 

3. Textbooks 

4. Assignment files 

5. Presentation schedule 
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STUDY UNITS 
 

There are 16 units in this course, and they are as follows:  

 

Module 1 

 

Unit 1   Overview of Management Information Systems in  

  Education 

Unit 2 Meaning of Management Information Systems (MIS) 

Unit 3 Information Technology (IT) and MIS in Education 

Unit 4 IT and MIS in Education: Computer Appreciation  

Unit 5    Computer Appreciation Continued: Hardware and  

  Software 

  

Module 2  

 

Unit 1   IT and MIS in Education: Windows Operating System 

Unit 2   Windows Operating System Continued: Windows Screen 

  Layout 

Unit 3   IT and MIS in Education: Computer Electronic Word  

  Processing using MS-Word (MS-Word Screen Layout  

  and Features) 

Unit 4  Microsoft Word (MS-Word) Continued: Text Formatting 

  and Editing 

Unit 5   Microsoft Word Continued: Tables in MS-Word 

Unit 6  Microsoft Word Continued: More Formatting, Editing and 

  Printing 

 

Module 3 

 

Unit 1  IT and MIS in Education: Computer Spreadsheet  

  Management Using MS-Excel, Excel Welcome Screen 

  and Features 

Unit 2   MS-Excel Continued: Formatting and Editing of  

  Worksheet Data  

Unit 3  MS-Excel Continued: More on Formatting and Editing of 

  Worksheet Data 

Unit 4  Microsoft Excel Continued: Database 

Unit 5  Microsoft Excel Continued: Chart 

 

 

TEXTBOOKS AND REFERENCES 
 

Each unit has a list of recommended textbooks and materials. Go 

through the recommended textbooks and materials for necessary 

assistance while going through the unit and before attempting the 
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exercises. Where you think you cannot find the necessary references that 

have been quoted in any of the units, just go on-line and type in the 

name of the author on Google, it will bring out all the available works of 

that author and I’m sure you will find the ones you are looking for. 

 

ASSESSMENT  
 

There are three aspects to the assessment of the course; the first is the 

self assessment/practice, the second is the tutor-marked assignments; 

and the third is the end of the semester written examination. 

 

In tackling the assignments, you are advised to be sincere in attempting 

the exercises/practices; you are expected to apply the information, 

knowledge and techniques gathered during the course. The assignments 

must be submitted to your tutor for formal assessment in accordance 

with the deadlines set by the authority of National Open of Nigeria 

(NOUN). The tutor-marked assignments you submit to your tutor will 

count for 40% of your total course mark. 

 

At the end of the course, you will need to sit for a final written 

examination of three hours duration. This examination will also count 

for 60% of your total course mark. 

 

TUTOR-MARKED ASSIGNMENT 
 

There are eighteen (18) tutor-marked assignments in this course. You 

are advised to submit all the assignments in which case, the best four 

will be counted for you. Each assignment counts 10% towards your total 

course mark. 

 

Assignment questions/Practice Exercises for the units in this course will 

be contained in the Assignment File. You will be able to complete your 

assignments from the information and materials contained in your 

reading, references and study units. However, it is desirable in all degree 

level education to demonstrate that you have read and researched more 

widely than the required minimum. Using other references will give you 

a broader viewpoint and may provide a deeper understanding of the 

subject. 

 

When you have completed each assignment, send it together with the 

TMA (Tutor-Marked Assignment) form, to your tutor. Make sure that 

each assignment reaches your tutor on or before the deadline set by the 

authority of National Open University Nigeria (NOUN) which will be 

made known to you through your study center. If for any reason, you 

cannot complete your work on time, contact your tutor before the 

assignment is due for submission to discuss the possibility of an 
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extension. Extension will not be granted after the due date except in 

exceptional circumstances. 

 

COURSE OVERVIEW 
 

Units Titles of Work Number of 

Weeks to 

Spend 

 Course Guide 1 

Module 1 

1 & 2 Overview of Management Information 

Systems in Education and Management 

Systems 

1 

3 Information Technology and MIS in 

Education 

1 

4 & 5 IT and MIS in Education and Computer 

Appreciation – Hardware and Software 

1 

Module 2 

1 IT and MIS in Education: Windows 

Operating System 

1 

2 Windows Operating System Continued: 

Windows Screen Layout 

1 

3 IT and MIS in Education: Computer 

Electronic Word Processing using MS-

Word – MS-Word Welcome Screen and 

Features 

2 

4 Microsoft Word (MS-Word):Text 

Formatting Editing 

1 

5 Microsoft Word Continued: Tables in MS-

Word 

2 

6 Microsoft Word: More Formatting, 

Editing, and Printing 

1 

Module 3 

1 IT and MIS in Education: Computer 

Spreadsheet Management using MS-

Excel, Excel Welcome Screen and 

Features 

2 

2 MS-Excel Continued: Formatting and 

Editing of Worksheet Data 

1 

3 MS-Excel Continued: More on Formatting 

and Editing of Worksheet  Data 

1 

4 & 5 MS-Excel Continued: Database and 

Charts 

1 

Total 17 
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Each study unit consists of one to two weeks work, and includes 

introduction, objectives, reading materials, exercises, conclusion, 

summary, tutor-marked assignments (TMAs) and marking scheme, 

references/further readings.  In general, these exercise/practice 

questions, test you on the materials you have just covered and to 

reinforce your understanding of the materials. Together with the tutor- 

marked assignments, these exercises will assist you in achieving the 

stated learning objectives of the individual units and of the course. 

 

FINAL EXAMINATION AND GRADING 
 

The final examination for this course will be of three hours’ duration 

and have a value of 60% of the total course grade. The examination will 

consist of questions, which reflect the types of self-assessment exercises 

and tutor-marked assignments you previously attempted. All areas of the 

course will be assessed. 

 

Make sure you revise the entire course very well before sitting for the 

final examination. You will find it useful to review your self-assessment 

exercises, tutor-marked assignments and the comments on them before 

the examination. The final examination covers information from all 

parts of the course. 

 

HOW TO GET THE MOST FROM THIS COURSE 

 
In distance learning, the study units replace the university lecturer. This 

is one of the great advantages of distance learning. You can read and 

work through specially designed study materials at your own pace, and 

at a time and place that suit you best. Think of it as reading the lecture 

instead of listening to a lecturer. In the same way that a lecturer might 

set you some reading to do, the study unit will tell you when to read 

other materials. Just as a lecturer might give you an in-class exercise, the 

study units provide exercises for you to do at appropriate time. 

 

Each of the units follows a common format. The first item is an 

introduction to the subject matter of the unit and how a particular unit is 

integrated with the other units and the course as a whole. 

 

Next is a set of learning objectives. These objectives let you know what 

you should be able to do by the time you have completed the unit. You 

should use these objectives to guide your study. When you have finished 

the unit you must go back and check whether you have achieved the 

objectives. If you make a habit of doing this, you will significantly 

improve your chances of passing the course. 
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The main body of the unit guides you through the required reading from 

other sources. This will usually be either from a Reading Section of 

some other sources.  

 

Self-help practices are interspersed throughout the end of the units. 

Working through these practices will help you to achieve the objectives 

of the unit and prepare you for the assignments and examination. You 

should do each self-test exercise as you come to it in the study unit. 

 

There will also be numerous examples given in the study units, work 

through these when you come to them too. 

 

The following is a practical strategy for working through the course. If 

you run into any trouble, telephone your tutor. Remember that your 

tutor’s job is to assist you when you need help, therefore do not hesitate 

to call and ask your tutor to assist you. 

 

 Read through this course guide thoroughly. 

 

 Organise a study schedule. Refer to the course overview for more 

details. Note the time you are expected to spend on each unit and 

how the assignments relate to the units. Important information 

e.g. details of your tutorials, and the date of the first day of the 

semester will be made available through the study centre.  You 

need to gather all these information in one place, such as your 

diary or a wall calendar. Whatever method you choose to use, 

you should decide on and write in your own dates for working 

through each unit of the course. 

 

 Once you have created your own schedule, do everything you can 

to stick to it. The major reason that students fail is that they get 

behind with their course work. If you get into difficulties with 

your schedule, please keep your tutor informed before it is too 

late for help. 

 

 Turn to Unit 1 and read the introduction and the objectives for the 

unit. 

 

 Assemble the study materials. Information about what you need 

for a unit is given in the "Overview" at the beginning of each unit; 

you will always need both the study unit you are working on and 

the one on your references, on your desk at the same time.  

 

 Working through the unit. The content of the unit itself has been 

arranged to provide a sequence for you to follow. As you work 
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through the units, you will be instructed to read sections from 

your other sources. Use the unit to guide your reading. 

 

 Well before the relevant due date, check your assignment file and 

make sure you attend to the next required assignment. Keep in 

mind that you will learn a lot by doing the assignments carefully. 

They have been designed to help you meet the objectives of the 

course and, therefore, will help you pass the examination. Submit 

all assignment not later than the due date.  

 

 Review the objectives for each study unit; confirm that you have 

achieved them. If you feel unsure about any of the objectives, 

review the study material or consult your tutor. 

 

 When you are confident that you have achieved a unit's 

objectives, you can then start on the next unit. Proceed unit by 

unit through the course and try to face your study so that you 

keep yourself on schedule. 

 

 When you have submitted an assignment to your tutor for 

marking, do not wait for its return before starting on the next unit. 

Keep to your schedule. When the assignment is returned, pay 

particular attention to your tutor's comments, both on the tutor-

marked assignment form and also on the comments written on the 

assignment. Consult your tutor as soon as possible if you have 

questions or problems. 

 

 After completing the last unit, review the course and prepare 

yourself for the final examination. Check that you have achieved 

the unit objectives (listed at the beginning of each unit) and the 

course objectives (listed in the course guide). 

 

FACILITATORS/TUTORS AND TUTORIALS 

 
There are tutorial hours provided by the National Open University of 

Nigeria (NOUN) in support of this course. You will be notified of the 

dates, time and location of these tutorials, together with the names and 

telephone number of your tutor, as soon as you are allocated a tutorial 

group.  

 

Your tutor will mark and comment on your assignments, keep a close 

watch on your progress and on any difficulties you might encounter and 

provide assistance to you during the course. You must submit your 

tutor-marked assignments to your tutor well before the due date. They 

will be marked by your tutor and returned to you as soon as possible. Do 

not hesitate to contact your tutor by telephone, e-mail, or discussion 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

154 

 

board if you need help. The following might be circumstances in which 

you would find help necessary. 

 

Contact your Tutor if: 

 

 You do not understand any part of the study units or the assigned 

readings. 

 You have difficulty with the self-test or exercise. 

 You have a question or problem with an assignment you have a 

question with your tutor’s comment on an assignment or with the 

grading of an assignment. 

 

You should try your best to attend the tutorials. This is the only chance 

to have face-to-face contact with your tutor and to ask questions which 

are answered instantly. You can se any problem encountered in the 

course of your study. To gain the maximum benefit from course 

tutorials, prepare a question list before attending them. You will learn a 

lot from participating in discussion actively. 

 

SUMMARY 
 

EDA742 (Application of Management Information Systems in 

Education) intends to introduce the concepts and theories of 

Management Information Systems in Education to you. Upon 

completion of this course, you will be equipped with the basic 

knowledge of the important concepts of management information 

systems and the importance of information technology to educational 

administration. 

 

Upon completion of the course, you will be able to answer these kind of 

questions: 

 

 What is Management Information System? 

 What are the functions of information in an organisation? 

 What are the challenges of Management Information Systems in 

Education in Nigeria? 

 What is data transmission? 

 What is the difference between Half-Duplex and Duplex under 

data? 

 How can we categorise computer? 

 What are the similarities between computer virus and animal 

virus? 

 What is the name of part of the scroll bar you should use if you 

intend to scroll fast? 
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 What is the name of the bar you will use to carry a dialog box or 

a window? 

 Which keys are peculiar to a computer keyboard that is not in the 

manual typewriter keyboard? 

 How can you save file in a new diskette? 

 Mention three external hard disc you can use as a back-up for 

your files. 

 How can you select a single word with the mouse? 

 What is the keyboard shortcut for double and single lines 

spacing? 

 How can you insert l0 X 6 tables to reveal information of 

students in various subjects? 

 What is the distinguishing factor between a workbook and a 

worksheet? 

 Which keyboard will you press if you want to see the last row 

and column? 

 Mention some e-mail sites that offer free e-mail services to 

individuals? 

 What are the disadvantages of deleting a worksheet from a 

workbook? 

 What are the limitations to be encountered when using the sort 

icon on the standard tools bar to sort a data base? 

 What are the functions of DBMS? 

 What is a web page and hyperlink? 

 

Indeed, the list of questions that you can answer is not limited to the 

above. To gain the most from this course, you should try to apply the 

principles and concepts of management information systems to the 

practice of administration of educational institutions.  

 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

156 

 

 

 

 

 

 

 

CONTENTS        PAGE 

 

Module 1………………………………………………… 1 

 

Unit 1   Overview of Management Information  

  Systems in Education…………………….. 1 

Unit 2 Meaning of Management Information  

 Systems (MIS)…………………………….. 14 

Unit 3 Information Technology (IT) and MIS in 

 Education………………………………….. 24 

Unit 4 IT and MIS in Education: Computer  

 Appreciation………………………………..  31 

Unit 5    Computer Appreciation Continued:  

  Hardware and Software……………………. 37 

  

Module 2…………………………………………………… 54  

 

Unit 1   IT and MIS in Education: Windows  

  Operating System…………………………… 54 

Unit 2   Windows Operating System Continued: 

   Windows Screen Layout……………………. 68 

Unit 3   IT and MIS in Education: Computer  

  Electronic Word Processing using  

  MS-Word (MS-Word Screen Layout  

  and Features)………………………………… 78 

Unit 4  Microsoft Word (MS-Word) Continued:  

  Text Formatting and Editing………………… 100 

Unit 5   Microsoft Word Continued: Tables in  

  MS-Word……………………………………… 118 

Unit 6  Microsoft Word Continued: More  

  Formatting, Editing and Printing…………….. 133 

 

Module 3…………………………………………………….. 142 

 

Unit 1  IT and MIS in Education: Computer  

  Spreadsheet Management Using MS-Excel,  

  Excel Welcome Screen and Features………….. 142 

Unit 2   MS-Excel Continued: Formatting and  

  Editing of Worksheet Data…………………… 158  

 

MAIN 

COURSE 



EDA742           MODULE 3 

 

157 

 

 

Unit 3  MS-Excel Continued: More on Formatting 

  and Editing of Worksheet Data……………….. 173 

Unit 4  Microsoft Excel Continued: Database………… 186 

Unit 5  Microsoft Excel Continued: Chart…………….. 206 

 

 

 

 

 

 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

158 

 

MODULE 1  
 

Unit 1 Overview of Management Information Systems in 

Education 

Unit 2 Meaning of Management Information Systems (MIS) 

Unit 3 Information Technology (IT) and Management 

Information Systems (MIS) in Education 

Unit 4 Information Technology (IT) and MIS in Education: 

Computer Appreciation 

Unit 5 Computer Appreciation Continued: Hardware and 

Software 

 

 

UNIT 1 OVERVIEW OF MANAGEMENT 

INFORMATION  SYSTEMS IN EDUCATION 
 
CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 Management 

  3.1.1 Process 

 3.2 Managerial Functions  

 3.3 Levels of Management 

  3.3.1 Top or Strategic Level of Management 

  3.3.2 Middle or Tactical Level of Management 

  3.3.3 Lower or Operational Level of Management 

 3.4 System 

  3.4.1 Open Systems 

  3.4.2 Close Systems 

 3.5 Data 

  3.5.1 Data Processing 

  3.5.2 Stages of Data Processing 

 3.6 Information 

  3.6.1 Characteristics or Attributes of Good Information 

  3.6.2 Forms of Information 

  3.6.3 Functions of Information 

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 



EDA742           MODULE 3 

 

159 

 

1.0 INTRODUCTION 

 
In the present day educational system, management information system 

cuts across all disciplines, from accounting to medicine, pharmacy, 

engineering, banking, administration, education etc. We must bear in 

mind that in the application of management information system in 

education, we are dealing with the concept of management and 

technology, and how we can harmoniously use the duo to achieve 

effective medium for analysing educational information.  

  

Therefore, this aspect of the course serves as a preamble for you to 

know the rudiments of the course. 

 

2.0 OBJECTIVES 

 
At the end of this unit, you should be able to: 

 

 define management, information and systems 

 list managerial levels and functions 

 distinguish between data and information 

 describe how data are processed to give information 

 identify the characteristics of good information and functions of 

information. 

 

3.0 MAIN CONTENT 
 

3.1 Management 
 

Like most terms in the social sciences, no definition has been universally 

accepted in relation to management. However, some scholars and 

practising managers have all attempted to provide definitions- based on 

their understanding of the prevailing situation. Some define management 

as the force that runs an enterprise and others claim that management is 

conceiving and achieving desired result by means of group effort, by 

utilising human talents, resources and skills. Others state that 

management is the satisfaction of economic and social needs through 

production as a result of human efforts. Others summarise management 

as planning and implementation. 

 

According to Leon Magison et al. (1983), “Management is working with 

people to determine, interpret, and achieve organisational objectives by 

planning, organising, leading, controlling and staffing.” It is important to 

know that Henry Fayol’s, definition (Cole: 1986) is closely related to the 

above definition. Fayol was the first to give comprehensive and 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

160 

 

summarised definition of management. He defined management as: “to 

forecast, plan, organise, command, coordinate and control”. 

 

In Fayol’s view, to forecast and plan means to examine the future and 

draw up a plan of action. To organise, means building a structure of both 

material and human resources in an organisation. To command means 

maintaining activities among employees. To control, means to ensure 

everything is in conformity with the plan and standard. Therefore, 

management is the process of planning, organising, leading and 

controlling the effort of organisational members and using all other 

resources to achieve stated organisational goals. 

 

3.1.1 Process 
 

A process is a systematic way of doing things; hence, we define 

management as a process because all managers, regardless of their 

particular attitude or skill, engage in certain related activities in order to 

achieve their objectives.  

 

In order to achieve the objectives of the organisation, it is necessary to 

bring together all available resources called “six Ms” of management i.e. 

men, machine, material, methods, money and market. These resources 

are brought together in harmony so that the end result may be 

accomplished by all within the determined constraint of time, effort and 

cost. 

 

3.2 Managerial Functions 
 

The major functions of management include the following: 

 

Planning 
 

Planning is the first of the five basic managerial functions. It is argued to 

be the most important function of a manager. Planning, therefore, means 

setting objectives and determining what should be done to accomplish 

them, i.e. today’s design for tomorrow’s action. Planning is an applied 

problem solving and decision making efforts through which managers 

act to ensure the future success of their organisation. It could be 

considered as, deciding in advance what to do, how to do it, where to do 

it, who should do it, and when to do it in order to achieve effectiveness 

at every level of responsibility. 

 

As a foundation of management process, planning identifies what should 

be done and set the stage for further managerial efforts at organising, 

leading and controlling. In other words, planning is the function that 

answers four questions. 
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1. Where are we now? – This question is concerned with assessing 

the present situation and forecasting how the situation may 

change in the future. 
 

2. Where do we want to be? – Answer to this question involves 

determining the desired objective in terms of the present and 

future 
 

3. What is the difference between where we are and where we want 

to be? 
 

4. How can we get there? – This question requires an outline of 

action and a careful analysis of future implication of present 

decision. 

 

Organising 
 

Harold Koontz (1980) defined organising as that part of management 

that involves establishing an intentional structure of roles for people to 

fill in an organisation. It is intentional, in the sense of making sure that 

all the tasks necessary to accomplish goals are assigned and especially, 

assigned to people who can do them best. 

 

Organising can be viewed as the process of identifying and grouping of 

work to be performed, by defining and delegating responsibility and 

authority and establishing relationship for the purpose of enabling 

people to work effectively together in order to accomplish the objective. 

 

In a simpler way, organising is the process of arranging people to work 

with one another towards their common goal. It implies first of all that 

there is a collection of people combining their effort to accomplish what 

none could do alone. This is sometimes referred to as synergy, i.e. the 

concept that the whole organisation as it works harmoniously and 

cooperatively is greater than some of its parts. 

 

Coordinating 
 

Coordinating is perhaps the closest word to a true synonymy of 

management. The challenge of coordinating is to capitalise on individual 

difference while maintaining control. Coordinating is therefore the 

function of management that involves harmonising and synchronising 

all efforts of individuals and units to achieve a common objective. 

 

Coordinating can also be seen as the process of integrating the 

objectives and activities of the separate units (departments or functional 

areas) of an organisation, in order to achieve the organisational goal, 

efficiently. Without coordination, individuals and departments will lose 
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sight of their role within the organisation. They will begin to pursue 

their own personal interest, often at the expense of the larger 

organisational goals.  

 

Commanding 
 

Another function of management is directing or leading. Commanding 

is influencing people so that they will contribute to organisation and 

group goals. A manager’s leading ability- i.e. manager’s ability to 

motivate, influence and communicate with subordinate will determine 

manager’s effectiveness. For managers to command effectively, three 

basic elements have to be considered jointly, namely- leadership, 

communication and motivation. 
 

1. Leadership- this means headship; people tend to follow those 

who offer means of satisfying their needs, wishes and desires. On 

the other hand, leadership is the relationship in which one person 

– the leader, influences others to work together willingly on 

related tasks to attain that which the leader desires. 
 

2. Communication- this deals with the acts of developing and 

attaining understanding. It can be verbal and non-verbal. 

Communication is a means to an end. It makes possible the 

management process and serves as a lubricant for a smooth 

operation. Effective communication enables manager to obtain 

data for decision making. 
 

3. Motivation- here, the focus is-how can I get my members to care 

more about their work? What kind of condition brings the best 

out of them? What motivates employees to do their best and 

derive their satisfaction from the work? Questions such as these 

are foremost in most managers’ mind. In the opinion of many, the 

key to performance is motivation. 
 

Motivation is the desire within an individual that stimulates him 

or her to action. Motivation of people deals with the way of 

removing conditions, which make people dissatisfied with their 

work. Each employee has his own acceptance zone. Instructions 

falling within this zone will be carried out to the best of his 

ability, while those outside it will be trampled or even sabotaged. 

The rule of motivation is to enlarge this zone. 

 

Controlling 

 
Management control is the process through which managers are sure 

that the actual activities conform to the planned activities. Controlling is 

making sure that everything happens according to plan. In the plan of an 
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organisation’s activities, the fundamental goals and the objectives and 

the method of attaining them are established. The control process 

measures progress towards these goals and enables managers to detect 

deviation from the plan in time and to take corrective action before it is 

too late. 

 

Staffing 
 

At times, some people will treat staffing separately as managerial 

function, while some will refer to it under coordination. However, 

staffing involves filling, and keeping the filled position in the 

organisation structure. This is done by identifying work-force 

requirement; recruiting, selecting, planning, promoting etc., candidates 

and current job holders to accomplish their task effectively and 

efficiently. 

 

SELF-ASSESSMENT EXERCISE  
 

Define the term management and vividly explain the functions of 

management. 

 

3.3 Levels of Management 
 

There are three levels of management in all formal organisations and 

there are clear differences in information requirements and decision 

making at each level. The three levels of management are: top or 

strategic management, middle or tactical management; and junior or 

operational management. Let us take a look at these. 

 

3.3.1 Top or Strategic Level of Management  
 

This is the peak of the management levels. It consists of the corporate 

officers that are elected by the board of directors. In the education 

industry, they are the ministers/commissioners appointed by the 

President/Governor, Chief Executive Officers (CEO), Chairman, 

General Manager and their deputies etc., for the ministries, parastatals 

and agencies. It has to do with policy formulation or gathering data to 

meet up with the prevailing situation in an organisation. In Nigeria for 

instance, policies on higher institutions, nomadic education, primary and 

post primary institutions are strategic policies. Also, Post UME Policy 

that was introduced in 2006 is an example of strategic policy.  

 

In summary, the functions of strategic level managers include: 

 

 formulating broad policies 

 working out long-range planning 
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 determining organisation objectives and goals 

 appointing other top level officers 

 authorising new facilities and launching research and 

development projects. 

 

3.3.2 Middle or Tactical Level of Management 
 

Middle level managers are in between the top and lower level managers. 

Managers at this level spend most of their time analysing data, preparing 

information for decisions and translating top level management overall 

policies and strategy into operational policies, procedures and methods 

of work. Vice Chancellors, Provosts, Rectors, Administrators, 

Principals, Proprietors/Proprietress of various schools are good 

examples of tactical managers. 

 

Tactical level management functions include: 

 

 assisting top level managers in executing their functions 

 transferring information and materials between different work 

groups 

 preparing plans and programs for various departments 

 management and control of activities of lower level manager. 

 

3.3.3 Lower or Operational Level of Management 
 

Operational level is the supervisory level. The supervisors do not 

manage other managers but spend more of their time with subordinates 

and peers to oversee the activities of the front line employees and ensure 

that they carry out their daily tasks as expected. The heads of 

departments (HOD) in schools are good examples of lower level 

managers in education. 

 

The operational level of management functions include: 

 

 directing all workers to accomplish their departmental goals 

 maintaining discipline and order 

 taking decisions to meet up with the challenges in his domain 

 executing the policies of top management level passed through 

middle level of management. 

 

3.4 System 
 

A system is a collection of interrelated parts, which form a whole. A 

system may be seen as a combination of interrelated elements, or sub-

systems, organised in such a way that the efficient functioning of the 
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system as a whole, is ensured, necessitating a high degree of 

coordination between the sub-system, each of which is designed to 

achieve a specified purpose. Systems are ‘synergistic’. Synergy is used 

to describe the concept, which states that the sum of a whole is greater 

than the sum of individual parts; examples include the human body, 

communication, information, railway etc. A system could be open or 

close. 

 

3.4.1 Open Systems 
 

Systems that receive inputs from the environment and sometimes return 

outputs to the environment are called open systems. A system is open if 

it imports various items from its environment, converts them into goods, 

services and waste materials and then exports them into the 

environment. 

 

Here, information is considered as an open system because it interacts 

with environmental factors such as social factors, economic situation, 

government influences, technology and physical environment (weather, 

location etc.) which form the inputs to give output in form of products, 

services, and ideas etc., to the environment again. 

 

3.4.2 Close Systems      
 

Systems that have sealed boundaries and do not receive input or produce 

output are close systems. They are independent of their environment. 

Close systems are required for stability and consistency, whereas open 

systems are required for uncertain conditions. Close systems are 

designed for efficiency, but open systems are designed for survival. 

 

 

 

  

 

 

 

 

Fig.1.1: Model of an Open System 

 

3.5 Data 
 

Data are raw facts or information yet to be processed i.e. unprocessed 

information. Data means raw facts in form of figures, specification, 

exam records, and admission list of students/workers, customer savings, 

sales figure, etc. It suffices to say that in order to harmonise all the 
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managerial functions, which could be seen as sub-systems, data have to 

be processed to get the needed information. 

 

3.5.1 Data Processing 
 

The entire trajectory of information processing, right from the input unit 

to the output unit, is referred to as Data Processing (DP). In other 

words, data processing is the term given to the process of collecting all 

items of data together to produce meaningful information. Data could be 

processed manually or electronically. However, when it is done on 

computers, it is known as Electronic Data Processing (EDP). For 

many years now the methods of DP have involved electronic means, 

principally, the computer. Subsequently, we shall concentrate on 

electronic data processing in view of our course of study, because it 

relies upon information technology and through it, other functions 

within an organisation can be integrated. 

 

However, EDP must be seen as one of the important areas in 

Information Technology (IT). It is the technology, which supports the 

activities involving the creation, storage, manipulation, and 

communication of information with their related methods, management 

and application. Data will pass through the same basic stages in the 

same circle, even though electronic, conventional or both methods are 

(is) used to process the data. Data processing stages can be summarised 

into what is called Data Processing System- as illustrated in the 

following figure.     

  

 

 

 

 

 

 

Fig.1.2: Data Processing System 

 

3.6 Information 

  

Information is the processed data, i.e. data that have been converted into 

more meaningful format through data processing. Good information is 

that which is encoded by the sender and decoded by the user the way 

and manner intended by the sender. For information to be good, certain 

characteristics must be present. We will look at these now. 

OUTPUT 
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PROCESSES 

(Including 
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3.6.1 Characteristics or attributes of good information 
 

As mentioned above, for information to be good, it must have the 

following features. 

Relevance- information must be relevant to the problem in question. It 

is a well known fact that reports, messages, tabulations etc., contain 

irrelevant parts which most often prevent the user of the information to 

get the actual meaning of what the sender wants. 
 

Accuracy- although absolute accuracy of information cannot be 

achieved, information should be sufficiently accurate for management 

reliance and for the purpose for which it is meant. 
 

Completeness- for management to make good decisions, information 

relating to that aspect should be complete. However, in practice, this is 

not often obtainable. Therefore, what is expected is that information is 

complete in relation to the key elements of the problem. This suggests 

that there should be interaction between information providers and users 

to ensure that the key factors are identified. 
 

Confidence in the source- the use of information determines its value; 

and managers use information when there is confidence in the source. 

Confidence is built when there is: 

 

a) past reliance on the source; and 

b) existence of good communication between the information 

producer and the manager. 

 

Communication to the right person- it is often common for 

information to be directed to the wrong level in an organisation. Since 

each administrator at different levels needs information to perform his 

duties and responsibilities, information suppliers should ensure that 

information goes straight to the right person and not to subordinates who 

may at times hold on to it for others to see how important he/she is in 

the organisation. 

 

Timing- for information to be good, it has to be communicated at the 

right time; hence, it will end up in the dust bin.  Information should be 

provided based on the frequency, which is related to the type of decision 

or activity involved. The intervals of passing information across may be 

longer at higher levels (strategic and tactical) than the lower level 

(operational). At the lower level information may be made available 

regularly for example, on a V.D.U. screen or on electronic boards.  
 

Detail- information should contain everything considered to be useful 

for effective decision making. This does not mean that users of 

information of whatever level must be overloaded with unnecessary 
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information; however information should be selectively filtered, 

summarised, edited and highlighted as appropriate as possible. 
 

Channel of communication- effective information is seen when the 

sender gets the feedback as intended. And the major determinants of 

accuracy of the feedback are the appropriateness of channels of 

communication involved. Therefore, adequate channel must be 

considered when disseminating information.  

 

Understandability- it has been said under the definition of data above, 

that what transforms data into information is understandability. For 

information to be good, it must be understood. 
     

 

3.6.2 Forms of Information 
 

There are various forms of information; some of them are discussed 

below: 
 

Formatted information- this kind of information includes 

alphanumeric items that have been arranged in a pre-specified format 

whereby the result of each item is defined in advance. For instance, a 

table that contains a student’s records in form of Name, Age, Class, 

Assessment, Exam, Total, Average, etc. 
 

Texts: information in form of text i.e. letters, numbers and symbol, 

could be combined in such a manner that immediate meaning and 

interpretation could be derived to give information. There is no 

prespecified format here. 
 

Images: Information that is generated through picture, basic shapes, 

photographs, and hand-drawn pictures. Example is an artist designs and 

drawings. 
 

Audio: This is information in the form of sound. For instance, a doctor 

might gather some information about an unconscious patient, just by 

listening to the sound of the stethoscope. 
 

Video: Video information combines the features of both image and 

audio information. That is information in form of sound and graphics. 

 

3.6.3 Functions of Information 
 

Means of Communication: Managers at all levels act on information to 

communicate with one another in order to know about developments, 

plans, forecasts, inherent changes etc, in the organisation. 
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Aid to monitoring and control: An organisation acts on information to 

know about performance and the extent of deviation from planned 

objectives and appropriate control measurements to be implemented. 

 

Reduction of uncertainty: The future of every organisation is oblique. 

Nobody knows what the future has to offer because of some 

environmental factors; however, information helps to reduce such 

uncertainties in the process of planning and decision making. For 

instance, planning to have tuition-free post primary institutions for the 

next twenty years is uncertain, because of some obvious factors such as 

population, economy, but information about such factors will help to 

reduce the uncertainties. 

 

Aid to simplification: Because information helps to reduce uncertainty, 

it then follows that problems and solutions are simplified and become 

more manageable. 

 

Memory Supplement: Information of past history helps to supplement 

the actions of managers. For example in Nigeria, free education, which 

was a manifesto of the Action Group (AG) party in the first republic, 

was implemented and it witnessed a huge success and the products were 

good in terms of knowledge. In the same vein, United Peoples Party 

(UPN) 1979 – 1984 implemented the same policy but it was only partly 

successful as their products were only average in terms of knowledge 

compared with those of the Action Group. 

 

Between 1999 and 2003, some states where the Alliance for Democracy 

Party (AD) ruled tried to implement the same free education policy, but 

their products were not as good in comparison with those from the 

earlier periods. 

 

Historical information such as the ones related above, could help any 

educational administrator in formulating policies and taking decisions 

on free education whenever he/she is called upon. 

 

SELF-ASSESSMENT EXERCISE  

 

1. Define the following terms – (i) Data  (ii) Information 

2.  What is data processing? 
 

4.0 CONCLUSION 
 

MIS exists in organisations in order to help them achieve their 

objectives, to plan, control and coordinate the six ‘Ms’ of management 

and meet with the challenges of the ever-changing environment 
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characterized by GETS (Government, Economy, Technology and 

Society). 

 

5.0 SUMMARY 
 

Management Information System is looked at as ways of processing 

data of an organisation into information, which is then used for accurate 

decision making at strategic, tactical and operational levels of 

management. 

 

6.0 TUTOR-MARKED ASSIGNMENT  
 

1. For information to be good, it must possess some characteristics. 

Discuss. 

2. Name the levels of Management known to you and write short 

notes on any two. 

3. What are the functions of information in an organisation? 
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1.0 INTRODUCTION 
 

This unit dwells on the details of what management information systems 

in education encompass.  

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 define Management Information Systems (MIS) 

 mention the characteristics of MIS 

 highlight the objectives of MIS 

 list the factors to be considered when designing MIS 

 state the problems with MIS and solutions to the problems 

 explain issues addressed by MIS in education 
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 explain Technology for management reforms 

 know institutional goals of MIS 

 discuss the role of MIS on the behaviour of educational 

managers. 

 

3.0 MAIN CONTENT 

 

3.1 Management Information System 
 

Harold et al., (1980), defined management information system as a 

formal system to gather, integrate, compare, analyse, and disperse 

information (internal and external) to the enterprise in a timely, effective 

and efficient manner. MIS is the combination of human and computer-

based resources that results in the collection, storage, retrieval, 

communication and use of data for the purpose of efficient management 

of operations and for business planning. 

 

At the strategic level of management, the manager needs information to 

plan the overall objective of the organisation. Tactical level managers 

need information to ensure that the resources of the organisation are 

effectively and efficiently utilised to achieve the strategic goals of the 

organisation. The frontline managers use operational information to 

ensure that specific tasks are planned and carried properly within the 

organisation.  

 

3.2 Objectives of MIS 

 

 Ensuring that all levels of management get the necessary 

information to carry out their managerial functions. 

 Improving the processes of decision making in the organisation. 

 Exposing members of an organisation to information technology 

(IT) through the use of computers to acquire and disseminate 

information as quickly as possible. 

 Helping to establish accurate database at all levels to meet 

specific needs of the organisation. 

 

3.3 Need for Management Information Systems 
 

Management requires information for the following reasons: 

 

 to establish, evaluate and adjust objective where necessary 

 to develop and plan standard 

 to measure actual performance so as to enable a comparison with 

plans and standards; and 

 to provide a basis for informed communication. 
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3.4 Characteristics of MIS 
 

 It is usually directed towards management of an organisation, be 

it formal or informal. 

 Data flow: MIS has common data flow 

 Data form sources of input, while information serves as output 

 MIS depends highly on database 

 MIS operates in areas of distributed data processing  

 It creates room for other subsystems to exist.   

 

3.5 The Design of MIS 
 

Many factors come to mind when designing MIS. Some of these factors 

include: 

 

 Behavioral Factor: Consists of the norms, attitudes, motivations, 

aspirations and capabilities of the people involved. For instance, 

in Nigeria MIS on compulsory levy in primary institutions might 

be jeopardised in some parts of the country because of their 

beliefs and attitudes. 

 Communication Channels: In order to make information 

available where and when needed, seminars, meetings, retreats 

etc have to be organised. 

 Computer Facilities: Computer and other data transmission 

should be made available to help in data processing. 

 Internet Facilities: If possible, it is ideal to be on network so as 

to have access to important information when designing yours. 

 Personnel: For effective data processing, competent personnel 

with qualitative computer knowledge might be needed to help in 

data processing. 

 Database: Simple database might be maintained to help in 

analysing information. 

 

SELF-ASSESSMENT EXERCISE 

 

Explain to a novice certain factors to be considered in designing MIS. 
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3.6  Problems with MIS and Solutions to the Problems 
 

Problems with MIS                                 Solutions to Problems of MIS 
Lack of Management Involvement: 
Most often the design of MIS is left in 

the hands of information specialists 

who may not know enough about 

management. At times they do not 

appreciate management’s true 

information requirements and of 

organisational problem. 

 

Management should try to participate 

in the designing of MIS by giving 

the designers clues of what the 

organisation actually needs. 

 

Lack of Top Management Support: 
Top management sometimes does not 

encourage MIS due to various reasons 

often based on fear of the unknown. 

 

Top management may not want their 

decisions to be challenged; thereby 

adhering to the slogan “this is how 

we have been doing it”. Top 

management should realise that the 

organisation’s success is mostly 

determined by the environmental 

factors; and it is information that will 

allow you to cope and manage the 

ever-changing environment. 

 

Lack of Computer Knowledge: It is a 

glaring fact that most administrators 

at all levels of management have little 

or no computer knowledge. 

Therefore, it is always difficult for 

them to assist MIS designers to 

acquire and disseminate information. 

 

Presently, among the best means of 

processing data, acquiring and 

processing information is the 

computer. Since computer is the 

major tool of information 

technology, all staff should try to 

have computer knowledge in order to 

help in achieving the success of MIS. 

 

Inappropriate Emphasis of 

Computer System: In some 

organisation too much emphasis is 

laid on the use of computer to the 

extent that other methods of 

information acquisition and 

dissemination are relegated to the 

background. 

 

Although, computers can assist in 

acquiring and disseminate 

information as quickly as possible, 

there are still limitations. Computer 

cannot be employed to know the 

behavioral factors, but it can be used 

to analyse the result in any form. In 

Nigeria, for example, the attitude 

toward Western education in both 

Northern and Western parts cannot 

be known by using the computer but 

the information can be analysed with 

the computer. 
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3.7 Issues Addressed by Management Information System in 

Education 
 

The aim and objectives of an educational institution and the number of 

activities in each institution will determined the type of management 

information systems to be developed or adopted for that institution. 

Within each functional area, the head requires constant flow of 

information in decision making and discharge their duties without any 

delay. Management information system therefore, is essentially the most 

crucial connecting link between the various management departments, 

functions or unit in any educational institution. 

 

Efforts to develop a good Management Information System for 

educational institutions give education manager the opportunity to 

assess the following set of crucial educational question: 

 

 What are the objectives of the educational system or the 

institution and what are the various functions and activities 

related to each of them? 

 What is the nature of the outcome or result expected from the 

activities? Is the educational institution working in a way to 

ensure good result? 

 What is the plan for the short/long term? Is the plan usable? 

 Will the current plan meet the present / future need of the student 

and the society? 

 What are the facilities available for the execution of the 

programmes? Are these facilities adequate? and 

 Are the existing operational budgets at the different level 

sufficient to cover the organisation functions anticipated? 

 

3.8 Technology for Management Reform 
 

With the introduction of Management Information Systems in Education 

in the school curricular, the education managers now adopt Management 

Information Technology in their day-to-day activities. The technology 

brings about reforms in the following areas of the institution. 

 

3.8.1  Management of Institutions and Systems 
 

The same technology used in computing and telecommunications 

services that brings about business efficiency, cost-effectiveness can 

also be applied to schools/school systems to enable the school head to 

streamline operations, monitor performance and improve on the 

utilisation of resources. Technology also promotes flow of information 

among schools, parents, communities’ central decision-makers and 
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business and fosters greater accountability and connectivity with the 

market place. 
 

At the school/institutional level, technologies are crucial in such areas as 

students’ admissions, students flow, personnel, staff development and 

facilities. 

 

3.8.2  Management of Policy Making 

 
The process of policy analysis and development is a complex and 

strategic one. It is by necessity, an intricate, non–linear process in which 

a variety of people and institutions with different view are actively 

involved in the process of analysing, generating, implementing, 

assessing, adjusting and re-designing policies. At this point, information 

can be valuable in storing and analysing data on education indications, 

students’ assessment, physical and human infrastructure, cost and 

finance etc. Technology can assist in constructing scenarios around 

different intended policy options to determine requirement and 

consequences. Each scenario can then be analysed systematically, 

evaluated in terms of accessibility over a period of time to have results. 

Technology can facilitate tracer studies, tracking systems as well and 

summative as formative evaluation during policy implementation. 

 

3.8.3 Managing of Learning Activities 
 

Technology is also a powerful instrument in driving and managing new 

modes of instruction, where distance is no barrier to learning, and more 

students’ interactions, more connections among/between schools, more 

collaboration among learners, and more involvement of tutorial 

facilitators. These needs are more critical in self-study; distance 

education and many platforms have been developed to meet such needs. 

Technology should not be a solution looking for a problem, it needs to 

be preceded by needs assessment, market analysis, strategic plan and 

experimentation, and accompanied by training appropriate investment 

and maintenance. 
 

3.9 Institutional Goals of Management Information Systems 
 

Management information system for an institution should be designed to 

achieve the following goals. 
 

 Enhance communication among staff. 

 Deliver complex materials throughout the institution. 

 Provide objective system for recording and aggregating 

information. 

 Reduce expenses related to labour-intensive manual activities. 

 Support the organisations strategies goals and direction. 
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Management information system in Education supplies education 

decision makers with facts, it supports and enhances the overall decision 

making process and also enhances job performance throughout an 

institution. At the management level, it provides information that helps 

the board of management (i.e. the highest decision making body for the 

institution), to make strategic decisions for the institution. 

 

Management information systems address the effective use of human 

and computer resources available in an organisation to achieve the 

objective of the organisation. The professionals in management 

information systems are responsible for developing various information 

systems that provide accurate and timely information to all levels of 

decision-making in an organisation. 

 

3.10 The Role of Management Information System on the 

Behaviour of Educational Managers 

 
All over the world, it is an established fact that information technology 

has been influencing the behaviour of educational managers in their 

daily discharge of their duties. But there is not yet an agreement about 

the precise nature of the change especially in educational institution. 

However, the application of management information system has, 

certainly reduced the tedium of administrative decision-making matters 

at both the lower and middle levels of management. In an educational 

institution, where computer-based management information system is 

used, it was clear that the heads of departments, principals, chief 

executives, registrar etc, have found decision making easier with 

management information systems. 

 

In Colleges of Education, Polytechnics and Universities, the usual areas 

of information difficulties are budgeting, students’ records, staff 

placements, audit and accounts, salaries, purchasing and supply, 

examination and results etc. However, with management information 

systems in education, all these and other areas of difficulty are handled 

effectively and efficiently. 

 

There are two schools of thought according to Nwankwo (1985) in the 

controversy over the role of management information system on 

educational managers. One school holds that, the use of computers 

would facilitate the jobs done at the clerical, technical and 

administrative level. As a result of this, fewer middle level and lower 

level management and non-academic staff would be needed.  This 

means that some of the staff in these categories will be rendered 

redundant. 

 

 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

178 

 

The other school of thought argues that since top management 

frequently depend on middle and lower levels for information, the 

behaviour of top managers will positively improve with the use of 

management information systems towards greater efficiency and more 

accurate decisions. For example, a research carried out by Hofer (1970) 

showed that the development of management information system has 

assisted top managers in industry and education to: 

 

 make some decisions at an earlier date  

 gain time in which to consider some decisions  

 consider more thorough analysis of some situations 

 review several courses of action of many problems    

 obtain additional information from middle managers concerning 

problems, opportunities and promising alternatives before making 

decisions. 

 

3.11 Challenges of Management Information Systems in 

Education 
 

The technical element about MIS in education is how to use 

information. Making use of information is highly specific, often 

personalised activity that affects work habits, work style, and the flow of 

work. Since the use of information is highly specific, training and re-

training, refreshing, workshops, seminars are necessary instrument in 

making MIS in education effective. Many obsolete styles of information 

system have failed not because of being obsolete, but because the 

operations failed to change with them or refuse to maintain them. MIS in 

education involves several critical steps to success which are listed 

below: 

 

i. Set standards for information: As a major requirement for MIS in 

education, needed information must be generated, defined and 

described. 

 

ii. Set Timing: Information generated at different times and location 

will vary because of the time and location. The figure obtained 

for enrolment rate in September may be different from the one 

obtained in March because of the time lag.  Likewise, the rate 

obtained from the cities/urban centers may be different from the 

one obtained from rural areas. 

 

iii. Define the level of possible accuracy. Most systems (statistics, 

personnel, inventory, textbook, examination) except finance, 

cannot report with more than 2-3% accuracy simply because of 

delays. 
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iv. Reports should be the result of daily activities not special purpose 

efforts as much as possible. All reporting should be extracted 

from daily operational activities. For example, data on enrolment 

should be generated from school registers. 

 

v. Define formats – This should be done at the early stage of design 

so that people can get used to it and know how to present and 

interpret information. For example if there is enrollment data for 

the nation, MIS in education must be ready to give additional 

information at regional / zonal or state level and also provide 

additional information on which analysis could be based. 

vi. Ensure prompt feedback – information provider must be given 

results of their work as quickly as possible because, the 

closer/quicker the processing of information is to the source, the 

better the level of accuracy and reliability. 

 

vii. Quantify the cost of producing information-most institutions, 

ministries, and parastatals produce information anyhow; they in 

no way measure the cost of the information in monetary terms. 

 

4.0 CONCLUSION 
 

In general MIS may be seen as a data processing system, which provides 

information to management for the purpose of controlling the business 

and as a basis for making decision. 

 

The information generated and obtained by management information 

systems in education is not only geared towards producing the annual 

statistical yearbooks of the Ministry of Education, nor allocating extra 

work for the Planning, Research and Development unit of the Ministry, 

it is a potent instrument for effective capacity building and a bridge to 

donor intervention and support in improving how to achieve educational 

objectives. 

 

5.0  SUMMARY 
 

In this unit, you have learnt about the inherent problems with MIS and 

the possible solutions to such problems as well as the various challenges 

of MIS in education. 

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. Define MIS and outline the objectives of MIS in education. 

2. What are the main challenges to the success of MIS in education 

in Nigeria? 
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1.0 INTRODUCTION 
 

This unit will assist you in understanding the relationships that exist 

between Information Technology (IT) and Management Information 

Systems (MIS) in Education, particularly, in the areas of application of 

IT in information systems. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 define Information Technology (IT) 

 explain application of IT in information management. 

 

3.0 MAIN CONTENT 

 

3.1 Definition of Information Technology 
 

As it has been defined earlier on, information technology is the 

technology, which supports the activities involving the creation, storage, 

manipulation, and communication of information with their related 

methods, management and applications.  Cole (1956) supplied a useful 

definition given by the Department of Trade and Industry in Britain as 

follows:  
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The acquisition, processing, storage and dissemination of vocal, pictorial 

textual and numeric information by a micro-electronic based 

combination, of computing and telecommunications.  

 

In short, IT is the medium by which information is passed across to all 

levels of management either internally or from external sources. Some 

of the IT facilities include computers of various types, scanners, printers, 

servers, word processors, photocopiers etc and other devices for 

information acquisition and dissemination such as 

teleconferencing/videoconferencing, networks, teletext, facsimile, 

Internet, e-mail, and voice mail etc. As you may notice, some of them 

have been discussed under acquisition and dissemination of information   

 

3.2 Application of IT in Information Systems 
 

Even though it is difficult to demarcate IT from MIS, it is possible to 

outline three major areas of IT application in information system. The 

three areas are:  

 

 office support systems; 

 data processing (or transaction processing); and 

 end user computing. 

 

 

 

 

 

 

 

 

 

 

Fig. 3.1: IT and Information Systems   

 

 

As you can see from the figure above, the three major areas of IT 

application in information systems are inter-related. 

 

Note that IT is discussed here in relation to the scope of this course. 

Other areas such as scientific use of IT, Computer Aided Design and 

Manufacture (CAD/CAM), robotics etc., are out of scope of this course. 

 

3.2.1 Office Support 
 

The type of office supports used influences information available for 

management. In modern offices, there are systems that help to facilitate 

IT and Information Systems   

Office Support 

System 

End User 

System 

Data or 

Transaction 

Processing 
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the acquisition and dissemination of information at various levels of 

management. The office support systems we are referring to here, are 

microelectronics and telecommunication devices. Some of them are 

discussed below and others such as networks, Internet and e-mail are 

discussed separately in different units because of their importance to our 

course of study. 

 

Text Handling Facilities: Word processors e.g. micro computers and 

other text handling facilities such as photocopiers, printers,, scanners etc 

are common features in modern offices, Word processor enables you to 

typeset documents, edit and give them the necessary formats. The 

documents can be stored in back-up storage media to be retrieved as at 

when due or printed out as many times as possible through the printer. 

 

Photocopiers: A photocopier machine makes duplicates of information 

in form of texts, charts, auto shapes, pictures etc. Indeed, it has become 

in-house miniature printing system for printing reports, memos, booklet 

bulletins and other documents. 

 

Desk-Top Publishing (DTP): Many softwares have been developed to 

handle processing of words and graphics in addition to the capabilities 

of importing/exporting from/to other application programmes. Examples 

of such applications are: Corel draw, Adobe page- maker etc. Also, 

cameras and scanners can be used to send pictures and other graphics. 

Hence, professional quality reports, bulletins, memos, books and other 

documentations can be produced within the office. 

 

Data Storage, Retrieval and Referencing: One of the major benefits of 

IT in office support, is the possibility of storing large amounts of data 

that could be accessed at any time with minimal effort. Files are stored 

in computer hard disc or in other auxiliary storage medium (Floppy 

discs and compact discs), and can be accessed using any type of 

computer with a VDU. However, if there is need for repeated 

referencing to information, in visual form, Computer Output on 

Microforms can be used. Microforms are photographically reduced 

information on files. 

 

Teletext/Viewdata: Teletext is a system for disseminating commercial 

and other information through available television network. It is also a 

referencing facility. On the other hand, view data is similar to teletext 

because it also provides electronic referencing to materials but it is 

different in the sense that: 

 

i) it is available only to subscribers who pay subscription as 

arranged e.g. DSTV.  
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ii) it is interactive in nature since user can interrogate the data 

supplied to the system and also supply answers to it unlike 

teletext which is for reading only. 

 

A good example of view data is seen in a system in which information 

provided by airlines can be accessed by travel agents to check flight 

times and availabilities and to book seats. 

 

Telecommunications Devices and Facilities: some telecommunication 

devices such as voice mail, facsimile, teleconferencing and video 

conferencing have been discussed exhaustively under acquisition and 

dissemination of information. Others such as Networks, internet and e-

mail as said earlier on are discussed separately in other units, because of 

their importance in Management information systems in Education. 

 

Data Transmission: is a situation whereby data and speech can be 

transmitted over ordinary telegraph and telephone circuits. Transmission 

of data is possible in three ways:  

 

i) Simplex:  is a situation whereby transmission is possible in one 

direction only.   

 

ii) Half Duplex: is a situation whereby transmission is possible in 

both direction but not simultaneously.                                                                                                     

 

iii) Duplex: Is a situation whereby transmission is possible in both 

directions simultaneously. 

 

Electronic Data Interchange (EDI): it is a form of electronic mail 

because it allows computer interchange of data.  The system allows 

computers of different organisations to communicate thereby replacing 

traditional paper based communication through orders, invoices etc. 

Some of the specialised applications of EDI are: 

 

i) Electronic Fund Transfer (EFT): It involves using the 

computer to send electronic data to a bank giving instructions to 

make payments or to transfer money between accounts. It is often 

employed to pay suppliers and worker’s salaries.  

 

ii) Society For Worldwide Interbank Financial 

Telecommunication (SWIFT): It allows the use of security 

codes for international trade operations involving foreign 

currencies worldwide, The Electronic fund transfer system 

between financial institutions in Nigeria is called: Nigeria 

Interbank Settlement System (NIBSS). 
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SELF-ASSESSMENT EXERCISE  

 

Define Data Transmission. Differentiate between Half Duplex and 

Duplex under data transmission. 

 

3.2.2 Distributed Data Processing or Transaction Processing 
 

After office support the next application area of IT is the aspect of 

repetitive processing of daily transactions of the organisation. In truth, 

some applications need to have data kept up to date all the time. These 

systems use direct access files in which any record can be read or 

written without having to read or write all the records before in the file. 

Transaction processing systems were among the first to prove the 

importance of the computer and originally were based on centralised 

mainframe computers to process large volume of routine jobs. However, 

with the advent of micro computers (desk tops, lap tops palmtops and 

note book) transaction processing has become so popular. Transaction 

processing makes it possible for data handling and processing to be 

carried out at or near the point of user rather than in one centralised 

location. Transaction processing is essential to keep the operations of the 

organisation running smoothly and provides the base for all other 

internal information support.  

 

Typically, transaction processing is seen in areas of order handling, 

accounts receivables and payables, invoicing, credit control, stock 

movements etc. More also, transaction processing is vivid in library 

loans system and students examination records. 

 

3.2.3 End User Computing 
 

Previously, it was believed that computer application is meant for those 

professionals such as programmers, system analyst etc., who have 

computer knowledge in related fields. However, with the evolution of 

personal computers, database networks and other application programs, 

this belief has been relegated to the background since managers can now 

develop their own systems to solve a particular problem and also to 

support and aid their processes of control and decision-making. Lucey 

(1997), defined End User computing as the ‘direct, hands-on approach 

to computers by users - not indirect use through systems professionals. 

Users include managers, office staff, sales people, production workers 

and others’. 

 

There are many applications to end user computing, but we shall 

concentrate on three that are related to our study.  
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Decision Support Systems (DSS): The essence of DSS is to support 

managers in their daily activities, especially decision making. It is quite 

similar to office support, but in DSS the managers, (i.e., the user) use 

variety of tools and procedures to develop their own system to help 

perform its functions more effective. It is this active involvement and 

the focus on decision-making, which distinguish a DSS from data 

processing system. This will be seen clearly under Spreadsheet 

management (Excel) later. Some of the packages you can employ for 

decision-making support are: Forecasting, Spreadsheets, Modeling and 

simulation, Non-linear programming, Expert system etc. However, 

spreadsheet, using Ms-Excel is discussed in details in module 2 and 3 

 

Expert system: It is a knowledge based system, which is a network of 

rules that represent the human expertise. It is a computer system, which 

encompasses some of the experience and specialised knowledge of an 

expert. In other words, an expert system allows a non-expert to achieve 

comparable performance as an expert in the particular field. However, 

the user does not surrender his judgment but he uses the system to 

enhance his judgment. Some of the fields that have witnessed the use of 

expert systems are: medical diagnosis, personal tax planning, aircrew 

scheduling, credit approval in banking, geological explorations etc. 

 

Executive Information System (EIS): This is another application tool 

under end user computing. EIS is a form of data retrieval system that 

provides selected and summarized information for senior management 

members. It facilitates the provision of information on critical areas of 

the organisation activities drawn from both internal and external 

databases. An EIS should exhibit the following characteristics: 

 

Easy to use: It must not be ambiguous. It must be simple and fast. And 

to guarantee the simplicity, the use of touch screen, pop-up menus, 

mouse etc. are approved. 

 

Access to data: data must be accessed without any hitch or hindrance, 

thereby permitting vertical and horizontal exploration of data. This is 

known as drilling down the data. 

 

Quality presentation: The report must be presented in attractive and 

understandable formats using graphics, charts, colours, diagrams etc. of 

high quality. 

 

SELF-ASSESSMENT EXERCISE  

 

What are the features of Executive Information System (EIS)? 
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4.0 CONCLUSION 
 

Office support systems cover different types of aids including: word 

processing, electronic mail, data transmission etc. Electronic data 

transmission is supplementing traditionally based communication. 

 

5.0 SUMMARY 
 

The main areas of IT application in MIS are: data processing, office 

support systems and decision support systems. 

 

6.0 TUTOR-MARKED ASSIGNMENT  
 

Explain the following terms under Office Support: 

 

1. Text handling facilities 

2. Desk-top Publishing 
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1.0 INTRODUCTION 
 

Although it is quite obvious that the computer is not everything about 

MIS, yet it is the basic tool we can easily employ nowadays. And it is an 

uphill task for someone to discuss other means (Networks, Internet and 

E-mail) of information technology (IT), or other application 

programmes, which are necessary for this course, without creating basic 

knowledge of computing.  

 

Note that this aspect of the course is not to make you a computer 

scientist, rather, to create an understanding of the basic elements which 

make up the computer system, which is at the heart of EDP; and to know 

how management can best use the computer and other IT equipment to 

provide better information. 

 

In addition, knowledge about computer appreciation will make you to be 

familiar with some common computer terms or languages that may 

interest you during your studies.  

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 describe what a computer is 
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 classify computers based on type, size/capacity, and nature of 

location 

 learn what the computer system is 

 understand the structure or layout of a computer 

 explain the components and configuration of a computer both 

Hardware and Software. 

 

3.0 MAIN CONTENT 

 

3.1 What is a Computer? 
 

A computer is an electronic machine, which is capable of storing data, 

performing computation on such data and retrieving information at a 

very high speed. The computations that can be performed include 

addition, subtraction, multiplication, division, etc. Computers can also 

compare two or more values to check for such logical relationship such 

as greater than, less than etc. 

 

In summary, a computer is an electronic machine or device that accepts 

data as input, processes the data, and gives out useful information as 

output. (See Unit 1 for notes on Data and information.)  

 

3.2 Classification of Computers 
 

Computers are grouped into various classes depending on the character 

they exhibit, the way they look or the way they are located. 

Subsequently, one computer can be referred to as digital computer and 

also minicomputer.  

 

3.2.1 Classification of Computers by Type 

 
Under the classification of computer types, computers are classified into 

three groups namely: analogue, digital and hybrid. 

 

Analogue Computers: This is a computer which does not compute 

directly with discrete values (digits), rather it measures quantity in 

continuous flow e.g. temperature, current, voltage. 

In other words, they are computers that work on physical principles or 

properties. 

Examples of such computers are diagnosis, thermometer, barometer, 

anemometer, analog watch etc. 

 

Digital Computers: Digital computer unlike analogue cannot measure 

quantity in continuous flow. It measures discrete values such as digits 

(0-9), letter of the alphabet, A to Z and special characters such as $, #, 
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&. They are the computers that understand binary (0 or 1) which can 

also represent an open or closed circuit in its electronic circuits. They 

work on discrete electrical state, such as ON or Off and discrete signal. 

Examples of such computers are: calculators, gaming computers, 

desktops, laptops etc. 

 

Hybrid Computers: This system has the features or capabilities of the 

analogue and digital computers. It can measure quantity in continuous 

flow as well as those in discrete values. The system used in the 

electricity meter reading is hybrid. It converts the quantity of the flow of 

current into digits, which can later be converted into monetary values 

such as naira or dollars. 

 

SELF-ASSESSMENT EXERCISE  

 

Outline and explain the classification of computers by type. 

 

3.2.2 Classification by Size/Capacity 
 

In the classification of computer by size and capacity, computers are 

classified into various groups namely: mainframe, mini and micro-

computer. 

 

Mainframe Computers: Mainframe computers are the largest forms of 

computers. These are computers that are very bulky and are usually 

stored in control rooms with air-conditioning accommodation. The CPU 

of the mainframe computer is the only element that distinguishes it from 

other forms of computers. The CPU is greater in size than the others and 

in fact more complex. It consists of many chips, i.e. processors 

connected together on several boards.  

 

It also has the capability of allowing other computers or terminals 

located at remote sites to communicate with it. Mainframe computers 

are used in research institute where they supply general purpose 

computing facilities and in commercial organisation like banks where 

large amount of transactions are made. Examples are: IBM 370, ICI 900 

etc 

 

Mini Computers: Minicomputers are smaller in size when compared 

with the mainframe. But can perform the same arithmetic and logic 

operational functions. Like mainframes, they also require air-

conditioning facilities 

 

Mini computers are very suitable for processing tasks that do not require 

considerable access to large masses of stored data. Examples are: Vax 

series, PDP-8 etc. 
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Micro-Computers: The Micro-computer is the smallest form of 

computers. This computer makes use of microprocessor as its central 

processing unit (CPU). The Micro-computer is the easiest to use and 

least expensive.  Many individuals purchase micro-computers for 

personal use, either for their jobs or for other purposes. Thus, micros are 

also known as Personal Computers (PC). They are those computers that 

are seen in almost every office today. Everything about them, such as 

heat produced, storage capacity, types of data processed, connected 

devices, processing rate, size, efficiency, power consumed etc. are 

relatively moderate. 

 

Micro computers by comparison with mainframe and mini computers, 

are altogether smaller and lighter, and do not require any special 

environment. Examples are: desktop, laptop, notebook and palmtop of 

various series. 

 

3.2.3 Classification by Nature of Location 
 

Computers are also classified by the way they are located or where they 

are located in other devices; and in this class, is the embedded 

computers. 

 

Embedded Computers: These are computers that are located within 

other machines to make them act like computer e.g. Speedometer. 

 

3.3 Computer System 
 

A simple computer system consists of the computer itself and other 

hardware devices, which are attached to the computer. We usually call 

these extra devices peripherals or supporting devices. The figure (below) 

shows a typical micro-computer system. 

  

           
Fig.4.1: Micro-Computer System 

 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

192 

 

3.4 Structure or Layout of a Computer System 
 

 

 

 

 

 

 

 

 

 

Fig.4.2: The Layout of a Microcomputer System 

 

The block diagram above shows the layout of a microcomputer system. 

As depicted in the diagram, the CPU is attached to a VDU (screen) so 

that output can be displayed. It is attached to a keyboard so the user can 

type in instructions and data. It is also attached to a disk drive, which is 

used to store data and programs on magnetic disk. 
 

Notice the direction of the arrows on the diagram. These arrows show 

the direction of data movement. Data move out of the computer to the 

screen so we call the VDU (screen) an output device. Data move from 

the keyboard into the computer so we call the keyboard an input device. 

The disk drive in the diagram is connected by two arrows, one in each 

direction. Data can move from the computer to the disk drive and also 

from the disk drive to the computer. The disk is a storage device. 
 

3.5 Computer Component and Configuration 
 

The computer consists of vital resources or components, which are very 

essential for information processing. For convenience sake, the 

component may be divided into two main categories namely, Hardware 

and Software. 

 

 

 

 

 

 

 

Fig. 4.3: Computer Components 

 

4.0 CONCLUSION 
 

The computer is a tool to many people in different ways. Therefore, we 

define the computer in such ways that can let us know completely what 

it is. Also, computers are grouped into various classes depending on the 

Monitor or VDU  

(Output Device) 

Keyboard  

(Input Device) 

      CPU  

(Computer) 

Disk Drive  

(Storage 

Device) 

   Computer 

  Software   Hardware 
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character they exhibit, the way they look or where they are located. 

Subsequently, one computer can be referred to as digital computer and 

also minicomputer. Another can be called embedded computer and at 

the same time called special purpose computer. 

 

5.0 SUMMARY 
 

Within business organisations, many different types and sizes of 

computer systems are found. Usually, the appropriate system is 

determined by the range and volume of services required to conduct the 

business. Big organisations rely on central mainframe computers, with 

minicomputers and microcomputer servicing local and individual needs. 

 

Within medium sized organisations, a mini computer is usually 

sufficient to handle transaction processing. Within small business 

organisation; one or more micro-computers usually support both 

company work and individual processing needs. 

 

6.0 TUTOR-MARKED ASSIGNMENT  
 

1. What is a computer? 

2. Classification of computers can be done based on the size or 

capacity of the computer. Discuss. 
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1.0 INTRODUCTION  
 

In this unit, you will learn the various parts that make up a computer 

system.  You will also learn about the hardware, the input unit, the 

output unit, central processing unit and the storage unit of a computer 

system as well as external devices used by a computer such as diskettes, 

compact disk, zip disk and flash drive. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 define computer hardware and software  

 explain the various parts of the computer that make up the 

hardware and software 

 state the meaning of computer virus 

 explain what is meant by booting 

 illustrate how to shut down a computer. 
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3.0 MAIN CONTENT 

 

3.1 Hardware 
 

This includes all equipment or physical devices used in processing data 

and delivering information. Hardware encompasses everything that is 

tangible, be it mechanical or electrical in a computer. It is any part of 

computer system that can be seen, touched and felt. Examples are 

keyboard, monitor or console, printer, scanner, plotter, fan processor, 

power pack, speakers, card, mouse, UPS etc. 

 

Hardware can belong to any unit such as the input unit, central 

processing unit (CPU), output unit, storage unit or any part such as the 

main parts and peripheral parts of the computer. Some of them are 

explained below: 

 

3.1.1 Input Units (Devices) 
 

Input devices are used to put data into the computer. In other words, 

they are the units you can use to talk to the computer. The input devices 

capture data and make them available for processing. In synopsis, the 

input devices are devices meant for collecting data from the outside for 

the computer to process. Input devices could be categorised into two – 

operated input devices and automated input devices.  

 

Operated Input Devices allow data to be entered into the computer by 

the use of hand. Examples of operated input devices are: keyboard, 

mouse, microphone, joy-stick, scanner, punching machine, touch screen, 

sorter, collator, graphic tablet or digitiser, digital camera, video digitiser 

etc.  

 

Automated Input Devices allow automatic data entry to take place. 

Examples of automated input devices are: Optical Mark Recognition 

(OMR), Optical Character Recognition (OCR), Magnetic Ink Character 

Recognition (MICR), sensors, smart cards, magnetic strip codes etc. 

 

Some of the input devices are explained below: 

 

i) Mouse: The mouse is a pointing device that is moved around on 

top of a mouse pad/mat or desk to move a marker called a cursor 

around the screen. In other words, a mouse is a hand-held device 

that controls the movement of a pointer on the screen. With the 

mouse, you can draw, move objects select commands and play 

games. Some mice have cable (cord) to connect them to the CPU 

while some are cordless. 
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Fig.5.1: Mouse 

 

See more notes on how to use the mouse in Module 2 

 

ii) Keyboard: The computer keyboard looks like a typewriter 

keyboard. It is used to type in command, instruction, data or 

whatever we want to send into the computer. Hence it is a 

communication device between the user and the computer. The 

keyboard is referred to as command line interface. This is 

because it enables the user to give command to the computer 

using its keys.  Like mouse, some keyboards are cordless 

(without cable) while some have cord (cable) that connects them 

to the CPU. 

 

 

                                             
 

Fig.5.2: Keyboards 

 

See more notes on how to use the Keyboard in Module 2 

 

iii) Scanner: The scanner is a machine that is used to collect data 

about the light reflected by areas on a picture and transmit it to 

the computer in order to reproduce or record photographs and 

other document into the computer. The scanner has features of a 

photocopying machine; therefore it can be used to reproduce 

documents. Once you have scanned the picture you can edit the 

computer version, cut bits of it, or rescale as required. Scanners 

can work in black, white, and grey or colour. 

 

Keyboards 

Left Button 

Mouse Ball 

Housing 

Mouse Ball  

Right Button 

Mouse 
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Fig.5.3: Scanners 

 

 

Scanner can also be used to input pages of text. However, optical 

character reading software is needed to convert the graphics image of 

the text into a text file, which can be edited using a word-processor. 

 

iv) Optical Mark Recognition (OMR): The OMR is a technique, 

which involves the reading of documents, or forms that are 

shaded usually with HB pencils. An optical mark recognition 

scanner such as the one above scans these documents and 

information therein is read by a computer system, which is 

connected to the scanner. All the printing on the form is in very 

pale ink called fade-out ink. This ink is not detected by the 

reading machine, which detects only a shaded portion. The 

machine transmits data about each space to the computer and the 

software works out whether the answers are right or wrong and 

adds up the total mark. 

 

The form will not go through the machine if it has been folded or 

wrongly handled. Other forms cannot be read because they have got 

dirty or marks have been made in the wrong place. The data from these 

rejected forms have to be entered by hand. 

 

OMR is used in the conduct of examinations.  

 

                                                             

                            
 

Fig.5.4: 

 

SELF-ASSESSMENT EXERCISE  

 

Write short notes on any two operated input devices known to you. 

 

Scanners 

A multiple choice card used in examinations 

Choices printed in 

pale ink. This can- 

not be detected by 

 the scanner 

shaded 
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3.1.2 Central Processing Unit (CPU) 
 

The CPU also known as the processor or micro processor was first 

developed by Intel in 1974. The CPU is responsible for handling all 

instructions and calculations it receives from other hardware 

components in the computer and software programs running on the 

computer. 

 

The CPU is often referred to as the heart, brain or life wire of the 

computer, where the actual arithmetic and logical operations are carried 

out. It contains the electronic circuitry that performs the arithmetic and 

logical operation required for data processing. The CPU is composed of 

three functional parts, as shown in the chart below:  

 

 

 

 

 

 

 

 

Fig.5.5: The CPU 

 

i) Memory: The computer memory is the storage place where the 

computer keeps data and information that are to be worked on. 

The memory is further divided into two different layouts – RAM 

and ROM 

   

a) RAM (Random Access Memory): It is a workplace of the 

computer. In other words, it is a storage area that holds programs 

and data temporarily during processing. Programmes are stored in 

the RAM until processing is completed. RAM is volatile which 

means that it cannot hold data and information when there is 

power failure. The capacity of the computer’s RAM determines 

the speed of the computer during processing of data.  

 

b)  ROM (Read Only Memory): Unlike RAM, the ROM is non-

volatile, which implies that it is not affected by any power failure 

and it can hold information permanently. 

 

Some of the functions of ROM include the following: 

 

1. Rom is used to hold instructions which are needed to start up the 

computer. 

 

2. It contains the system manufacturer’s information 

   ALU Memory Control Unit 

    CPU 
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3. It performs Power-on-Self-Test (POST) functions. This has to 

do with self-test of the internal circuitry and peripheral devices 

attached to the computer. 

 

4. It performs Basic-Input-Output system (BIOS) function. The 

ROM contains some routines that stand as fluids boundaries 

between the different peripheral devices that make up the 

computer to work as integrated unit (system). 

 

Note: The major differences between ROM and RAM are: 

 

1.  RAM is volatile while ROM is non-volatile. 

2.  Information in ROM is permanent while that of RAM is 

temporal. 

 

SELF-ASSESSMENT EXERCISE  

 

What is the full meaning of RAM and ROM? 

 

ii)  Arithmetic and Logical Unit (ALU): Arithmetic unit performs 

such processing operations, which involve addition, subtraction, 

multiplication division etc, while the logic unit performs the 

function of comparison between numbers and shifting of value 

from one area to another. After the control unit has set up the 

necessary path, data are brought from memory to the ALU and 

placed in registers. Within these registers, arithmetic and 

comparison operations are performed. 

 

iii) Control Unit: This directs the operations of the computer by 

interpreting programs instruction and activating the circuitry to 

carry out the instruction. When the user inputs programmes, then 

the control unit recalls programme instructions one at a time as 

needed, evaluates each instruction to determine what operation is 

required, and activate the electronic circuitry and data path 

necessary to carry out the operation.  

 

 

 

                                       
                                         

 

Fig.5.6: Central Processing Units 

 

Central Processing                           

Units 
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3.1.3 Output Unit 

 
These devices are means of communicating the processed task in the 

computer to the user. In other words, they are the devices used to get 

information out of the computer system in a form, which the user can 

understand. During output the data is put into a context so that it 

becomes information. Examples are: visual display unit (VDU) or 

monitor, printer, speaker, Graph plotter etc. 

 

i)  Monitor: The monitor is also known as visual display unit 

(VDU) or display screen. The monitor looks like a television. It 

shows what the computer is doing or the work/ task that the CPU 

is processing. The flat screen sharply reduces reflection from the 

user’s environment and eliminates glare. 

 

The monitor produces soft copy output because it is intangible; hence 

you cannot hold it or wipe it off. 

 

                                  
 

Fig.5.7: Monitors 

 

 

ii)  Printer: Printers are very important output devices that make it 

possible to print out (write out) work done on the computer. 

  

Most system requires printed output like payroll and management 

information etc. According to the type of computer in use a large range 

of printer and printing systems are available. The printer takes 

information from the CPU in binary coded form then converts it to the 

form that is understandable to human before printing them on paper in 

form of hard copy. 

 

 

 

 

 

 

Monitors 



EDA742           MODULE 3 

 

201 

 

 

 

 

             
 

Fig.5.8: Printers 

 

 

SELF-ASSESSMENT EXERCISE  

 

Mention any two (2) output units and explain one. 

 

3.1.4 Storage Device (Unit)  
 

Data fed into computer systems have to be transferred to backing store 

so that it will not be lost when the computer is switched off or develops 

a fault. Backing store is the general name given to disks and tape used to 

store data. It allows data to be saved on a suitable medium so that it can 

be reused. The medium is the disk or tape on which the data is stored. 

The storage device is the disk drive or tape drive which reads and 

writes the data.  

 

Drive: A drive is storage medium in the computer. It is any letter from 

A-Z or number from, 0-9 with a colon in front of it e.g. A:, B:, T:, 0:, 

6:, 9:,etc. 

 

However, conventionally the common drives are labeled as follows:  

Hard Disk                                           Drive C i.e. C:  

Compact Disk (CD)                  Drive D i.e. D: 

Floppy Disk (Diskette)                       Drive A or B i.e. A: or B: as the 

case may be if there are master and slave and on the same computer. 

Zip Disk   Drive E i.e. E:  

Printers 
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Some of the storages devices are as follows: 

 

1.  Magnetic Disk (Hard Disk and Floppy Disk) 

 

i) Hard Disks: Are made of metal coated with a magnetisable 

material. They can hold a large amount of data and they are 

usually fixed inside the hard disk drive. The heads which move 

across the disk to read and write the data are extremely close to 

the surface and a speck of dust can easily cause damage; hence 

the disk is sealed inside to keep it clean. 

 

Hard disk capacities are measured in millions and billions of bytes of 

storage. They are in sizes of 1.2 GB, 2 GB, 4 GB, 40 GB etc. Hard disk 

drive is called drive C. 

 

 

              
Fig.5.9: Hard Disks (HDD) 

 

 

ii)  Floppy Disks: These are thin, flexible and made of plastic coated 

with a magnetisable material. They are sealed into a protective 

case which has openings to allow data to be written and read. 

They are also known as diskettes. Floppy disk is a secondary 

storage device, with a lesser capacity and it is detachable.  

 

The floppy disk is labeled as Drive A. However some computers have 

two floppy disk drives – 3.5″ (3½″) and 5.25″ (5¼″) In that instance, 

3.5″ (3½″) that always come with the computer will be Drive A while 

the other will be Drive B. Drive A is the master drive and Drive B is 

the slave drive.  Presently, drive B is considered outdated because new 

model systems do not have provision for it. 

 

Note: when the diskette Notch is closed (protected), it becomes readable 

only, and you cannot copy on it; and while it is opened, it becomes both 

readable and writeable and that means you can copy on it. 

 

Hard Disks 

(HDD) 
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Fig.5.10: Diskettes (3½″) 

 

 

2.  Compact Disks (CD-ROMs/CD-Rs/CD-RW)  
 

i)  Compact Disk: Computer compact disks look like the compact 

disks used for music and they work in the same way. The earliest 

compact disks (CD) were read only, hence the name CD-ROM 

(Compact Disk Read Only Memory). However, recordable CDs 

known as CD-R (Compact Disk Recordable) and read/write CDs 

known as CD-RW (Compact Disk Read/Write) are now 

available. Therefore, with CD-R disk, you can put a blank disk in 

the CD-R drive and use it to save your own data or programmes. 

Also, it is possible to read from and write to special optical disks 

many times using CD-RW.  

 

The capacity is larger than that of floppy disk, and smaller than the Hard 

disk. The capacity ranges from 250MB, 550MB 659MB and above. CD 

drive is often referred to as drive D.   

 

  

                     
Fig.5.11: Compact Disk 

 

 

Zip Disk: It is larger in capacity than floppy disk, but smaller than 

compact disk. It is capable and generally big enough to store graphics, 

transfer of files between work and home and saving of Internet 

downloads. 

 

Compact 

Disk 

Diskettes (3½″) 
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Fig.5.12: Zip Disk 

 

 

Flash Drive: It is typically small, lightweight, removable and 

rewritable. A flash drive consists of small printed circuit board encased 

in a robust plastic or metal casing, making the drive sturdy enough to be 

carried in a pocket, as a keyfob, or on a lanyard. They are more 

compact, generally faster, hold more data, and are considered more 

reliable (due to their lack of moving parts) than floppy disks. These 

types of drives use the USB mass storage standard supported by modern 

operating system such as Linux, Mac OS and Windows. 

 

Memory capacity typically ranges from 128MB to 64GB 

 

                           
 

Fig.5.13: Flash Disks 

 

SELF-ASSESSMENT EXERCISE  

 

What are the labels conventionally attached to the following storage 

media and with what alphabet? 

 

i) Hard Disk  ii) Diskette  iii) Compact Disk 

          

3.1.5 System Unit 
 

The system unit is made up of all that make what you actually call a 

computer, and the devices are as follow. However, these are addition to 

what you have learnt already about CPU.  

 

Motherboard: This is the underlining part of the computer for desktops 

CPU on which every other component of the system unit, except the 

Flash 

Disks 

Zip Disk 
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power pack and disk drives are mounted. It is made up of silicon board 

just as those of the radio or television. 

 

Power Park: This is a component of the computer that distributes the 

amount of current required by the different components of the computer 

to such components. 

 

Slots: These are the outstanding parts of the motherboard. They are 

rectangular in shape with grooves in the middle in which cards are 

slotted.  

 

Cards: These are devices that make available the interface for the 

connection of external devices to the computer Examples of such cards 

are the printer, TV-card, audio or video, VGA, modem etc. 

 

Ports: These are provisions at the back of the cards on which all 

external devices are connected; there are two main types of ports parallel 

and serial ports of which the parallel port transmits data bit by bit out, 

one bit in, in a communication that is bi-directional, and the serial port 

transmits data-eight bits at a time and simultaneously in a bi-directional 

communication.  

 

3.1.6 Parts of a Computer 
 

The computer has different parts, but the main essential parts of the 

computer are: 

 

1. The Monitor (Visual Display Unit)  

2. The central Processing Unit (CPU) 

3. The Keyboard  

4. The mouse 

 

3.1.7 Supporting (Peripheral) Devices 
 

Other parts of the computer that are not members of the main part are 

referred to as peripheral devices. It is possible to do without them. They 

perform input, output or storage function outside but under the control 

of the computer. Examples: are Printer, Speakers, Scanner, Microphone, 

UPS etc. 

 

3.2 Software 
 

Speaking in terms of computers, software is a set of instructions – the 

computer programs that are used to command the computer. People 

develop softwares to describe their processing needs to the computer, 

the software in turn, operate the computer hardware to perform the task. 
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They are the invincible or intangible portions of the computer that 

instruct the computer hardware on how to carry out tasks. Computer 

software can be divided into two broad categories – System and 

Application. 

 

 

                           

 

 

 

 

 

Fig. 5.14 

 

 

3.2.1 System Software 
 

The system software is also referred to as operating system (O.S.). The 

computer as a complex machine has important software that allows you 

to communicate with it, i.e. the system software. The operating system 

provides the routines needed to allow application softwares to interact 

with the hardware. In other words, they are programs that interpret 

user’s programme commands that are contained in application 

programmes and activate the proper hardware circuit and device to 

perform the processing. In short, the O.S is a collection of programme 

modules that act as interface between the computer hardware and the 

user.  

 

3.2.2 Application Software 
 

These are programmes created to perform a specific task; they provide 

the user’s end desire. In other words, they are programmes created 

specifically to meet the user’s needs. The ones developed by the 

manufacturer are called Generalised Application Software, while 

those developed by the user are called User Program or User-define 

Software. 

 

Application programs are categorised into different groups according to 

their functions and purpose. Some of the Generalised Applications 

Packages are as follows: 

 

Word processing Softwares: These are software packages that are used 

for typing and printing of all types of documents. They allow entering of 

text and quality typesetting. Examples of word processing software are: 

Microsoft word, Word perfect, Grammatik, Word Star, Display Writer 

etc. 

   Software 

 Application  System 
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Spreadsheet Management Software: These are softwares that are used 

for calculation, and they can also be used to do some graphics, word 

processing and database management. They are in form of matrix i.e. 

rows and columns, which control the table of cells. Examples of 

spreadsheet management softwares are Microsoft Excel, Lotus 1-2-3, 

Super Calc, Quattro pro, Super Project, Math Cad, Oracle etc. 

 

Graphics: These are softwares that are used for drawing or producing 

beautiful pictures, objects, sketches etc for use in desktop publishing and 

otherwise. Examples of such softwares are Freelance Graphics, ABC 

Flow Chart, More Font, PM Plus, Corel Draw etc. 

 

3.3 Computer Virus 
 

This is a programme that affects other programmes in the computer 

without your awareness. In other words, the computer virus is a set of 

coded instruction that comes into the computer through a foreign disc or 

network. The first thing it does is to attach itself to critical files, then 

replicate and spread through the whole system. Some viruses normally 

cause unusual screen display or behaviour.  

 

Types of Virus 

 

Some of the notable viruses are: Black Friday, Black Wizard, Acid 

Virus, Yankee (OPEY A – New name), Stone (MARKER A – New 

name), Amoeba (W Bleba.worm – New name), Aids, Demon, Ghost, 

Athens, Sadam, Striker, Red State, Blood etc. 

 

Causes of Virus 

 

i. By allowing others to use diskettes of their own on your system 

without scanning with any Anti-Virus. 

ii. Software piracy i.e. illegal duplication of software might transfer 

a virus from one disk to another. 

iii. When a computer is connected to the network, it stands the 

chance of contacting virus. 

 

Preventive Measure against Virus: All viruses are destructive; 

therefore, prevention is better than cure. 

 

i) Immunity of system against virus with Anti-Virus programme is 

highly recommended 

ii) Any borrowed diskette should always be scanned for virus with 

Anti-Virus programme before usage.  
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iii) Dust should be avoided as much as possible in the computer 

room to avoid blocking of circuit in the system unit.  

 

Anti-Virus: Anti- Virus is a software programme that is used to correct 

or remove the infection of virus on the computer. Some of the anti-virus 

programmes are: Ultra secure, PC Guard, Norton Anti-Virus, Virea, Dr 

Solomon, Computer lock, Mcafee, Watchdog, Turbo Lock, and PC 

Assure etc.   

 

3.4 Booting 
 

Booting is a computer language, meaning - to switch on the computer or 

to start it. It is also called Bootstrap. When you switch on your 

computer, it will carry out diagnostic routine by looking through its 

memory (RAM) chips to make sure that they are all working properly. 

In that process, the computer is booting. 

 

Types of Booting: Booting can be done in two ways – Cold booting 

and Warm booting. 

 

Cold Booting: It is the starting of a computer by pressing the power 

(On/Off) button. You instruct somebody to “cold boot the computer” 

and do not say: “put on the computer” or “power the computer” or “start 

the computer”  

 

Warm Booting: It is the process of restarting your computer without 

putting it off, using the Reset button. Warm booting can also be done by 

pressing Ctrl + Alt + Del keys on the keyboard. However, warm booting 

must not be done when the computer is on (without a problem); unless 

the computer happens to hang during operation. 

 

SELF-ASSESSMENT EXERCISE  

 

(Practice) 

 

How to cold boot (start) the computer   
 

Press the power (On/Off) button. If power is not written, look for Zero 

(O) and One (1) symbol such as these:           or          .  

 

3.5 Shut Down/Turn off Command 
 

Computer is not like other electronics e.g. Television, Radio etc that you 

can switch off directly whenever you are through with it. It has a 

procedure of shutting down first before you press the power button if the 

system is not the automatic type. 
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SELF-ASSESSMENT EXERCISE  

 

(Practice) 

 

How to shut down or turn off the computer  

 

 Before you attempt to shut down ensure that no programme is 

currently running or minimised on the task bar. 

 Activate the start button.  

 Click the Shut Down command or Turn Off depending on the 

version of windows you are using. For instance the shut down 

dialog boxes of windows 2000 and windows XP are displayed 

below: 

 

        
 

Fig.5 15 

 

 Select shut down option. (Windows 2000)   Click on Turn Off 

(Windows XP).  

 Click OK or press enter key (Windows 2000, 98 etc). 

 

4.0 CONCLUSION 

 
What makes up the computer system is the Hardware and software. 

Hardware are physical or tangible parts of the computer and the software 

are the intangible parts or programmes that are used to instruct the 

hardware. 

 

5.0 SUMMARY 
 

The system software (operating System) serves as interface between the 

application software that meets the user’s needs and the hardware. 

Example of an Operating System is windows and example of application 

software is Word Processing or Spreadsheet Management. 
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6.0 TUTOR-MARKED ASSIGNMENT 
 

1. Outline the procedure of how to shut down or turn off the 

computer. 

2. Actually the computer virus is different from animal virus, but 

they have certain similarities. Discuss. 

3. Write short notes on the following computer terms:  

  

 i.  Peripheral  devices   ii.  Ports iii.  Slots 

 

 

7.0 REFERENCE/FURTHER READING 
 
Ithurralde, I. & Ramkaram, A. This is IT 2. (2nd ed.). 
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MODULE 2 
 

 

Unit 1  IT and MIS in Education: Windows Operating System 

Unit 2  Windows Operating System Continued: Windows Screen 

Layout 

Unit 3  IT and MIS in Education: Computer Electronic Word 

Processing Using Ms-Word (Ms-Word Screen Layout and 

Features) 

Unit 4  Microsoft Word (MS-Word) Continued: Text Formatting 

and Editing 

Unit 5  Microsoft Word Continued: More Formatting, Editing and 

Printing  

 

 

UNIT 1 IT AND MIS IN EDUCATION:  

  WINDOWS OPERATING SYSTEM 
 

CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 What is Windows Operating System (O.S.)? 

 3.2 Loading Windows Operating System 

 3.3 Features and the Screen Environment 

 3.4 Basic Techniques on How to Use the Mouse 

  3.4.1 Clicking 

  3.4.2 Double Clicking 

  3.4.3 Dragging 

  3.4.4 Pointing/Locating 

 3.5 Start Button 

 3.6 Menu 

  3.6.1 Moving within Menu Items 

 3.7 Menu Conventions 

  3.7.1 Underline Character 

  3.7.2 Ellipsis (…) 

  3.7.3 Right-Facing Triangle or Forward Arrow (►)  

 3.8 Shortcut 

 3.9 Opening of Icons 

 3.10 Selecting (Highlighting) and Choosing Icons 

 3.11 Dialog Box 

  3.11.1 Moving Dialog Box 

  3.11.2 Closing a Dialog Box 

4.0 Conclusion 

5.0 Summary 
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6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 

 

1.0 INTRODUCTION 
 

Already, part of Windows Operating System had been explained in the 

last unit of module 1, i.e. - how to boot the computer and turn it off. In 

this unit, you will know what is meant by windows and what you can do 

with them. Therefore from now on, try to be by your system for the 

practical demonstrations and exercises. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 define Windows Operating System 

 recognise windows environment and its features 

 understand the basic techniques on how to use the mouse 

 distinguish between menu and menu conventions  

 explain what is shortcut and how to create it 

 understand how to open an icon and differentiate between 

selecting and choosing an icon  

 identify a dialog box. 

 

3.0 MAIN CONTENT  
 

3.1 What is Windows Operating System (O.S)?  
 

Windows is one of the operating systems that make use of Graphical 

User Interface (GUI) under the environment of WIMP (Windows, Icons, 

Menus and Pointers) as shown below:  

 

 
Icons 

Windows 

Pointer 

Menu 

A graphical interface 
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Fig.1.1 

 

As an Operating System, it serves as intermediary between the hardware 

and the user’s application software. With Windows O.S., it is possible 

to switch between programmes without closing down one and open the 

next. Many windows can be opened at one time, although only one can 

be active at any given time. 

 

We have different versions of Windows OS such as 3.1, 95, 98, Me, 

2000, XP etc. However, apart from the earliest versions (3.1 and 95), 

others have slight differences; therefore once acquainted with one- e.g. 

98, others will not create fear or threat. It is easy to learn applications 

associated with windows because of its consistency of graphical 

interface from one application to another. Once you are familiar with 

one application like MS-Word, you have already learnt the essentials 

for using any other application.   

 

With Windows OS, you can execute the same command by using 

several methods, but here we shall be practicing with one or two 

methods even though the particular command has many methods of 

carrying it out. Therefore, you are free to use other methods known to 

you in such situations.     

 

3.2 Loading Windows Operating System 
 

In the last unit of Module 1, we practised how to start the computer. In 

another way, it is the same language when you talk about ‘how to load 

Windows OS’. However, in order to refresh our memory, we shall still 

practice it. 
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Practice 1 

 

How to start Windows 

 

 To start windows OS, cold boot the computer by depressing the 

power button. Then wait until when the pointer is single like 

this:       It indicates that it has finished booting. 

 

3.3 Features and the Screen Environment 
 

After the computer has finished booting successfully, it will stop at the 

environment called desktop. Depending on how your computer is set 

up, various items (icons) will appear on your desktop. A bar called the 

taskbar will appear at any edge of the four edges of the screen, 

normally at the bottom; and a pointer as shown below: 

 

 

                    

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 1.2 

 

Desktop: this is the environment where you can start anything you want 

to do after the computer has finished booting. The items that you see 

scattered on the left side of your desktop are called Icons.  

 

Icons:  an Icon is a command in picture form. Each icon represents an 

object such as a folder or an application program. Examples of some 

icons you can see at the desktop are: My Computer , My Documents 

, Internet Explorer , Recycle Bin  etc. These could also be 

created on the taskbar as shortcuts too.  

 Desktop 

Icons 

Taskbar 

Pointer 

Desktop environment 
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Icons are merely shortcuts to application programmes or files that you 

have created using any application.  

 

Pointer: Is used in conjunction with an input device such as a mouse, to 

point to various parts of the display. 

 

Taskbar: The taskbar is normally found at the bottom of your screen 

when you start windows for the first time. By default, it is always visible 

when running windows Applications. At anytime you start a programme 

or open a window, a button representing that program or window will 

appear on the taskbar and when you close the window, its button will 

disappear from the taskbar.  

 

         
 

 

 

Fig.1.3 

 

Note: It is possible to put toolbars as many as you want on the taskbar, 

but it is not ideal because it may make the buttons of some active 

windows to hide.  

 

3.4 Basic Techniques on How to Use the Mouse 
 

The motive of bringing this topic here is to eliminate the difficulties you 

might face with the language associated with the mouse that your 

instructor will be using during the practical exercises in the course. 

 

3.4.1 Clicking 
 

This is pressing and releasing of a mouse button either left or right 

button. Whenever your instructor asks you to click the mouse, what he 

expects you to use to click is the left mouse button. When there is need 

for you to use the right button he will say right click. Therefore 

wherever you see click or click on anything, you are expected to use the 

left button. There is nothing like left click in computer parlance. 

 

3.4.2 Double Clicking 
 

Is a way of pressing and releasing the mouse button particularly the left 

mouse button twice in rapid succession (very fast). 

Start Button Notification 

Area 
Quick Launch 

Toolbar 
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3.4.3 Dragging 
 

Is a way of pressing a mouse button and holding it down while moving 

(dragging) the object to where you want it. 

 

3.4.4 Pointing/Locating 
 

This entails moving the pointer until its tip rests on a specific object you 

want to use before you click or double click. Examples of good and bad 

pointing are shown below:  

 

 

                                                       
 

                                           
 

Fig.1.4 

 

Note: In situations where the mouse pointer will change from the spear 

head shape to other shapes, it will change by itself when it gets to that 

particular position or spot. 

 

3.5 Start Button 
 

The start button on the task bar, is used to start a program, open 

documents, change system settings, get help items etc. When you 

activate the start button, a menu called the Start Menu that contains 

everything you need to begin with windows will come out as shown 

below: 

 

Good Bad Bad 

Bad Bad Good 
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Fig.1.5 

 

3.6 Menu 
 

Menus offer the user a choice of functions associated with an application 

or operating system. Therefore the start menu reveals most of the 

possible commands you can use to start working with windows. 

 

Practice 2 

 

How to bring out the Start Menu 

 

 Click on the Start Button itself 

Press Escape key or click outside the menu since you will not 

proceed further. 

 

 

Optional Method 

 

 Press Ctrl (Control) + Esc (Escape) keys on the keyboard 

 

Hint: Use one finger to hold Ctrl key down and use another finger of 

the same hand or the other hand to tap Esc Key. 

 

3.6.1 Moving Within Menu Items 
 

Movement within the start menu and other menus is done either by 

using the mouse pointer   or by pressing the navigator keys on the 

Start Menu of Windows XP 

 

Start Menu of Windows 98 
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keyboard. Movement with the mouse is done either vertically or 

horizontally and not diagonally. 

  

   
 

Fig.1.6 

 

Practice 3 

 

How to move within Menu Using the Mouse 

 

 Activate the Start Button with the mouse  

 Move the mouse pointer up and down, left and right to select 

any command. 

 

For example,  

 

 Move the Pointer to Programmes (All Programmes in 

Windows XP) 

 Again move the Pointer to Accessories, and then click outside 

the menus to remove them.  

 

Optional Method – Using the Keyboard 

 

 Activate the Start Button with the keyboard, then use the 

navigator Keys to move up / down or left / right as the case may 

be. 

 

For example, press the up arrow key to locate Programs (All 

Programs in Windows XP), press the right arrow key to bring out the 

second menu, then press the up or down arrow key to locate 

Accessories and press the right arrow key to bring out the third menu. 

Press Esc key until all the menus are removed.  

 

3.7 Menu Conventions 
 

Menu conventions are common rules associated with menus in 

Windows and other windows application programs that make a user to 

have easy short cut to certain commands. 
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3.7.1 Underline Character 
 

The underlined character under a menu command gives you fast access 

to a command using the keyboard.  

 

Practice 4 

 

How to use the Underline Character  

 

 Activate the start Button with the keyboard by pressing Ctrl + 

Esc Keys  

 Press R key on the keyboard since it is the underline character in 

Run to activate the Run command  

 Press Esc key to remove the Run dialog box 

 

Note that the underline characters in some other menus need to be 

activated by pressing the underline character with the Alt key.  

 

3.7.2 Ellipsis (…) 
 

An ellipsis command leads to a diagonal box. Wherever you see a 

command with three (3) dots (…) in front of it, expect a dialog box. For 

example the Run command in the start menu.  

 

3.7.3 Right-Facing Triangle or Forward Arrow (►) 
 

Commands with this symbol: ► in front of them leads to second menu 

and secondary menu can lead to another as the case may be. 

 

Practice 5 

 

How to use the Right-Facing Triangle 

  

 Activate the Start Button with any method 

 Locate Programs (All Programs in windows XP) 

 Locate Accessories  

 Locate System Tools 

 You will notice four (4) cascading menus on the screen 

 Press Escape key or click outside the menus since you will not 

proceed further. 

 

3.8 Shortcut 
 

Icons that you see at the desktop and the taskbar are shortcuts to 

Application Programmes or other Folders. Therefore, shortcuts are icons 
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created for easy access to a file or folder that you use frequently. A 

shortcut does not change the location of a file. It is simply a pointer that 

allows you open the file quickly. If you delete the shortcut, the original 

file still remains intact. 

 

Practice 6 

 

How to create Shortcut on the Desktop 

 

We shall practise with Microsoft Word (MS-Word) Icon. Check 

whether if it is already on the desktop. If there is one or two already, 

yours will now be number 2 or 3 as the case may be  

 

 Activate the Start Button with any method of your choice 

 Locate Programs (For Windows XP 2003 Version, after you 

have located Programs, locate Microsoft Office) 

 Right click on the application program i.e. Ms-Word in this 

case 

 Locate Send To 

 Click on Desktop (create shortcut) 

Microsoft Word shortcut (Icon) with big W logo  will appear 

on the desktop 

 

Practice 7 

 

How to create Shortcut on the Taskbar 

 

You will still practise with the Microsoft Word (MS-Word) Icon you 

have created on the Desktop. 

 Right click on the Icon (MS-Word) at the Desktop 

 Then hold and drag it to the area of Quick Launch on the 

Taskbar and release your hand from the mouse. And the 

following menu will pop up. 

 

 
 Fig.1.7  

                       

 

Note that the shortcut will not stay if the Quick Launch is not on the 

Taskbar. The Quick Launch part of the Taskbar is the section where 

your shortcut can stay.  

 

Click on Create Shortcut Here option 

 

If you use the left mouse to drag, you will not 

see this menu but the shortcut will be created.  
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Practice 8 

 

How to check whether the Quick Launch is on the Taskbar  

 

 Right click on any empty space of the Taskbar to give you a 

menu such as the one below: 

 

 

      
 

Fig.1.8 

 

3.9 Opening of Icons 
 

There are many ways of opening icons on the desktop, but there is only 

one way to open an icon on the taskbar and other bars. 

 

Practice 9 

 

How to open an Icon on the Desktop 

 

We shall use the MS-Word  icon we have just created to practise 

how to open an icon on the Desktop. Although we are yet to practice 

how to close windows, you can use the close buttons (,) at the top 

extreme right corner to close the windows 

 

 Double click on the Icon  and not on the name of the Icon 

underneath. 

 

Optional Method 
 

Right click on the Icon, and then click Open command from the pop-up 

menu. 

 

Locate Toolbars, and subsequently  

move to Quick Launch 

 

The absence of the check mark (good mark) 

denotes 

that it is not on the Taskbar 

 

Click on Quick Launch command to check it 

(make it available). 
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Practice 10  

 

How to open an Icon on the Taskbar 

 

If an Icon is on the Taskbar or any other bar, click on it  once in 

order to open it. For example click on the MS-Word Icon you have 

created on the Taskbar. 

 

3.10 Selecting (Highlighting) and Choosing Icons 
 

In windows, the terms Select and Choose have different meanings. 

Selecting an item usually means marking it with the selection cursor, 

which can appear as a highlight, a dotted rectangle with Radio Button or 

both. Selection alone does not start an action. You choose an item to 

carry out an action.  

 

Practice 11 

 

 Click on My Document Icon  to select it.  

You will notice that it now has a different colour or highlight 

depending on how your computer is set up. 

 Press Enter key to open (choose) 

 

Note: This is another way of opening an Icon 

 

3.11 Dialog Box 
 

A dialog box is a small window where you will be required to give 

further details on how your command is to be executed. Windows O.S. 

displays a dialog box when it needs additional information to complete a 

task. Most dialog boxes contain options you can select from. After you 

specify option, you can choose a command button to carry it out.  

 

Some dialog boxes may display information, warnings, or message 

indicating why a requested task cannot be accomplished.  

 

For instance, when you click on the Run and Shut Down or Turn off 

computer commands in the Start menu, the dialog boxes below will be 

seen. 
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Fig.1.9 

 

3.11.1    Moving Dialog Box 
 

If a dialog box has a title bar, you can move the dialog box to another 

location on your desktop. For instance the Run dialog box above has a 

Title bar, but the Turn off computer has none. Moving a dialog is just 

like moving window. 

 

Practice 12 

 

How to move a Dialog Box 

 

 Activate the Start Button and click on Run Command  

Run dialog box such as the one below will come up 

                    

                                 
Fig.1.10 

 

3.11.2    Closing a Dialog Box 
 

When you choose a command button, the dialog box closes and the 

command is carried out. You also use the close button, cancel and Esc 

key to close the dialog box. 

 

Closing the dialog box to complete the command 

 

 Select the option and click OK or Yes button 

 

Close Button Title Bar 

Turn off computer Dialog box            Run Dialog box 

Click on the title bar, then 

hold the mouse button 

down and drag it to the 

center of the screen. 
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Closing dialog box without completing the command 

 

 Choose the cancel button, or press ESC. 

 

4.0 CONCLUSION 
 

Underline character in a command pave way to a shortcut to the 

command; ellipsis command makes you to realise that a dialog box will 

come out whenever the command is activated. And when the mouse 

pointer points to a right-facing triangle command, it brings out a second 

menu which can also lead to third menu as the case may be. 

 

5.0 SUMMARY 
 

Selecting and choosing a command in computer have different 

meanings. Selecting a command means to mark it out different from 

other commands without carrying out the action. On the other hand, 

choosing means to carry out the action, after selecting it. 

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. Explain the following terms associated with the mouse: 

 

i. Double clicking ii. Dragging iii. Pointing/locating. 

 

2. State any two methods of how to open an icon on the desktop.  

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S (2000). Computer Science. (5th ed.). Gosport Hants: Asfifor 

Colour Press. 

 

Ithurralde, I. & Ramkaram, A. This is IT 2. (2nd ed.). 
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UNIT 2 WINDOWS OPERATING SYSTEM   

  CONTINUED: WINDOWS SCREEN LAYOUT 
 

CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 What is a Window? 

 3.2 Parts of a Window 

 3.3 Resizing Windows 

 3.4 Moving Windows 

 3.5 Scrolling 

 3.6 What you can do with Windows 

  3.6.1 Changing the Appearance of Windows 

  3.6.2 Screen Saver 

  3.6.3 Computer Time/Date 

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 

 

1.0 INTRODUCTION 
 

In this unit, you will learn what a window is, the various parts of a 

window and what you can do with window. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 define windows, label its different parts, and practice how to 

minimise, restore, maximise, close and resize a window 

 discuss how to use the scroll arrow and scroll box to scroll both 

horizontal and vertical scrollbars of a window 

 explain how to change the background or wallpaper and screen 

saver of a window 

 explain how to set the date and time of the computer. 
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3.0  MAIN CONTENT 
 

3.1 What is a Window? 
 

A window is a box or flame on the screen. For example, the flame 

below is My Documents’ window. It contains more commands than the 

dialog box and it is also bigger in size. 

 

When you work with applications, you often have a number of windows 

opened. Therefore, we shall use this part of windows as a preamble to 

explaining some of the common features of windows; however some 

have been dealt with already under dialog box. 

 

 

 

 

    
 

 

 

 

3.2 Parts of a Window 
 

Most windows have certain elements in common such as title bar and a 

menu bar. However, not all windows have every feature. The following 

are some of the common features. 

 

Title bar shows the name of the application or document. If more than 

one window is opened, the title bar for the active window (the one in 

which you are working) is usually brighter (in colour) than other title 

bars. 

Menu bar- lists the available menus from which you can choose 

commands. 

Window Border 

Down Scroll 

Arrow 

Up Scroll 

Arrow 

Scroll Bar 

Scroll Box 

Title Bar 
Minimize 

Button 
Maximize 

Button 

Close 

Button 

Menu Bar 

Fig.2.1: My Documents’ Window  
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Scroll bars enable you to move through document or a list when the 

entire document or list does not fit in the window or the allocated space. 

 

Maximise button ():  clicking this button with the mouse enlarges the 

active window so that it fills the entire desktop. The button will be 

visible if the window is not yet in its fullest size. 

 

Restore button (): replaces maximise button after you enlarged a 

window to its fullest size. It is used to restore the window to its original 

size. 

 

Minimise Button (−): reduces the window to an icon at the taskbar. 

You will notice that the window will disappear from the screen, but it is 

not closed. You can still open it from the taskbar by clicking on the 

Icon. 

 

Windows boarders: Are the four outside edges of a window. You can 

change the window size by lengthening or shortening the boarder on 

each side of the window.  

 

Practice 1 

 

How to minimise a window 

 Open My Documents Icon  on the Desktop to bring out My 

Documents window such as the one below: 

    

 

       
Fig.2.2 

Click on the Minimize 

Button 

 

You will notice that the 

window has 

disappeared from the 

screen and now an Icon 

or Button on the 

Taskbar as shown 

below:  
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The minimised button might be in short form such as: My Doc… 

or only the Icon  

 

 Click on the Minimised Icon on the taskbar to make it reappear. 

 

Practice 2 

 

How to maximise and restore a Window 

 

Try to identify Maximise and Restore buttons in My Documents’ 

Window above. 

 

 Click on the Maximise Button  or Restore Button   of My 

Documents’ Window above depending on how your window is at 

present.  

 

You will notice that the Maximise Button enlarges the window to 

occupy the whole desktop while Restore Button returns the window to 

its previous size. Also, Maximise button replaces Restore Button after 

clicking on Restore Button and vice-versa. 

 

Practice 3 

 

How to close a Window 

 

 Click on the Close Button  to close the window  

 

3.3 Resizing Windows 
 

In addition to Maximise and Restore buttons which you can use to 

resize window to take different sizes, window border could also be 

used to resize windows to your taste. 

 

Practice 4  

 

How to use the Window Border to resize a Window 

 

Open My Documents Icon on the Desktop to bring out a window such 

as the one below: 

 

 Click on Restore Button if the window is maximised. 

My Documents’ Window minimised 

as an Icon on the taskbar 
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Fig.2.3 

 

Hint: if you want to make the window smaller by dragging inward, 

either vertically, horizontally or diagonally, drag as if you are going to 

meet the opposite side. And note that it is only the diagonal resize that 

will not change the aspect ratio of the window. 

 

3.4 Moving Windows 
 

Moving a window to a different place on the screen can make it easier 

to see more than one window at a time or see something the window is 

covering up. 

 

Practice 5 

 

How to move Windows 

 

 Open My Documents Icon on the Desktop  

 Click on Restore Button if the window is maximised 

 Click on the Title bar of the window, then hold and drag to a 

new location, just the same way you move a dialog box. 

 

3.5 Scrolling 
 

Some windows and dialog boxes have scroll bars you can use to view 

information that does not fit inside the window or dialog box. In 

situations where you can view all the contents of a window or dialog 

Diagonal Resize 1: 
Point to any of the four 

angles (corners) of 

the window, and when 

your mouse pointer 

changes to this shape, 

click and hold to drag 

inward or outward 

diagonally to resize 

the window 

Vertical Resize: Point to the top or bottom border of the window, and 

when your mouse pointer changes to this shape, click and hold to drag 

inward or outward vertically to resize the window 

Horizontal Resize: 
Point to the right or left 

border of the window, 

and when your mouse 

pointer changes to this 

shape, click and hold to 

drag inward or 

outward horizontally 

to resize the window 

Diagonal Resize 2 
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box without scrolling, scroll bars may be absent or dimmed to indicate 

that they cannot be used. However, if a window is not large enough to 

display all the information, a scroll bar appears at the right-hand side 

and/or bottom of the window. That is vertical and horizontal scroll 

bars.  

 

Please see My Documents window under parts of windows 

above to identify scroll bar and its parts. Note that it is 

only the vertical scroll bar that is present here. Is there 

horizontal scroll bar in your window? You can also use it 

to practise too, if yes. The scroll bar(s) may be absent if 

your computer is new or there are no many files in my 

document folder. 

 

Practice 6 

 

How to scroll either Horizontal or Vertical Scrollbars 

 

 Open My Documents Icon at the Desktop  

 Click on Restore Button if the window is maximised. 

 

Using the scroll box:  

 

 Click on the Scroll box, hold and drag through all the 

information in a list or document. This is the fastest way of 

scrolling. 

 

Using the scroll arrows:  

 

To Scroll Do this 

One Line up or down Click the up or down scroll arrow 

Continuously Point to one of the scroll arrows, click 

and hold down the mouse button until 

the information comes into view. 

 

3.6 What you can do with Windows 
 

You can use windows to perform different tasks. Some of the tasks you 

can use windows to do are as follows: 

 

3.6.1 Changing the Appearance of Windows 
 

You can personalise windows with patterns, pictures and colours by 

using control panel. You can display pictures or patterns as well as 

wallpaper for windows or use your own scanned pictures. 
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Practice 7 

 

How to change the Background or Wallpaper of the Computer 

 

 Right click on the empty space of the desktop to bring out a 

Menu like the one below: 

 

                       
 

 
 

Fig. 2.4 

 

3.6.2 Screen Saver 
 

Screen savers are the different animations or displays that occupy the 

screen while the computer is idle after the stipulated time set. Screen 

savers can save wear and tear on your screen and protect your work 

when you are away. In your computer there are several of them that 

come with windows. 

 

Practice 8 

 

How to change the Screen Saver 

 

 Right click on the empty space of the desktop to bring out the 

Menu such as the one under Background or Wallpaper above.                        

Click properties option to bring 

out the Display Properties 

dialog box such as the one 

below 

Click on Desktop tab or 

background tab 

depending on the window 

version you are using. 

 

Select the background type of your 

choice. In this case, Azul is the 

selected option. 

 

You can also make changes on the 

Position of the background if you 

do not like the default type. In this 

case the position is on Stretch.  

 

Click on the down facing arrow to 

change it to Tile or Center and see 

the preview  

 

Click Apply and OK to effect your 

changes. 
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 Click properties option to bring out the Display Properties 

dialog box such as the one below: 

      
Fig. 2.5 

 

 Click Apply then OK to effect your changes. 

Allow the computer to be idle for the time you set to see the 

display 

 Press any key on the keyboard preferably, the space bar or 

shake the mouse to stop the Screen Saver display. 

 

3.6.3 Computer Time/Date 
 

The time of the computer is located at the right extreme of the Taskbar 

as shown below. Any file you create is maintained with the current 

settings. Therefore, the first thing you do after the computer has finished 

booting is to point to the clock to know whether the current date and 

time are correct 

 

 
 

 

 

Fig. 2.6 

 

 Double click the clock on the taskbar to bring out Date and 

Time Properties dialog box as shown below: 

 

Mouse Pointer 

pointing to Clock to 

bring out further 

information. 

Click on the Screen 

Saver tab 

Click on the down facing 

arrow to select Screen 

Saver of your choice. In 

this case, Starfield is 

selected. 

Click on the up/down 

facing arrow to 

increase or decrease 

time the computer will 

be idle before displaying 

the Screen Saver 



EDA742           MODULE 3 

 

233 

 

        
 

 

 

 

Fig. 2.7 

 

Practice 9 

 

Make your changes as instructed below: 

 

Year  1993 

Month  September 

Date  Last Friday  

Hour             5 

Minutes 42 

Seconds Omit or set at 01 

AM/PM If yours is on AM, change it to PM and vice-versa 

   

 Click Apply, and then OK to effect your changes 

 Point your mouse pointer to the Clock on the Taskbar and see 

what it is now. 

 Double click on the Clock again and set everything that you have 

changed to the current settings.                

 

4.0 CONCLUSION 
 

A window could be resized by using the Restore and maximise buttons 

and any border of the window.  

 

5.0 SUMMARY 
 

The background and screen saver of the computer could be changed 

through the Display Properties dialog box. 

 

Click on the up/down 

facing arrow to increase 

or decrease year 

Click on the item i.e. Hour, 

Minutes, Seconds or AM first 

before you click on the 

up/down facing arrow to 

increase or decrease any item. 

For example, click on 11 to 

place the cursor before 

clicking the up/down facing 

arrow. 

Click on the down facing 

arrow to select month. 

Click on date to select any date. 

For instance first Tuesday is the 

selected date here. 
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6.0 TUTOR-MARKED ASSIGNMENT 
 

1. Mention the name of the bar you can use to carry a dialog box or 

a window 

2. What is the name of the bar a minimised window stay when it 

disappeared from the screen? What do you do to bring the 

minimised window back to the screen? 

3. What is the name of part of the scroll bar you should use if you 

intend to scroll fast? 

4. Give the names of the following buttons in a window: 

 

 i)    ii)    iii)    iv)   

 

5. Give the names of the following mouse properties: 

 i)    ii)  iii) 

 

 

7.0 REFERENCES/FURTHER READING 
 

 French, C.S. (2000). Computer Science. (5th ed.). Gosport Hants: 

Asfifor Colour Press. 

 

Ithurralde, I. & Ramkaram, A. This is IT 2. (2nd ed.). 
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UNIT 3 IT AND MIS IN EDUCATION: COMPUTER  

  ELECTRONIC WORD PROCESSING USING 

  MS-WORD (MS-WORD SCREEN LAYOUT AND 

  FEATURES) 

  

CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 What is Word Processing? 

 3.2 What is Microsoft Word (MS-Word)? 

 3.3 Word Screen Layout 

 3.4 Hidden Toolbars 

 3.5 Arrangement of Toolbars 

 3.6 Active and Inactive Commands 

 3.7 Page Setup 

 3.8 Keyboard Keys 

 3.9 Creation of a New Document 

 3.10 Saving Documents (Files) 

 3.11 Closing/Quitting Documents (Files) 

 3.12 Opening of Files Saved in the Hard Disk 

3.13 Saving File/Folders in other Storage Mediums e.g. 

Diskette, Zip Disk and Flash Disk 

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 
 
1.0 INTRODUCTION 
 
Applications (MS-Word and MS-Excel) treated in this course did not 
cover the applications in computer wise, as you would expect. The 
topics selected are those that are considered to be of benefit to the 
actualisation of the success of MIS in education especially in areas of 
acquiring, processing and dissemination of information in education. 
 
Note that the knowledge of MS-Word here has covered that of Word 
Pad which is normally used for web pages and e-mail messages. 
However, explanation on how to load and use it will be done briefly at 
the end of the module. In this unit, you will learn how to create 
documents, save them in the hard disk or other removable disks, and 
open them whenever the need arises. 
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2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 explain what Microsoft Word is and how to load it  

 recognise the screen layout and the features  

 identify toolbar and how to arrange them  

 differentiate between active and inactive commands 

 set up a page before creating a new document  

 identify keyboard keys and use them  

 create a new document, save and open it  

 save and open file in Removable disks. 
 
3.0 MAIN CONTENT 
 

3.1 What is Word Processing? 
 

Word processing is an act of preparing, organising and production of 

document through the use of machine. Some of the applications for 

processing include: word perfect, word star, MultiMate advantage II, 

Display write, Textor, WinWord, Shakespeare etc. For our course, MS-

Word is used.  

 

3.2 What is Microsoft Word (MS-Word)?  
 

Microsoft word (MS-Word) for window is a word processing 

application programme used by modern secretaries, managers and 

corporate bodies to produce letter, chart graphics, memos, tables and 

borders etc.  

 

Practice 1 

 

How to load MS –Word  
 

You must start window before you load word since word is window 

based application programme. There are several ways to load word.  

 

 Click on the Start button  

 Locate Program (All Programs in Windows XP) and click on 

MS-Word  

 

Optional Method 

 

 Open the MS- Word Shortcut Icon  on the desktop or on the 

Taskbar if it is created  
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After loading, two windows will be displayed – the Microsoft Word 

WINDOW and A DOCUMENT WINDOW.  

 

3.3 Word Screen Layout  
 

The document window that you will work with will display the 

following bars, icons, button on the screen. 

 

 

 

 

 
 

 

 

 

Fig. 3.1: MS-Word Screen Layout 

 

The different parts of the MS-Word welcome screen are explained 

below:  

 

 
Title Bar: Displays the name of the active document. It is the coloured 

horizontal bar displayed at the top of the screen. In most computers, it is 

blue in colour.  

 

 
Menu Bar: This is the horizontal bar below the Title bar. MS-Word 

menu is made up of series of commands that allow you to work easily 

when they are activated. They are: File, Edit, View, Insert, Format etc.  

 

Standard  

Tools Bar 

Vertical  

Scroll Bar 

Title Bar 

Menu Bar 

Formatting  

Tools Bar 

Office Assistance 

Horizontal  

Scroll Bar 
Drawing Tools Bar 

Task Bar 
Status Bar 

Horizontal Ruler 

Cursor 

Selection Bar 

Vertical Ruler 

Restore  

Button 
Minimize 

Button 

Close 

Button 

MS-Word Screen Layout 
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Standard Toolbar: Is the third horizontal bar at the top of the screen. 

This bar consists of pictures (icons), which are shortcuts, to certain 

commands. In office 2000, from the first Icon, they represent: New, 

Open, Save, E-mail, Search, Print, Print Preview etc. Point to all the 

icons in order to know their names 

 

 
 

Formatting or Ribbon Bar: Helps you to quickly change the 

appearance of text. It is the fourth horizontal bar at the top of the screen. 

Depending on the arrangement of the bars, at times it overwraps the 

standard tools bar in some systems it is joined with the 3
rd

 bar. If that is 

the case of yours, note it start with: Normal, Times New Roman, 12, B, 

I, U, etc. 

 

 
 

Drawing Tools Bar: Helps you to draw some objects in word. It is 

located at the top button of your screen; it is the third segment of the tool 

bar.  

 

 
 

Status Bar: It is located at the button of the screen just after the drawing 

tool bar. It contains information about the user’s position in the active 

document; it also focus on the use of the active tool etc., i.e. current 

page, doc number, cursor position in the document etc.  

 

 
 

Task Bar: is at the button of the screen. It is all the time visible. At any 

time you start a programme or open a window, a button representing that 

programme or window appears on the Task Bar. When you close a 

window its button disappears from the Task Bar Other item such as the 

clock might appear on the notification area of the Task Bar Also you can 

create shortcut to certain programmes on the Task Bar e.g.  Icon is a 

short cut to Microsoft Word.  

 

                                  
Fig. 3.2 
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Office Assistance- it offers on line help in Application Programmes. 

That is, if the user appears to have performed an illegal operation or 

performing a task where readymade formats can be employed. While the 

office assistance can intrude into your work session on its own, it can 

also be triggered off by clicking on it. You can invoke it by clicking on 

the question mark icon  on the standard tool bar.  

 

3.4 Hidden Toolbars  
 

Toolbars you may want to work with but are absent from the screen are 

called Hidden Tools Bars. You can reveal and hide them if you wish as 

follows:   

 

Practice 2 

 

How to reveal Hidden Toolbars  

 

 Activate the View menu and locate Toolbars as shown below: 

 

 
 

Fig. 3.3  

 

Optional Method  

 

 Right click on any of the revealed bar, apart from the Title bar, 

preferably, the empty space of menu bar.  

 Check (click) on any toolbar that has been unchecked.  

 

3.5 Arrangement of Toolbars 
 

The arrangement of toolbars in any application program does not matter. 

At times the Formatting is seen before Standard or Menu bar. Also at 

times some Toolbars are placed vertically at the right or left hand side of 

the screen. 

 

The toolbars with the check mark (good 

mark) are the ones present while others 

without the check mark are absent. 

 

Click on any toolbar you want to reveal or 

hide. For example, uncheck Standard, 

Formatting and Drawing one after the other 

in order to hide them. 

 

Follow the same procedure to reveal them by 

clicking on each of them one after the other 

again. 
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Practice 3 

 

How to arrange Toolbars 

 

 
 

 

 

 

 

 

Fig. 3.4 

 

Optional Method  

 

 Click on any place of the bar (be careful not to click on any 

particular command or button), then hold and drag it to 

wherever you want it 

 

Please use the first method if you are finding it difficult to locate the 

empty space between commands or buttons.   

 

Rulers: (Horizontal and Vertical): These are used to measure the length 

and width of the user’s work sheet.  

 

Work Sheet: This is the electronic sheet with an insertion point given to 

the user to work with.  

 

Insertion Point: Shows where test will be inserted when you type. (It is 

the 1-shaped cursor that blinks on your screen).  

 

Scroll Bar:  This is used to control the focus and the display of the 

active document. It appears on the right edge and button edge of the 

document window. You can scroll by clicking or dragging the scroll bar.  

 

Selection Bar:  This bar is the region between the left edge of the 

document window and the left margin.  It is an unmarked area along the 

left- hand side. This region (bar) helps you to select quickly with the 

mouse. In the selection bar, the mouse pointer will turn to an arrow 

facing right e.g.  

 

3.6 Active and Inactive Commands  
 

Commands that respond immediately after they are chosen are active 

commands. They appear dark or blue in colour.  

 

Point to the fainted vertical line mark at the beginning of the bar, and 

you will notice that the mouse pointer will change to a cross shape like 

this: . Then click, hold and drag to any position where you want it. 
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Commands that do not respond immediately when they are chosen are 

inactive commands. However they might be active after more actions 

have been performed. They are usually grey or white in colour.  

 

The figure below shows examples of active and inactive commands. 

 

 
 

Fig. 3.5 

 

3.7 Page Setup  
 

At times you begin a new document by setting up the page. That is by 

determining the type of paper (A4 foolscap Legal, envelop or any other 

types), the orientation of the paper (portrait or landscape), the margins to 

be left out on all sides of the selected paper etc.  

 

Practice 4 

 

How to setup Page  

 

 Activate the file menu 

 

 Click Page Setup to bring out the page set up dialog box like the 

one shown below: 

Active Commands 

Inactive Commands 
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Fig. 3.6 

 

 Click on the down facing arrow on Apply to box to select This 

Point Forward if you do not want the settings to be applied to 

the whole document (for more than one page document)  

 Click OK. 

 

Note: It is not compulsory that you must carry out all the settings as 

explained above. Most often, it is the paper size that is always set on A4 

size before you commence your work because it is the ideal printer 

paper size for most printers. 

 

3.8 Keyboard Keys 
  

This topic is brought here so that we may have the practical knowledge 

of most of the keys that we shall be using frequently. Therefore, try to 

identify the outlined keys on the keyboard first before you attempt to 

read its function or practise with it.  

 

Computer keys: These are escape, Alt, Ctrl, Delete, Print Screen, Scroll 

Lock, Pause/Break etc. These keys are not found on the manual 

typewriter keyboard. 

 

Function keys (F1-F12): Perform different task according to the 

application software in use. At times the Function Keys are used in 

conjunction with other keys in the keyboard. 

 

Cursor or Arrow Keys: These are the Home, Page Up, Page Down, 

End, Home Keys and the 4 Arrow Keys. They are used to position the 

Margins allow you to setup 

appropriate margin to suit your 

task either by increasing or 

decreasing the margins at all sides 

of the paper. 

 

Orientation gives you the 

possibility of printing on portrait 

or landscape shape of the paper. 

 

Click on Paper Size tab in order 

to select the type of paper you 

would like to use e.g. A4, A3, B5 

etc. Note that if printer is not 

installed in your system, the list 

of various sizes will not come up. 

 

Click on Layout tab to set 

Header and Footer 
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cursor on the screen. In other words, they are used for moving around in 

your document. They are also called the navigator keys. 

 

Home and End Keys: Home key returns the cursor to the beginning or 

starting of the line while the End key returns the cursor to the end of the 

line. 

 

Page Up and Page Down: Page up is used to move the cursor up one 

page while Page Down is used to move the cursor down one page. 

 

The 4 Arrow Keys: Are used to move up and down or left and right 

between lines of texts and menus. They are also called the navigators. 

 

                          
Fig. 3.7 

 

Status Indicator (Light): The status lights are 3, located at top extreme 

right of the keyboard. They display the status either on or off. They are 

Caps Lock, Num Lock, and Scroll Lock. 

 

Caps Lock: Like other status indicators keys, the Caps Lock key is 

pressed to put it on or off. When it is on, all alphabetical characters will 

be capital letters and when it is off, all alphabetical characters will be 

small letters 

 

Practice 5 

 

How to use the Caps Lock Key 

 

 Press the Caps Lock key and ensure that the light is on, then type 

THE BOY IS COMING. 

 Press the Caps Lock key again and ensure that the light is off, and 

then type the boy is coming. 

 Please do not mind if the first letter T is capitalized automatically 

because your system might be set on Autocorrect 

 

Numeric/Direction Key Pad: The numeric keypad is like a portable 

calculator attached to the computer. The num lock light indicates that 

the numeric numbers (0-9) are active and when it is off, the arrow 

keys will be active instead. The numeric keypad allows you either to 

move the cursor or input numeric data. 

The 4 Arrow Keys 
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Practice 6 

 

How to use the Num Lock Key 

 

 Press the Num Lock key if the light is not on already 

 Type  1 2 3 4 5 6 7 8 9 10 11 12 to 40 

 Press the Num Lock key to off it, then type 4 4 4 or 6 6 6 6 6 or  

8 8 8 8 

What do you notice? The cursor is now moving up/down, left/ right 

 

Enter/Return Key: perform the follow functions. 

 

It moves the cursor from the end of one line to the beginning of the next 

without getting to the right margin where the computer can wrap. 

It is used to create more gaps between lines when the cursor is placed at 

back of the beginning of the line of text. 

In some keyboard it is marked with the sign: 

  

Practice 7 

 

How to use the Enter Key 

 

Type the following lines of text as they are. Please do not type the 

instructions italicized and bold at the end of each line. 

 

Why are you leaving us behind?       Press Enter key 

My dearest teacher of yesterday.     Press Enter key 

The memory of your departure is very great, to me is agonizing!         

Press Enter key 
Each time I remember your love, the spirit of sorrow fills my mind. 

 

 Place the cursor (i.e. I beam mark) at the back of the beginning of 

line 2 and it will be like this: (My) flashing. 

 Press Enter Key twice to create extra space. Please hold on and 

go further. 

 

Backspace key: Is often referred to as the tying ‘eraser’. The more it is 

depressed, the more character to its left are deleted. It is used to bridge 

abnormal gap between lines when the cursor is at the back of the 

beginning of the lines. Also, in some keyboard, it is marked with this 

symbol:  
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Practice 8 

 

How to use the Backspace Key 

 

 Place the cursor (i.e. I-beam mark) at the beginning of line 2 if it 

is not there already 

 Press Backspace Key twice to bridge the space.  

If you press it further, it will join the first line, but you can press 

Enter Key again to take it to the second line. 

 

Deleted Key: It is used to erase character to the right of the I-beam 

cursor one character at a time. However it should not be taken to be the 

same thing with the BACKSPACE that is used to cancel the most recent 

operation. 

 

Practice 9 

 

How to use the Delete Key 

 

 Place the cursor between the words – you and leaving in line 1 as 

shown below: 

 

Why are you  leaving us behind? 

 

 Press Backspace Key to erase Why are you and press Delete Key 

to erase leaving us behind?       

 

The logic is to use Backspace Key while deleting to the left and use 

Delete Key while deleting to the right. 

 

Escape Key: it is used to cancel the current line or command when the 

enter key has not yet been pressed. 

 

Shift Key: Allows you to type capital (upper case) or small letters 

(lower case). Also, it makes typing of upper keys special characters such 

as @, $, % etc possible. 

 

At time, it is shown on the keyboard by this symbol: 

 

Practice 10 

 

How to use the Shift Key 

 

 Ensure that your Caps Lock is not on 

 Hold the Shift Key to type A B C D E F, and release your finger 

and type a b c d e f, again. 
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 Hold the Shift Key to type! @ # $ % + ?, release your finger and 

use the same keys to type 1 2 3 4 5 = / 

 

Windows Key: With the indicator of the symbol      functions as a 

start button on the task bar. 

 

Practice 11 

 

How to use the Windows Key 

 

 If your keyboard is windows keyboard, press the windows key  

to activate the start button.  

 Press Esc (Escape) key to remove the Start menu from the screen. 

 

3.9 Creation of a New Document 
 

In MS-Word, there are two types of document creation – Template and 

Custom. Template involves using a document format as a guide to the 

new document to be created, and a wizard do assist in the creation of the 

document. On the other hand, with Custom document, the designer 

determines entirely how he wants the document to look.  

 

Now start working with MS-word by creating a custom document. Type 

the following passage. Do not attempt to edit the mistakes you may 

notice or format any text. We shall use it for practice. After typing some 

few lines, go to 3. 10 and practice how to save for the first time before 

you resume your typing.  

 

Obedience Pays 

 

In those days when men were living by might and power, when jungle 

justice was the order of the day, when lawlessness pervaded almost 

every society and trade was barter system; there came the colonial 

masters who claimed to salvage our fore-fathers from barbarism. 
 
The colonial master brought a system of government that was 

completely alien to the pre-colonial era especially in the south west of 

the country. There was nothing like taxation i.e. poll tax in that part of 

the nation before the arrival of the colonial masters. The people saw it as 

a disguise means of extorting the hard Queen's coin; they couldn't even 

get after much sales. Therefore, they have to avoid paying tax by all 

means either by escaping through the jungles where their houses were 

part of in those days or comically, a man disguising himself by wearing 

his wife’s attire and start doing some women domestic works; and he 
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will pretend to be deaf and dumb if the tax collectors happen to ask him 

any question about the husband’s whereabouts. 

 

On the other hand, the tax collectors were so cruel to the extent that 

they will take away a child in place of his father if the situation permits. 

They were popularly known as 'Dogeni (s)'. 

 

One faithful day, Mr. Egbor went to farm with his two sons – Okha and 

Oshoke. All of a sudden the rain started falling heavily; therefore they 

ran to the little farm hut to take shelter. Father and sons were enjoying 

themselves with the warmth of the fire and fresh roasted corns, when 

four Dogenis drenched with the rain seeking for shelter, entered the hut. 

Unknowingly to the Egbors, the Dogenis used the smoke from the fire to 

trace the hut. And there was no way they could escape. 

 

Dawn on Mr. Egbor, that they were inside the Dogenis’ net; he 

entertained them with fresh corns to the extent that one of the Dogenis 

was carried away with deep sleep. Like a trapped bush fowl, Mr. Egbor 

thought of other strategies to escape. He told his first son – Okha to go 

and harvest more corns for the Dogenis, at the same time, he used            

non-verbal cues of the eyes to tell him to go home from there. Okha 

retorted by saying: “I can't go. Don’t you see that the rain is still 

drizzling?” He did the same thing to Oshoke and he obeyed and went. 

After a while Mr. Egbor started shouting "Oshokee... What are you 

doing there? Are you not seeing the corn to harvest? ……This useless 

boy!” Subsequently, he told the Dogenis that he was going to check 

what was making Oshoke to delay. He zoomed off and met Oshoke at 

home. 

 
The Dogenis waited and night was approaching after the rain had 
stopped. What do you expect them to do with Okha? Of course they 
took him away as ransom for his dad and brother. 
 
This legend reminds me of a song my primary six (6) teacher taught us. 
It goes thus: 
 
Obedience pays, humility pays. 
They make you beloved to God and to man.  
Pride and disobedience and dishonesty pay.  
They make you be sorrow to God and to man. 
 

3.10 Saving Documents (Files)  
 

The recent Microsoft operating system offices have Auto Recovery to 

recover your document if there is power failure and there is no UPS to 

conserve power in order for you to save your document before shutting 

down the computer. However, it is a big risk because at times not 
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everything you did is recovered. Therefore it is advisable to save your 

document after typing some few words in the hard disk which is the 

local disk you are working with; and create a back-up in other storage 

medium such as diskette, zip, flash etc. 

 

Practice 12 

 

How to save a File for the First Time in the Hard Disk 

 

 Click on the file menu  

 Click on Save As command. And the Save As dialog box such as 

the one below will come up. 

 

 

   
 

 

 

 

 

 

Fig. 3.8 

 

You are free to use any name of yours to save the file but I would like to 

suggest that you use a common name (MS-Word Tutor) to save the file 

for easy reference.  

 

 Type the name of the file in the file name box. 

 Click on Save or press Enter key on the keyboard. Then you will 

see the name on the Title bar and Taskbar respectively. 

 

Subsequent Savings after the First Saving  

 

If a document is already existing with a name in the system, there is no 

need to use the save as command to save additional or subsequent work 

You will notice that the file name box contains the first few text of the first line you 

have typed. Ignore them and type your own file name; and you will see that 

everything will be deleted immediately you start typing. 

 

You can also click on the file name box and use the eraser keys (backspace and 

Delete keys) to erase the text before typing your own file name   

Ensure that Save in 

is My Document 

folder, because that 

is the ideal folder 

(directory) to save 

your files in the hard 

disk 

 
In case it is not there 

at default, click on 

the down facing 

arrow and select 

My Document 
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you have done or doing on it. You can use any of the following methods 

to save the subsequent work done. However the third and second 

methods are frequently used. 

 

 Activate the file menu  

 Click on Save command.  

 

Optional Method 1  

 Click the Save Icon  on the standards tool bar  

 

Optional Method 2 

 

 Press Ctrl + S 

 

3.11 Closing/Quitting Documents (Files)  
 

Every application programme is closed and quit before the system is 

shut down in order to avoid unnecessary message. 

 

Practice 13 

 

How to close and quit a File  

 

 Click on the close button   in the document window and 

Microsoft window respectively to quit the document 

 

Please consult windows operating System in unit 2 above if you have 

forgotten the close buttons.  

 

3.12 Opening of Files saved in the Hard Disk  
 

The open command is used to retrieve files saved in the hard disk. There 

are many methods you can use to open your files saved in the hard disk 

and the following open dialog box will appear no matter whichever 

method you applied.  Some of them are as follows:  

 

Practice 14 

 

How to open or retrieve a File in the Hard Disk  

We shall use the file (MS-Word Tutor) we have saved to practise 

 

To open through the Application window   

 

 Load the Application Programme (in this case MS- word).  
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 Activate the File Menu and click on Open command. Or Click 

on Open Icon  on the standard tools bar. Or Press Ctrl + 

O from the keyboard. 

 

The open dialog box such as the one below will appear no matter which 

of the three options you employed.  

 

 

 

 

      
 

Fig. 3.9 

 

Optional Method 1 – To open through My Documents Icon on the 

Desktop  

 

 Open my Documents Icon to show you my Documents window 

such as the one below: 

 

Click on Open 

at the right 

bottom or top 

of the dialog 

box. Or Press 

Enter Key to 

effect your 

action.  

 

Select the file (in this case 

MS – word Tutor)  
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Fig. 3.10 

 

Optional Method 2 –Through the Task Pane 

 

If you are using the recent versions of windows, e.g. XP, you will notice 

the appearance of a task pane either at the right or left of the document 

window every time you load MS-Word; and it will contain some of the 

recent files you have saved. 

 

      
 

 

  Fig. 3.11 

 

 

 

 Locate the 

File (MS 

Word 

Tutor) Icon 
and open it  

 

You will 

notice that it 

will load the 

Application 

Program 

and at the 

same time 

open the file  

 

Click on the close button to trigger 

it off if you do not want to use it. 

Click on the particular file (MS-Word 

Tutor in this case) 

 

It is the simplest method of opening files, 

but it does not contain many files.   

Task Pane   
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3.12 Saving File/Folders in Other Storage Mediums E.G. 

Diskette, Zip Disk and Flash Disk  
 

Files/folders in the hard disk are copied into other storage mediums such 

as diskettes, Zip Disks, flash disks, compact disks etc in order to transfer 

them to another computer or for making back-up of data files. 

 

Note that you can copy a file into the CD if your computer has CD 

Read/Write disks and drives in order to read from and write to CD. CD-

RW disk is relatively slow when data are being written to it. 

 

Also, it is important to note that Windows 98 does not have facilities for 

flash disk; and you may not be able to use flash disk even though your 

system has the recent Windows O.S. and there is no provision for the 

flash drive too. 

 

We have several methods of copying files and folders into other 

removable disks, but only one method that has no restriction is 

considered here. 

 

Practice 15 

 

How to save (copy) a File in the Hard Disk into a Diskette or Flash 

Disk  

 

Using My Documents Icon on the Desktop  

 

 Slot or plug the disk into the appropriate drive 

Note that the port for flash drive may be at the back or sides of 

the CPU. And after you have plugged a flash disk, the icon will 

appear on the notification part of the task bar. 

 Open My Document icon on the desktop  

My Documents window such as the one below will appear: 
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Fig. 3.12 

 

You may have noticed here that my flash drive is represented by Drive 

D- i.e. D: this is because there is no Compact Disk drive in my system. 

Yours might be E: or F: depending on the available disk drives in your 

system.   

 

Practice 16 

 

How to retrieve or open a File in the Diskette or Flash Disk  

 

From My Computer Icon on the Desktop  

 

 Open My Computer icon at the Desktop to bring out My 

Computer Window like the one below. 

 

Right click on the file 

or folder you want to 

copy 

 

 

Locate Send To 

 

 

Click on the drive you 

want to copy into (in 

this case, floppy 

disk).  
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Note: Remember to close the windows of all removable disks that you 

have opened before you remove them from their disk drives. And if you 

want to unplug the flash disk before you shut down the system, you do 

that through its icon on the taskbar as explained below: 

  

 

 

 

 
 

 
 

 

 

 

Open the File (MS-

Word Tutor) Icon  

 

Please scroll to 

locate the file if it is 

not at instant view of 

the window i.e. if you 

have many files in 

your disk.  

 

Open the removable 

disk Icon (in this 

case – the flash 

disk) 

 

Then you will see its 

content just like the 

one shown below  

 

 Click on the show hidden icons button if 

the flash icon is not visible at the notification 

area of the taskbar. 

 

 Use the mouse pointer to point at it to 

ensure that it is the flash icon before you 

click on it to get a message such as the one 

on the taskbar below, depending on the type 

of flash you are using. 
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Fig. 3.13 

 

The above message may appear pointing to the icon as indicated above 

or it may appear at the center of the screen. It depends on the method 

you adopt. 

 

4.0 CONCLUSION 
 

It is ideal in MS-Word that the page is set up before you attempt to 

create a document  

 

5.0 SUMMARY 
 

Back-up disks are very essential for files transfer from one system to 

another, and also guarantee safety of files in case the hard disk or the 

entire system develops faults which might be irreparable. 

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. Mention some keys that are peculiar to a computer keyboard that 

are not in the manual typewriter keyboard. 

2. The following symbols signify which key on the keyboard?      

  

 i)          ii)              iii) 

 

3. Mention the eraser keys on the keyboard and explain to novice 

how he/she can use them. 

4. List any three external disks you can use as back-up for your 

files. 

 

 Click on the message in order to 

get the final message that will permit 

you to remove the flash disk 
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UNIT 4 MICROSOFT WORD (MS-WORD)   

  CONTINUED: TEXT FORMATTING AND  

  EDITING 
 

CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 Selection of Text 

 3.2 Text Formatting 

  3.2.1 Font Type, Size and Style 

  3.2.2 Text Alignment 

  3.2.3 Dropped Capital 

  3.2.4 Change Case Command 

  3.2.5 Line Spacing Command 

 3.3 Text Editing 

  3.3.1 Spelling and Grammar 

  3.3.2 Synonyms (Nearest in Meaning) of Words 

  3.3.3 Find, Replace and ‘Go To’ Commands 

  3.3.4 Copying, Cutting and Pasting Text 

  3.3.5 Undo and Redo Commands 

  3.3.6 Page Numbering 

  3.3.7 Header and Footer 

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 

 

1.0 INTRODUCTION  
 

This aspect of MS-Word teaches you how to work with text in terms of 

formatting and editing to make the document look very attractive and 

free of many errors. 

 

2.0 OBJECTIVES  
 

At the end of this unit, you should be able to: 

 

 use mouse to select text  

 format text in terms of font type, size, style, alignment etc.  

 spell-check a document 

 find and replace text and find synonyms of words 

 space lines of text  

 copy, cut, and paste text  
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 redo and undo commands  

 insert page Number and create header and footer. 

 
3.0 MAIN CONTENT 
 
3.1 Selection of Text 
 
In order to specify where you want your action to take place, the text 
must be selected or highlighted. 
 
Practice 1 
 
How to use the Mouse to select 
 
 Load MS-Word and open the file (MS-Word Tutor) containing 

the passage – Obedience Pays. 
 Let us use the heading – Obedient pays to practice. 
 

To select single word or text e.g. Obedience 

 
 Place the cursor on anywhere in the word e.g. Obedience and 

double click to get result like this – Obedience  

 

How to erase any selection 

 
 Click outside the selection or press any arrow key on your 

keyboard. 
 

To select multiple texts or lines of texts 

 

 Place the cursor like this –     Obedience Pays, then click and 

hold down the mouse button and drag over Obedience Pays to 

the right to give you this result – Obedience Pays. Or place your 

cursor like this – Obedience Pays and drag to the left  
 
To use the mouse to select a large portion of the passage or the 
whole passage 
 
 Place the cursor at the beginning or end of the portion and drag 

left up or right down. 
 Place it at the end of the first paragraph like this as shown 

below: 

 

In those days when men were living by might and power, when 

jungle justice was the order of the day, when lawlessness pervaded 

almost every society, and trade was barter system; there came the 

colonial masters who claimed to salvage our fore fathers from 

barbarism. 
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 Click and drag to the left to select the last line and then go up to 

select the others to get result like this: 

 

In those days when men were living by might and power, when 

jungle justice was the order of the day, when lawlessness pervaded 

almost every society, and trade was barter system; there came the 

colonial masters who claimed to salvage our fore fathers from 

barbarianism. 

 
How to use the Selection Bar to select 
 
 Move the mouse pointer to the selection bar and ensure that you 

are at the beginning of the line, then you will notice that the 
pointer will turn facing the line of text just as the one shown 
below pointing to the first line of the passage. 

   
In those days when men were living by might and power, 
when jungle justice was 

 
 Click to select the whole line. And to select other lines at the top 

or bottom, hold down the mouse button and drag up or down as 
the case may be. 

 
To highlight the entire document with the mouse 
 
 Hold down the Ctrl key and click any part of the Selection bar. 
 
Note: Remember that the selection bar is the space between the left 
margin and the vertical ruler where the mouse pointer will be facing 
right pointing to the line of text. See MS-Word Screen Layout. 
 
How to use the Keyboard to select 
 
To select     Press 
One character to the right   Shift + Right Arrow keys  
One line down    Shift + Down Arrow keys 
One line up     Shift + Up Arrow keys 

Whole document    Ctrl + A 
 
Note: Wherever you see commands such as the above commands, it 
means that the first key e.g. Shift key/Ctrl key is held down while the 
other key is taped. And if the keys are three (3), you hold the first two (2) 
keys down, and then tap the last key. For instance, Ctrl + A, implies 
holding Control key down, and then tap A key;  
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Practice 2 

  

How to use the Keyboard to select 

 

Practise with the first line of the passage 

 

 Place the cursor between were and living as shown below: 

In those days when men were living by might and power, when 

jungle justice was  

To select – were men when days those In  

 Hold down the Shift key and start taping the Left Arrow key, 

or hold it down to select fast. 

 

To select - living by might and power, when jungle justice was the 

 

 Hold down the Shift key and start taping the Right Arrow key, 

or hold it down too to select fast. 

 

3.2 Text Formatting  
 

Text formatting involves all the techniques that are employed by the 

user in order to change the appearance of text to suit his own taste in 

form of character (font) type, size, colour, style e.g. bold, italics, 

underline alignment etc.  

 

In case you want to remove the format that you have applied, click or 

press the particular button or key you have used to apply it. Also, if it is 

applied through the dialog box, you can use the same dialog box to place 

it back at default. 

 

3.2.1 Font Type, Size and Style 
 

At default MS –Word’s font type is Times New Roman, and the font 

size and style are on normal (12) and regular respectively.  

 
Practice 3 
 
How to change Font Type 
 
Load MS-Word and open the file (MS-Word Tutor) containing the 
passage – Obedience Pays 
 
 Select the heading – Obedience Pays  
 Activate the Format menu, click on Font command 

 Click Font Tab if it is not already opened  
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The Font dialog box such as the one below will appear 
 

        
 

Fig. 4.1 

 

Is your result like this? Obedience Pays 

 

Optional Method – Using the Formatting Tools Bar 

 

 Highlight the text  

 

 
 

 

 

 

 

 

 

 

 

 

 

 

Fig. 4.2 

Here, Monotype Corsiva is 

the selected font type.  

 

Font style is on Bold Italic, 

while the Font Size is 36  

Click on these down facing 

arrows in order to select any 

colour and underline style of 

your choice.  

Scroll or type to select 

font size  

Click on B, I, U, to 

apply either bold, italics 

or underline to the 

selected text. 

Click on the down 

facing arrow to 

apply any font 

colour of your 

choice. 

Click on the down 

facing arrow to select 

any font size from the 

list of options 

 

You can erase the 

default size and type the 

one not on the list. But 

you have to press enter 

key to effect your 

changes. 

 

Click OK to effect your 

formats  

 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

262 

 

3.2.2 Text Alignment  
 

Alignment command positions selected texts of the document to 

specified part of the page. A text or paragraph can be aligned in four 

major ways left, center, right and justify  

 

Practice 3 

 

How to align Text 

 

Using the Formatting Tools Bar 

 
 Select the heading – Obedient Pays  
 Please point the mouse pointer to each button to know its name 

 

 
 

 

 

 

 

Fig. 4.3 

 

Optional Method – Using the Keyboard 

 

 Select the texts  

 Press Ctrl + L for Left alignment 

 Press Ctrl + R for Right alignment 

 Press Ctrl + E for Center alignment 

 Press Ctrl + J for Justify alignment. 

 

Note that Justify’s effect is noticed when you have multiple of text e.g. a 

page or more. It makes text to occupy the full width of the selected 

paper.  

 

3.2.3 Dropped Capital 
 

Letter (character) starting the first word in a paragraph of texts can be 

dropped by a number of specified lines to give a magazine look. When 

text is dropped, the character becomes bigger longer in height than text 

on the same line. 

 

 

 

 

 Click on any of the first three alignment buttons on the formatting 

tools bar to see how the heading could be aligned to the left, center and 

right of the page. Finally align it to the center of the page. 

 

. 
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Practice 4 

 

How to make Text a Drop Cap 

 

 Select the text e.g. letter I at the beginning of the first line in the 

first paragraph 

 Click on the format menu 

 Choose the Drop Cap to give you the drop cap dialog box as 

follows: 

 

     
 

Fig. 4.4 

 

n those days when men were living by might and power, when jungle 

justice was the order of the day, when lawlessness pervaded almost 

every society and trade was barter system; there came the colonial 

masters who claimed to salvage our fore-fore fathers from barbarism. 

 

How to remove a Dropped Capital 

 

 Select the text and follow the procedure of how to apply it above 

 Click on the None icon, and click on the OK button. 

 

3.2.4 Change Case Command 
 

It allows a user to switch between texts cases i.e. upper, lower, 

sentence, title and toggle cases. No mater which case you use to type 

your document, you can change it later to the desired case. 

 

Uppercase makes every selected text capital letters. Lowercase makes 

every text small letters; and sentence case capitalizes the first letter in a 

sentence and makes the others small letters just as in normal sentence. 

Title capitalizes the first letter of each word in a selected line(s) of texts, 

while toggle changes the first letter of the first word in all the selected 

sentences to small letters and capitalizes the rest. Note that title and 

toggle are not frequently used.   

I 

Click on either Dropped or In margin icon to select 

the type of drop cap. In this case, Dropped is 

selected. 

Type the number or scroll to select the number of 

lines to drop. In this case three lines are dropped. 

 

 

 
Click on OK to effect your format; and then 

check if your format looks like the one below. 
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Practice 5 

 

How to change Case using the format menu 

 

 Highlight the first paragraph of the passage in Ms-Word Tutor 

file 

 Click on the format menu and from the sub menu, click on 

change case command 

The change case dialog box like the one below will appear: 

              
Fig. 4.5 

 

Optional Method – Using the Keyboard 

 

 Highlight the texts as in first method 

 Press Shift + F3 intermittently until your format is on the 

intended one 

 

Note: Second method only allows you to get upper, lower and sentence 

cases; as you press the keys, it moves from one case to the other. 

 

3.2.5 Line Spacing Command 
 

By default, word single spaced lines of text and automatically adjusts 

line heights to accommodate graphics of large or smaller sizes. Custom 

spacing can improve the look of the document. 

 

Practice 6 

 

How to set Line Spacing using the Format menu 

 

 Select the paragraph, page or the whole document you want to 

adjust. In your case, select the whole document 

 Activate the Format menu and choose Paragraph to give you 

the paragraph dialog box such as the one below: 

 

 

 Click on any case you 

want to change to, and 

then click on Ok to see 

the result 



EDA742           MODULE 3 

 

265 

 

 
 

Fig. 4.6 

 

Optional Method – Using the Keyboard 

 

 Select the paragraph, page or the whole document you want to 

adjust 

 

For This Format      Press 

Single-spaced lines      Ctrl + 1 

Double-spaced lines      Ctrl + 2 

One-and-a-half-spaced lines    Ctrl + 5 

 

3.3 Text Editing 
 

Text editing is a way of using all the necessary tools to give precision to 

a document.  

 

3.3.1 Spelling and Grammar 
 

As often said, “no one is above mistake”; a user can wrongly spell a 

word in the document either due to speed or by placing hand on a wrong 

key. 

 

When typing on document, word uses wavy red underlines to indicate 

possible spelling errors and wavy green underline for possible 

grammatical errors in view of the computer’s dictionary. Therefore 

any word e.g. vernacular or British spellings underlined; and grammar 

that is correct but underlined should be ignored. The best way to correct 

Click Indent and Spacing tab if it 

is not opened already  

 

Click on the dropped down arrow 

by line spacing box to select one of 

the options:  

Single i.e. Single-spacing that Word 

can increase (Word here refers to 

MS-Word) 

1.5 lines i.e. One- and -a-half line 

spacing that Word can increase 

Double i.e. Double-spacing that 

word can increase  

   

At least i.e. The minimum line 

spacing that Word can increase 

Exactly i.e. Fixed line spacing that 

word does not adjust 

Multiple i.e. At most line spacing 

that word can increase  

   

 

 Click Ok to execute your formats 
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spelling and grammatical errors in the document is by running spell 

check on the texts in the document. 

 

Practice 7 

 

How to spell check a Single Word 

 

Move your cursor to the word e.g. coonial in the third line of the first 

paragraph and right click to pop out a menu like the one below: 

 

 

 
 

Fig. 4.7 

 

Practice 8 

 

How to spell check Multiple Words (Whole Document) 

Using the Tools menu 

 

 Ensure that the cursor is blinking inside the document 

 Activate the Tools menu 

 Click on spelling and grammar to bring out the spelling and 

grammar dialog box. 
 

 
 

 Locate the correct 

spelling from the 

suggested list of words; 

if it has more than one 

and then click on it. 

 Click on Ignore Once if 

the displayed word is 

correct but not recognize 

by computer dictionary; 

click on Ignore All if the 

highlighted word is more 

than one in the document. 

 

 Click on Add to 

Dictionary, if you intend 

to include the selected 

word into the computer 

dictionary   
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 Click on Change to correct the wrongly spelt word to suggested 

word by computer; click on Change All to change subsequent 

appearance of the highlighted word. 

 Click on Auto Correct to correct the displayed word manually. 

 

               
Fig. 4.8 

 

Optional Method 1 – Using the Keyboard 

 

 Place the cursor at anywhere in the passage and Press F7 key 

The dialog box in 1st method will appear. 

 

Optional Method 2 – Using the Standard Tools Bar 

 

 Place the cursor at anywhere in the passage 

 Click on Spelling and Grammar icon  on the standard tools 

bar 
The dialog box in 1st method will appear. 

 

3.3.2 Synonyms (Nearest in Meaning) of Words 
 

Thesaurus is used to find synonyms of words. It is used to improve the 

precision and variety of your writing. 

 

Practice 9 

 

How to check synonyms of a Word 

Right Clicking on the Word 

 

 
 

Fig. 4.9 

After you have finished spell checking the 

whole document, a message such as the one by 

the left may come out to alert you about the 

completion of the spelling exercise. 

 Right click on the particular word e.g. 

lawlessness in the first paragraph of 

MS-Word Tutor passage as indicated 

here 

 

 Locate Synonyms and you will 

notice the pop up of various possible 

nearest in meaning to the word you 

right clicked on. 

 

 Click on any word you would like to 

use to replace the original word 
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Optional Method – Using the Tools menu 

 

 
 

Fig. 4.10 

 

3.3.3 Find, Replace and Go To Commands  
 

These three commands are very useful in a document that has many 

pages. Find will show the word to you, wherever it is in the whole 

document but cannot replace it; while Replace will help you to find the 

word and at the same time change it to the intended word typed in the 

Replace box. Go To on the other hand, helps you to go to a specified 

page, section, line, footnote etc in the document 

 

Practice 10 

 

How to replace Words in a Document 

 

 Activate the Edit menu 

 Click on any of the three commands i.e. Find, Replace and                 

Go To  
 

  

 Select the word e.g. arrival in the second      

paragraph of MS-Word Tutor passage as 

indicated here 

 Activate the Tools menu and point to 

Language 

  Click on Thesaurus to give you the 

dialog such as the one by the left. 

 Select the required word in the pane 

under Replace with Synonym if you want 

to replace the selected word 

 Click Replace 
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Find and Replace dialog box such as the one below will come out 

 

 

 
 

 

 

 

 

 

Fig. 4.11 

 

3.3.4 Copying, Cutting and Pasting Text 
 

As you edit your document, you often find it necessary to copy or cut 

texts or graphics and paste them somewhere else in the document. Text 

that you copied or cut is placed on the clipboard. 

 

Clipboard is a temporal storage area that accommodates anything be it 

an object, text or graphic that is cut or copied using the cut and copy 

command from the standard tools bar or the edit menu. 

 

The clipboard does not accommodate more than one content and it is 

volatile; which means that it loses its contents when there is power 

failure. Therefore, whenever you apply the copy or cut command, try to 

apply the paste command immediately to complete your action. Also, it 

only operates in windows environment. 

 

Note: Cut removes the selected text from the document and stores it in 

the clipboard, while copy sends a duplicate copy of the selected text 

from the document and stores it in the clipboard. In other words, cut 

removes the selected text(s) or object(s) while copy duplicates the 

selected text(s) or object(s) 

Click Replace tab in 

case you used Find or Go 

To to bring the dialog 

box out 

 

 

 

Type in the word to find 

in this case Dogenis 

 

 

Type in the word to 

replace with in this case 

Police 

 
Click on the More 

button to restrict the 

find what. Here you can 

give specification based 

on the options. 

Click on Replace 

button to make just 

only one replacement 

in the document 

 

Click on 

Replace All 

button to make 

all replacement 

in the document. 

Please apply this 

option 
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Practice 11 

 

How to copy Texts or Graphics using the Standard Tools bar  

 

 Select the texts (in this case the first paragraph of Ms-Word 

Tutor) 

 

 
 

 

 

 

 

 

Fig. 4.12 

 

Let us paste what we have on a new sheet. And to get a new sheet, click 

on the New Blank Document icon  on the standard tools bar. As 

you can see from the standard tools bar above, it is the first icon 

 

Note: Try to use the undo command to get the paragraph back after 

using the cut and paste command. (see practice 12 below)  

 

Optional Method – Using the Keyboard 

 

 Select the texts 

 

For this Texts Editing     Press 

Cut       Ctrl + X 

Copy       Ctrl + C 

Paste        Ctrl + V 

 

3.3.5 Undo and Redo Commands 
 

Undo and Redo commands allow you to reverse in both ways any most 

recent action such as deleting, cutting, copying or closing most Word’s 

commands. You might click what you are not supposed to click; choose 

the undo command as the next action and if you want to reverse it again, 

choose the redo command. 

 

There is limit to undo and redo commands depending on how your 

computer is configured. Whenever they are inactive, that means you 

cannot cancel your last changes or actions.  

 

Click on cut icon if 

you want to remove 

the original 

paragraph from 

where it is. 

 

Click on copy icon if 

you want to retain the 

original paragraph and 

send a duplicate copy 

elsewhere 

 

Click on the paste icon 

after you have position the 

cursor at the current place 

where you want the 

paragraph to be e.g. at the 

end of the page 
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Note that there is no need for selection before you use these commands. 

Selection is applied below in order to delete the texts so that you can 

know the action of the commands when mistakes are made. 

 

Practice 12 

 

How to undo and redo Commands using the Standard Tools bar  

 

 Select the text (in this case the heading – Obedient Pays) 

 Press Delete key on the keyboard. 

 

 
 

 

 

 

 

Fig. 4.13 

 

Optional Method – Using the Keyboard 

 

For this Texts Editing     Press 

Undo       Ctrl + Z 

Redo       Ctrl + Y 

 

3.3.6 Page Numbering  
 

Page Numbers Command is used to apply page numbering 

automatically either through the insert menu or header and footer under 

view menu to the document.  

 

Practice 13 

 

How to insert Page Numbers  

 

 Click on the Insert menu  

 Choose Page Number command. And the page numbers dialog 

box such as the one below will come out: 

 
Page Numbering Format dialog box like the one below will come up:

Click on undo icon to 

bring back the deleted 

text 

 

Click on redo icon to 

reverse the action 

again i.e. deleting the 

text  

 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

272 

 

    
 

 

 

 

     
 

Fig. 4.14 
 

3.3.7 Header and Footer 
 

A header or footer is a text, which appears at the top or bottom of every 

page a bit above the top or bottom margin. Headers and footers often 

include such information such as document title, section or chapter title, 

date and time document was created, page number etc. What are the 

header and footer of this training manual? 

10 

 

Practice 14 
 

How to create Header or Footer  

 

Let the header of your document contain the page number, placed at the 

center and the footer should contain your name placed at the right 

margin 
 

 Click on the View menu  

 Choose Header and Footer command.  

You will notice that the document will be dimmed and the header 

and footer tools bar will come out as follows: 
 

Click on format tab if you want to change the style of the numbering. For example, 

you can change the Arabic numeral which is the default to upper roman, lower 

Roman Upper alphabet lower alphabet.  

 

Click on the down facing arrow by 

position box to change the position to 

Top of page or bottom of page  

 

Click on the down facing 

arrow by Alignment box to 

change the alignment to either 

right, center or left of the 

page 

Click on the down facing arrow to 

change the numbering format to any one 

of your choice. In this case upper 

alphabet is chosen 
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  

  

  

 

Fig. 4.15 

 

 Type header information such as chapter. name, page number etc.  

 To create footer, click the switch between header and footer 

icon on the header and footer tools bar to move to footer area.  

 Click Close on the header and footer tools bar when you are 

through.  

 

HINT: On the footer and header tool bar, you can click to insert page 

number using ‘#’ ‘button; current date, time auto text etc for example to 

insert Running –Total  number, such as “page  3 of 20”  click insert 

Auto Text.  And click page X of Y. 

 

4.0 CONCLUSION 
 

With MS-Word, text could be formatted to give the user what he 

expected; for instance, a user may decide to type a document in lower 

case and change it to upper case later. Also, there is room for editing, for 

example, when mistakes are made, the undo and redo command could 

be used to reverse the action or copy / cut and paste text at desired 

places. 

 

5.0 SUMMARY 
 

The formatting tools bar provides icons as shortcuts for formatting text, 

while the standard tools bar provides shortcuts for editing text. 

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. How do you select a single word with the mouse? 

 

2. Interpret the following commands 

 i)  Ctrl + C    ii)  Ctrl + X    iii)  Ctrl + V    iv)  Ctrl + Z      

Press the tab key to 

move the cursor to 

the center or right 

margin, depending 

on where you want 

to place the header 

 

Click on insert page 

number icon to 

insert page number 

 

Click on switch 

between header and 

footer icon if you want 

to go to the footer 

section, and vice versa  

 

Click on close 

button to go back to 

your normal page 
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 v)  Ctrl + Y 

 

3. Write short notes on the following 

 i)  Clipboard     ii)  Undo and Redo commands    

 iii)  Header and Footer 

 

4. How do you spell check a single word? 

 

5. Mention the keyboard shortcut for double and single spacing of 

lines. 

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S. (2000). Computer Science. (5th ed.). Gosport Hants: 

Asfifor Colour Press.  

 

Petroleum Training Institute (PTI). (1999). Lecture Manual on Word 

Processing. Warri. 
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UNIT 5 MICROSOFT WORD CONTINUED: TABLES IN 

  MS-WORD 
 

CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 Tables in Word 

 3.2 Entering Text into a Table 

 3.3 Table Selection 

 3.4 Adding (Inserting) New Rows and Columns to a Table 

 3.5 Deleting Table, Rows and Columns  

 3.6 Text Orientation (Direction) and Alignments in a Table 

 3.7 Adjusting Row Height and Column Width 

 3.8 Moving Table 

 3.9 Sorting Table Data 

 3.10 Splitting Table Cells 

 3.11 Table Borders 

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 

 

1.0 INTRODUCTION 
 

This part of word processing teaches you how to disseminate 

information with a table. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 insert table and enter text into a table  

 select table and other parts such as columns, rows and cells  

 insert and delete columns and rows whenever there is need  

 direct text in table’s cells vertically and align cells entries  

 adjust row height and column width to fit the text  

 sort table data either in ascending or descending order  

 split/merge table’s cells to give more information  

 apply boarders to a table. 
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3.0 MAIN CONTENT 
 

3.1 Tables in Word  
 

A table is made up of Rows and Columns where different related fields 

are entered. The intersection between Rows and Columns are the Cells 

which are units of storage. The Rows are horizontally arranged while the 

Columns are vertically arranged. Most often, it is convenient to 

represent information in a table for more clearance. However, table in 

MS-Word is similar to Ms-Excel, therefore what table can do in MS-

Word, can be done more conveniently in MS-Excel. See example of 4 

rows by 6 columns table is shown below: 

 

Practice 1 

 

How to insert Table using the Table Menu  

 

 Load Ms-Word or click on the New Blank Document icon on 

the standard tools bar if you are working on any other document 

in order to get a new sheet.  

 

 
 

 

 Position the insertion point where you want the table to be  

 Activate the Table menu  

 Locate Insert and click on Table.  

The Insert Table dialog such as the one below will come out. 

 

 
 

Fig. 5.1 

 

 

 

New Blank Document icon 

Type or scroll to get the number of 

columns. In this case, 7 entered for columns. 

Type or scroll to get the number of rows. 

In this case, 12 is entered for  rows. 

 

Click OK to insert the table 

Autofit to content is selected if you want the 

rows/columns to adjust automatically to fit the 

content of the cell as you are entering the data.  
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   Cell    

       

       

       

       

       

       

       

 

Fig. 5.2 

 

3.2 Entering Text into a Table 
 

Anytime you want to enter data into a table, click on the particular cell 

and start whatever you want to type. And to move within the cells 

vertically and horizontally, use the navigator keys. You can also use the 

Tab key to move horizontally.   

 

Practice 2 

 

How to enter Text into a Table 

 

 Insert a table of 4 x 5 i.e. 4 rows 5 columns like the one below 

and enter the data therein. 

 

NAMES MATHEMATIC

S 

ENGLIS

H 

GEOGRAP

HY 

AGRIC. 

SC. 

Iredia 

Austine 

54 62 48 53 

Onome 

Ejiro 

65 81 74 65 

Abdul 

Hassan 

84 62 51 80 

Bayo Tunde 45 56 65 70 

 

 Save the file with a name for future reference e.g. mine is saved 

thus – Primary 4 Table. 

 

 

Row 1 

Row 2 

Column  

      2 

Column  

     6 

Row 7 
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3.3 Table Selection 
 

Just as the same way you select text before formatting, the whole table 

or parts of the table is/are selected or highlighted to give you way to 

carry out any format you want to make. 

 

Practice 3     

                  

How to select Table’s Column  

 

 Take the mouse pointer to the top of the column, and when it 

turns to this shape  , then you click to select. 

And to select more than one column, hold down the mouse 

button after you have selected the first column and drag to the 

left or right to select the adjacent columns 

 

Practice 4   

                    

How to select Table’s Row  

 

 Take the mouse pointer to the selection bar, and when it turns to 

this shape, then you click to select. 

And to select more than one row, hold down the mouse button 

after you have selected the first row and drag to the top or bottom 

to select the adjacent rows 

 

Practice 5   

                     

How to select a Single Cell 

 

 Move the pointer to the left bottom right-angle of the cell along 

the left edge and click when it turns to this shape   , click to 

select. 

 

Practice 6       

                 

How to select the Whole Table 

 

 Select either the first or last column, then drag across to select 

others to the end  

  Or 

 Select either the first or last row, then drag across to select 

others to the end 

  Or 

 Click on Select All button. 
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Note: You will notice a dark or bluish colour on any selected part of a 

table. 

Fig. 5.3 

 

3.4 Adding (Inserting) New Rows and Columns to a Table 
 

At times there is need for you to add more rows or columns to a table in 

order to add more data or information. 

 

Use the following information to practice 

 

Insert a row to enter Peter Ajala’s data whose records are: Maths 58; 

Eng 73; Geo 47 Agric 62 between Onome Ejiro and Abudul Hassan i.e. 

3rd and 4th rows. Also insert a column between Geography and Agric 

Sc. i.e. 4th and 5th columns to enter the follow scores from top to 

bottom – 39; 65; 59; 47 and 68 for Music.   

 

Practice 7a 

 

How to insert Row(s) 

 

 Select the Row (in this case either 3rd or 4th row) 

 Activate the Table menu and locate insert  

 Click on Rows Above or Rows Below. 

 

Practice 7b 

 

How to insert Column(s) 

 

 Select the Column (in this case either 4th or 5th column) 

 Activate the Table menu and locate insert  

 

Mouse Pointer on top 

of column 4 pointing 

to select the column  

 

Mouse pointer 
on the selection 

bar pointing to 

select row 5  

 

Select All  

button 

 

Mouse pointer at the bottom left angle 

of the cell pointing to select a cell  
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 Click on Columns to the Left or Columns to the Right 

 

 
 

Fig. 5.4 

 

You now have a similar table like the one below; then enter the data 

supplied above. 

 

NAMES MATHEMATICS ENGLISH GEOGRAPHY  AGRIC. 

SC. 

Iredia 

Austine 

54 62 48  53 

Onome 

Ejiro 

65 81 74  65 

      

Abdul 

Hassan 

84 62 51  80 

Bayo 

Tunde 

45 56 65  70 

 

Fig. 5.5 

 

Optional Method 1 

 

 Select the Row or column   

 From the standard Tool bar click Insert Rows icon  or 

Insert Columns icon  
 

Optional Method 2 

 

 Select the Row or Column  

 Right click on the selected Row or Column 

 Click Insert Rows or Insert Columns as the case may be. 

 

Note: The shortcoming of the optional methods is that it does not give 

I chose Rows Below 

because I selected the 

3rd row 

 

I chose Column to the 

Right because I selected 

the 4th column 
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room to know whether the row will appear above or below; likewise 

whether the column will appear left or right of the selected column 

 

Practice 8 

 

How to insert New Row to the Bottom of a Table 

 

 Position the insertion point in the last cell of the table 

 Press Tab key on the keyboard. 

 

3.5 Deleting Table, Rows and Columns 
 

Just as there is need to add rows or columns to a table, also there is need 

at times to delete rows or columns, even the entire table. 

 

Delete row 5 i.e. Abdul Hassan and Column 3 i.e. English from your 

table 

 

Practice 9 

 

How to delete Rows, Column or Cells 

 

 Select the parts of the table i.e. row 5 and Column 3 one after 

the other  

 Click on the Table menu and locate Delete 

 Choose either Delete Rows or Delete Columns. 

 

Your table will now look like the one below: 

 

NAMES MATHEMATICS GEOGRAPHY MUSIC AGRIC. 

SC. 

Iredia 

Austine 

54 48 39 53 

Onome 

Ejiro 

65 74 65 65 

Peter 

Ajala 

58 47 59 62 

Bayo 

Tunde 

45 65 68 70 

 

Fig. 5.6 
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Optional Method 

 

 Highlight the Row or Columns you want to delete 

 Right click on the highlighted row or column 

 Click on Delete Rows or Delete Columns.  

 

3.6 Text Orientation (Direction) and Alignments in a Table 
 

At default, the orientation of text in a cell is horizontal and the 

alignment is top left in the cell.  However, texts in a table could be 

directed vertically down or up in other to create space for more data 

entries in a table. Text could either be aligned to the top, center or 

bottom. Office 2000 and above provide nine options for alignment of 

text in a cell. 

 

Practice 10 

 

How to direct Text in Table 

 

 Select the cell(s) – in this case, the first row that contains the 

field headings is selected. 

 Activate the format menu and click on Text Direction 

 

Text direction dialog box such as the one below will come up. 

 

 
 

Click on text vertical up button to 

make the orientation vertically up 

 

Click on text vertical down button to 

make the orientation vertically down 

 

Click on OK to carry out your action.  

 

You will notice from the preview section 

how the orientation changes. 
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For our case, vertical up is applied and the new table is shown below: 

 

N
A

M
E

S
 

M
A

T
H

E
M

A
T

IC
S

 

G
E

O
G

R
A

P
H

Y
 

M
U

S
IC

 

A
G

R
IC

. 
S

C
. 

Iredia Austine 54 48 39 53 

Onome Ejiro 65 74 65 65 

Peter Ajala 58 47 59 62 

Bayo Tunde 45 65 68 70 

 

Fig. 5.7 

 

Practice 11 

 

How to align Text in a Cell 

To center aligned the Field Headings 

 

 Select the first row that contains the headings as shown below: 

 

   
 

Fig. 5.8 

 

Practice 12  

 

How to align text in Selected Cells 

 

 Select all the cells that contain the data as shown below if you 

want the format to apply only to some of the inside text: 

Right Click on any 

selected portion, then 

locate  

 

Cell Alignment to give 

you a menu like the one 

seen on the figure, 

Choose  

 

Align Bottom Center icon  

to make the headings 

aligned  

to the bottom center. 
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Fig. 5.9 

 

Optional Method 

 

 Reveal tables and border tools bar if it is hidden. 

 

 
 

 
 

Fig. 5.10 

 

3.7  Adjusting Row Height and Column Width  
 

Table’s rows and columns are sometimes expanded or contrasted to 

accommodate texts in a particular cell if Autofit to content is not used to 

insert the table.  

Right Click on any 

selected portion, locate 

Cell Alignment,  
Choose  

Align Top Center icon 
to make the text aligned 

to top center 

 

Click on the down facing arrow by Cell 

Alignment Icon, and then choose Align 

Center Top option or any other alignment 

of your choice. 

 

 

Table after applying 

the alignments. 
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Practice 13 

 

How to adjust Row Height and Column Width 

 

 Position the mouse pointer in any of the cell of the table 

You will notice that both the vertical and horizontal rulers have 

taken the dimensions of the table’s row and columns. 

 

 
 

Fig. 5.11 

 

Optional Method 

 

 Move your mouse pointer to the line border between the rows 

or columns until the pointer changes to a double cross arrow. 

 Click and hold down the mouse button and drag up or down to 

enlarge or reduce the row height or drag to the right or left to 

enlarge or reduce the column width 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 5.12 

N
A

M
E

S
 

M
A

T
H

E
M

A
T

IC
S

 

G
E

O
G

R
A

P
H

Y
 

M
U

S
IC

 

A
G

R
IC

. 
S

C
. 

Iredia Austine 54 48 39 53 

Onome Ejiro 65 74 65 65 

Peter Ajala 58 47 59 62 

Bayo Tunde 45 65 68 70 

Click on Move Table 

Column then hold 

down the mouse button 

and drag to the right or 

left to enlarge or reduce 

the column width 

 

Click on Adjust 

Table Row and 

then hold down the 

mouse button and 

drag up or down to 

enlarge or reduce 

the row height  

 

After the adjustments, 

you will notice that the 

table now looks smaller 

and all the data are now 

properly arranged. 
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3.8 Moving Table 
 

A small table like the one above can be repositioned in any part of the 

document as you wish by dragging.  

 

Practice 14 
 

How to move Table 
 

 Click on select All button then hold and drag to move the table 
 

3.9 Sorting Table Data 
 

Sorting table data is a way of arranging data in ascending or descending 

order for easy reference or retrieval of the data. 

 

Practice 15 

 

How to sort Table Data 

 

 Position the cursor in the first cell i.e. NAMES of the table or 

select the whole table 

 Activate the table menu and then click on Sort command 

 

The sort dialog box such as the one below will come up  

 

 
 

Select either Ascending or 

Descending (in this case, ascending 

is selected). 

 

You can use the 2nd and 3rd Sort by, 

if you want to use another field 

heading to sort. This is often used 

when a database has field headings 

such as Surname, First Name and 

Middle Name. It is then good to use 

the 2nd and 3rd Sort by to arrange 

those names with the same surname 

or first name. 

 

Click OK to carry out your action. 
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Fig. 5.13 

 

3.10 Splitting Table Cells 
 

Table cells are split in order to enter more data in continuation of the 

previous data, most often the field headings. For example, let us include 

theory and objective column under Geography. 

 

Practice 16 

 

How to split Cell (s) 

 

 Erase the data under Geography and type them again after 

splitting. 

 Insert a row immediately after the field headings’ row, to enable 

you type Theory and Objective under Geography. 

 

Select the cells you want to split as shown on the first diagram below: 

 

 Activate the table menu, locate Split cells and click on it. 

The split cells dialog box (2nd Fig) will come out. 

 

 

 
 

Table after the Sort ascending 

command was applied. 

 

You have noticed that the first 

name now is Bayo Tunde. That 

is how they would be arranged 

notwithstanding how long the 

list may be; and all other data 

associated with them will 

follow suit.  

 

Type or scroll to 

enter the number of 

columns. In this 

case, 2 is entered. 

 

Click Ok or press 

Enter Key to carry 

out your action.  

 

Note: Do not touch 

the number of rows 
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Fig. 5.14 

 

3.11 Table Borders 
 

The vertical and horizontal lines form the borders in a table. You can 

beautify the table by applying different borders to the cell, row, column, 

or the whole table. Colour could also be applied if you are using colour 

printer. 

 

Practice 17 

 

How to format Table into Borders  

 

 Select the row(s), column(s) or the whole table (in this case, the 

whole table is selected).  

 Activate the Format menu  

 Click on Border and Shading  

Border and Shading dialog box such as the one below will 

appear 

 

 
  

The middle lines either 

in the diagram or 

buttons represents all 

the vertical and 

horizontal lines inside 

the table. 

 

Scroll and click to 

select any border style  

 

Click on the buttons or 

diagram to apply the 

particular border style 

 

Here, wavy line is used 

for inside vertical and 

horizontal borders, and 

the outside borders are 

on double line i.e. both 

vertical and horizontal 

lines 
Click on the down 

facing arrow to apply 

colour if you are using 

colour printer 

The None Box and All 

buttons could be used to 

apply or remove borders 

Table after 

splitting. 

 

You can now 

enter the data for 

Geography -     

Theory and 

Objective 
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Fig. 5.15 

 

4.0 CONCLUSION 
 

With table, some records for example, student’s records could be 

entered haphazardly and later sort out in alphabetical (ascending) order. 

 

5.0 SUMMARY 
 

Table cells could be merged and split in order to provide additional 

information. 

  

6.0 TUTOR-MARKED ASSIGNMENT 
 

Insert 10 x 6 table to reveal information of 10 students in 6 subjects. 

Choose names and subjects as you like. Sort the names in ascending 

order.  

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S. (2000). Computer Science. (5th ed.). Gosport Hants: 

Asfifor Colour Press.  

 

Petroleum Training Institute (PTI). (1999). Lecture Manual on Word 

Processing. Warri. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Table after applying 

different styles of 

borders 
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UNIT 6 MICROSOFT WORD CONTINUED: MORE  

  FORMATTING, EDITING AND PRINTING 
 

CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 Borders and Shading 

 3.2 Creating Documents in Word Pad 

 3.3 Renaming a File or Folder  

 3.4 Recycle Bin 

 3.5 Printing 

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 

 

1.0 INTRODUCTION 
 

There are some document formats and edits that are not so related to the 

ones we learnt in unit 4, consequently, this unit will let us have 

knowledge of such formatting and editing of text and miscellaneous 

topics. 

 

2.0 OBJECTIVES  
 

At the end of this unit, you should be able to: 

 

 apply colours shading colour to text in order to create distinctive 

emphasis  

 apply page boarder to make the document look attractive  

 create a file in word pad  

 define recycle bin 

 rename and delete file or folder 

 print a document. 

 

3.0 MAIN CONTENT 
 

3.1 Borders and Shading 
 

Borders and shading around selected paragraph or text make a document 

looks more presentable with distinctive emphasis. Art page border could 

be used to add beauty to the front page of a document. Example of Art 

border is shown on the first page of this module. 
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Practice 1 

 

How to add Shading to Selected Text  

 

 Open MS-Word Tutor File and select only the third paragraph 

 Activate the Format menu, click Borders and Shading  

Borders and Shading dialog box like the one below will come out 

 

 

 

 

 
 
On the other hand, the tax collectors were so cruel to the extent that 
they will take away a child in place of his father if the situation permits. 
They were popularly known as 'Dogeni(s)'. 
 

 

Note: If the font colour and the shading colour are the same, change the 

font colour to the opposite colour of the shading colour. For instance 

the font colour above was changed to white to get the opposite of black. 

 

Optional Method 

 

 
 

 

Fig. 6.1 

Click on the down 

facing arrow to 

choose whether to 

apply to paragraph 

or text. In this case 

it is applied to text. 

 

Click on OK   

 

 

Click on the down facing 

arrow by the Highlight 

Icon on the formatting 

tools bar. Then click on 

any colour and release 

your finger from the 

mouse 

 

Take the mouse pointer 

to the word and double 

click on it, or hold and 

drag across to highlight 

multiple words 

 

 

Text after applying 

Shading format 

Click on Shading tab if it is not the 

current opened tab at default.  

Click on any 

colour to select 

colour for 

shading.  Black 

colour is chosen 

here. 
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Practice 2 

 

How to add Border to a page  

 

 Place the cursor at anywhere inside the document  

 Activate the Format menu, click Border and shading  

Borders and Shading dialog box like the one below will come out. 

 

 

 

 
 

Fig. 6.2 

 
 

Fig. 6.3 

Click to select and apply 

any line style and colour 

just the same way you 

applied line borders to 

table above 

 

Click on the down facing 

arrow for more art 

borders 
 

Click on the down facing 

arrow to specify where 

you want the border. It 

could be applied to the 

Whole page, This section 

etc. Here it is applied to 

this section-First page 

only.  

 

Click on Option tab to 

get Border and Shading 

Options dialog box such 

as the one below to 

specify how you want the 

border to appear 

Click on the down facing arrow to select 

Edge of Page or Text. Note that if you 

select Edge of page option, the border 

will extend to include the margins. 

 

Click to uncheck Surround header and 

Surround footer options if you do not 

want the border to surround header and 

footer. Here, they are not unchecked. 

That is why the border on the page of 

demonstration above, includes the 

Header – MIS in Educ., and the Footer – 

page number. 

 

Click on OK and the other OK on the 

cascaded border shading dialog box to 

carry out your action. 
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3.2 Creating Documents in Word Pad 
 

We shall create another document (file) which we shall use to practice 

rename and file deletion in WordPad in order to prove to you that 

your knowledge of MS-Word Application has covered WordPad as I 

said at the beginning; you will notice that it is similar to MS-Word, but 

limited to some few commands. 

 

Practice 3 

 

How to create a Document in Word Pad 

 

 Activate the Start Button 

 Locate Programs 

 Locate Accessories 

 Click on WordPad to reveal the WordPad window such as the 

one below: 

 

        
 

Fig. 6.4 

 

 Type the following few lines of text: 

 

Bright some days, good bye, good bye, 

Everything passes away, away, 

I have nobody to comfort my soul, 

I’d better paddle my own canoe, paddle my own canoe. 

 

 Save it with a name – CANOE, just as the same way you saved 

for the first time in MS-Word 

 Close the window(s) so that you can be at your desktop 
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3.3 Renaming a File or Folder 
 

Renaming is a process of labeling a file/folder with another name. It 

does not change the content of the file or folder, but can affect the 

location. 

 

Note: Remember that the ideal place to store your files / folders is My 

Documents folder. Therefore whenever you want to look for a file you 

created with any Application Programme, open My Documents Icon at 

the desktop or from any other place as you might discover by yourself. 

 

Practice 4 

 

How to rename a File / Folder at the Desktop 

 

 Open My Document Icon at the Desktop with any method 

known to you 

 

 

 
 

 

 

 

Fig. 6.5 

 

Right click on the 

File (Canoe) Icon 

From the pop up 

menu, locate 

Rename, and then 

click on it 
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You will observe that the cursor is now flashing after the last character 

of the name of the file like the one demonstrated here:  

 

 Type the new name e.g. SHIP  

 Press Enter Key on the keyboard or click empty space outside 

the file  

 

3.4 Recycle Bin 
 

The file(s) you deleted are stored in the recycle bin. A recycle bin is a 

holding place for deleted files in windows environment. Deleted file(s) 

is/are not usually removed from your computer Hard disk until you 

empty the recycle bin. This implies that you can retrieve file(s) you 

deleted mistakenly, if you have not emptied your recycle bin. This also 

suggests that with the view to free up your disk space you must empty 

your recycle bin periodically. 

 

Note: Any file deleted at the command prompt or from a floppy disk 

does not go to the recycle bin. 

 

Practice 5 

 

How to erase (delete) an Unwanted File or Folder 

 

Follow the same procedures of how to rename a file above i.e. 

 

 Open My Document Icon at the Desktop with any method 

known to you 

 Right click on the File (Canoe) Icon  

 From the pop up menu, locate Delete, then click on it. 

Confirm File Delete dialog box such as the one below will 

appear 

 

 
Fig. 6.6 

 Click Yes to confirm deletion from the recycle bin dialog box. 

 



EDA 742  APPLICATION OF MANAGEMENT INFORMATION SYSTEMS (MIS) IN 

  EDUCATION 

 

296 

 

Optional Method 

 

 Click to select the Icon or file 

 Press delete key on the keyboard or choose Delete option from 

the file menu as the case may be 

 Click yes to confirm deletion from the recycle bin dialog box 

 

Practice 6 

 

How to recall (restore) the Deleted File 

 

 Open the recycle bin icon at the desktop 

 Select the file you want to restore 

 From the file menu click restore 

 

Optional Method 

 

 Open the recycle bin icon at the desktop 

 Right click on the file then select restore command. 

 

Practice 7 

 

How to Empty the Recycle Bin 

 

 Open the recycle icon at the desktop 

 Activate the file menu and select empty recycle bin 

 

Note: Mind the way you use this command because it will remove 

everything in the recycle bin, and there is no way you can easily regain 

any of them. 

 

3.5 Printing 
 

Print command allows you to print out the document on a paper. That is 

a way of producing the hardcopy. 

 

It is good that you preview the document to see how it will look like 

after printing. In computer jargon, it is called WYSIWYG (What You 

See Is What You Get).  

 

It is not all the commands in the print dialog box that are used to set 

your printing. 
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Practice 8 

 

How to preview a Document before the actual Printing 

 

 Open the document (MS-Word Tutor) and click to ensure that 

the cursor is inside the document. 

 Activate the File menu and click on Print Preview or click on 

Print Preview icon  on the Standard tools bar 

The Print Preview window such as the one below will open  

 

 

 

 
 

Fig. 6.7 

 

Practice 9 

 

How to print a Document 

 

 Open the document e.g. (MS-Word Tutor) and click to ensure 

that the cursor is inside the document. 

 Activate the File menu and click on Print or press Ctrl + P on 

the keyboard. Please do not use the Print icon  on the 

Standard tools bar at first printing because it will not give you 

the print dialog box for printing set-up. 

Click on the Magnifier icon to 

zoom so as to see details of the 

previewed page 

 

Click on this close 

button or the 

close button at the 

top extreme end of 

the window in 

order to return to 

the real document 

window when you 

are through with 

the preview. 
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The Print dialog box like the one below will appear 

  

   
 

 

 

 

Fig. 6.8 

 

4.0 CONCLUSION 
 

Any deleted file from the hard disk goes to the Recycle Bin, whereas 

flies that are deleted from any removable disk such as diskette, flash 

disk do not go to the Recycle Bin 

 

5.0 SUMMARY 
 

It is good to print the preview of any document before actual printing to 

see how the print out (hardcopy) will look like. 

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. Define the term Recycle Bin. 

2. Explain the procedure you can use to rename a file in My 

Document’s folder. 

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S. (2000). Computer Science. (5th ed.). Gosport Hants: 

Asfifor Colour Press.  

 

Petroleum Training Institute (PTI). (1999). Lecture Manual on Word 

Processing. Warri. 

Click on the down facing 

arrow to select printer, if 

you have more than one 

printer installed 

 

Click on Properties to 

select orientation under 

Layout i.e. Portrait or 

Landscape. The Paper 

size is also selected 

through this medium if it 

is on automatically select 

 

Type or scroll to enter the 

number of copies you 

want a page to produce. 

 

 

 

 

 In Page range section, select All - for all the pages to be printed; Current Page - for 

the page where the cursor is to be printed out; Selection - to print any selected part; 

Pages if you want to type the particular page number(s) you want to print. 
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MODULE 3  
 

Unit 1  IT and MIS in Education: Computer Spreadsheet 

  Management Using MS-Excel, Excel Welcome Screen 

  and Features   

Unit 2  MS-Excel Continued: Formatting and Editing of 

  Worksheet Data  

Unit 3  MS-Excel Continued: More on Formatting and Editing of 

  Worksheet Data 

Unit 4  Microsoft Excel Continued: Database 

Unit 5  Microsoft Excel Continued: Charts 

 

 

UNIT 1 IT AND MIS IN EDUCATION: COMPUTER  

  SPREADSHEET MANAGEMENT USING MS-

  EXCEL, EXCEL WELCOME SCREEN AND 

  FEATURES   
 

 

CONTENTS 
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2.0 Objectives 

3.0 Main Content 

 3.1 What is Spreadsheet Management? 

 3.2 What is Microsoft Excel (MS-Excel)? 

 3.3 Means of Navigation within a Worksheet 

 3.4 Entering Worksheet Data to Create a Document 

 3.5 Saving, Closing and Opening Books (Documents) 

 3.6 Editing the Content of a Cell 

 3.7 Columns’ Widths and Rows’ Heights 

 3.8 Selection or Highlighting 

 3.9 Clearing and Deleting Cells, Rows and Columns  

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 References/Further Reading 

 

1.0 INTRODUCTION 
 

Spreadsheet contains a grid of rows arranged in numbers (1 2 3 etc.) and 

columns arranged in letters (A B C etc.). The most common application 

programme under Spreadsheet is Microsoft Excel (MS-Excel). 

 

Since it is a window based application, particularly among the office of 

windows operating system, it shares some similarities with other 
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application programmes especially MS-Word. Therefore, in areas where 

such similarities are obvious, mere mention will be made without 

detailed explanation or illustration. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 define what is spread sheet management and the definition of  

MS-Excel  

 load Excel and recognise the Welcome screen environment and 

features 

 define columns, rows, work book, worksheet cells and range of 

cells  

 enter worksheet data to create a document  

 edit the content of a cell  

 adjust columns’ width and rows’ height  

 select various parts of a worksheet such as columns, rows, cells, 

range etc.  

 delete columns and rows 

 insert rows and columns and worksheet. 

 

3.0 MAIN CONTENT 
 

3.1 What is Spreadsheet Management? 
 

It is application software that contains table of cells arranged in the 

matrix of rows and columns. The most evident power of spreadsheet is 

its ability to handle calculations very fast. Examples of spreadsheet 

software are Quarto pro, Lotus123, Microsoft Excel, Supper Calc, 

Supper project, K- Speed, Plan Perfect etc; and out of these, we shall use 

MS-Excel as our application.  

 

3.2 What is Microsoft Excel (MS-Excel)? 
 

Microsoft excel is a spreadsheet management software for calculating, 

organising, analysing, and presenting data in various forms. Among 

others, it is meant for business management, financial management, 

scientific and statistical use of specialised functions and graphs. 

 

There is a worksheet to manipulate and analyse data such as numbers, 

text, and formula. With chart, you can quickly present your worksheet 

data graphically using either two–dimensional (2-D) or                            

three-dimensional (3-D) chart types. While databases facilities make it 
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easy to conveniently sort, search, and manage a large amount of 

information on a worksheet, using standard database operations. 

Indeed, Microsoft Excel is very important in information management in 

education because it helps to generate and analyse data in a special way 

to give useful information. 

 

Practice 1 

 

How to Load Ms-Excel 

 

 Coldboot the computer and after it has finished booting 

successfully and when it is at the desktop, then, 

 Activate the Start button to bring out the start menu 

 Locate Programmes (All Programmes in Office XP) and click 

on MS-Excel 

 

Optional Method: 

 Open the MS-Excel Shortcut Icon  on the desktop or on 

 the Taskbar , if it is created 

 

After clicking on Excel using any method above, the welcome screen 

such as the one bellow will come out. 
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Fig. 1.1 

 

The tools bars that you will work with in Excel are similar to the ones in 

MS-Word. Therefore, only those that are peculiar to Excel alone are 

given vivid explanation here.  

 

 
 

Fig. 1.2 

 

Reference Bar and Formula Bar 

  

The Reference bar and formula bar are joined together. It is the bar 

below the standard or formatting tool bar as the case may be.  

 

The Reference bar displays the active cell where the cursor is- e.g. G9 in 

the reference bar above and below. It is also called Name Box. 

Excel Welcome Screen 

Title Bar 

Standard Tool 
Bar 

Formatting Tool 

Bar 

Active 

Cell 

Cell 

Reference 

 Bar 

Formula Bar 

Status Bar 
Task Bar Vertical 

Scroll Bar 

Menu Bar 

Row Heading 

Minimize Button 

Restore Button 

Sheet Scroll 

Bar 

Sheet Tab 

Horizontal 

Scroll Bar 

Drawing  

Tools Bar 

Office 

Assistance 

Column Heading 

Close 

Button 
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Fig. 1.3 

 

Note: The column headings can take any case i.e. upper or lower case. 

For example, A8, T5 and P12 or a8, t5 and p12. 

 

The formula bar at times displays some icons such as cancel , enter 

, sign of equality = or function  sign  , depending on the task the 

user is doing.                    

 

The enter icon serves the same purpose of enter key on the keyboard. 

Also, cancel icon performs the same function of Esc key or Del key on 

the keyboard. The moment you start typing or editing cell data, the 

formula bar becomes active.   

 

Mouse Pointer  
 

This shows where the next action will occur when you click the mouse. 

It takes the shape of an I-beam   when it is in the formula bar or cell that 

is edited. It is a cell pointer  when placed over a cell; and an                  

arrow     when you point at graphics, status bar, menu bar, scroll bar etc. 

 

Columns/Rows Headings 

 

In Excel, the columns are arranged in alphabetical order i.e. A-IV and 

the rows are in numerical order i.e. 1-65536. At times they may set the 

columns headings on numerical number same as the rows headings as 

you can see from the figure below; and this may confuse you when 

referring to cell entries. If yours is like that, you can change it as 

follows: 

When referring 

to the cell entries 

in Excel, you call 

the column 

heading and row 

heading, but not 

the content. For 

instance, you call 

C4 in order to 

refer to kobo. 

Likewise you say 

E6 in order to 

refer to naira 

The column heading (G) and row heading (9) of the active cell are highlighted with 

blue or dark colour. 
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Practice 2  

 

How to set the Column Headings to take Numerical or Alphabetical 

Value 

 

 Activate the Tools menu and click on Option command from the 

pop-up menu 

The Option dialog box such as the one below will show 

 

 
Fig. 1.4 

 

Practice 3 

 

How to view the last Column/Row 

 

 Hold down the Control (Ctrl) key and tap the Right Arrow key 

  in order to see the last column 

 Hold down the Control (Ctrl) key and tap the Down Arrow key 

  in order to see the last row 

 

Workbook: A workbook is a collection of worksheet in Microsoft 

Excel; it is the file in which you work and store your data. Because each 

workbook can contain many sheets, you can organize various kind of 

related information in a single file. 

 

Worksheet: Is the primary document for the storage and manipulation 

of data; it is always a part of the workbook. Worksheet is for listing and 

analyzing data. You can enter and edit data on several worksheets 

simultaneously and perform calculation based on data from multiple 

worksheets.  

Click on General tab 

 

Uncheck the 

Reference Style 
under Settings 

 

Click on OK to effect 

your action 
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Usually, it holds texts, figures graphs etc. Each worksheet is a 

rectangular grid of 265 columns and 65,536 rows which form the cells. 

Once excel is loaded or invoked, a worksheet will be presented to you to 

work with. 

 

Cell: A cell is an intercept of rows and columns (i.e. where a row and a 

column meet). Hence the entire worksheet is a grid of cells. A cell can 

contain word, numeric values, symbols, formula or nothing. Each cell is 

identified by a cell address format known as Column - Row format e.g. 

A1, C3, E4, or Row - Column format. The content of a cell is identified 

with its address 

 

Range: A range is a rectangular box that comprises numbers of cells. It 

is identified or noted with the first cell address separated with colon and 

the last cell address e.g. A1:D8 In other words, it is a reference that 

relates to more than one cell. Most often in order to perform some 

specific task you may need to define or specify a range to be used. 

 

The method of referring to a range is by calling the first cell and then the 

last cell. For example, in the figure below the numbers occupy cell B4, 

C4, D4, E4, F4, G4 and H4. Since it is a range, just take the first cell and 

the last cell and separate them with a colon (:)  Examples are shown 

below: 

 

 
 

Fig. 1.5 
B4:H4 
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Fig. 1.6 

 

3.3 Means of Navigation within a Worksheet 
 

To move cursor from one cell to another use the arrow keys 

 to move the cursor to the desired cell.  

Or  

Simply place the mouse pointer in the cell you wish to move to and 

then click. Also, Enter key and Tab key could be used to move the 

cursor down or left and right. 

 

3.4 Entering Worksheet Data to Create a Document 
 

You can enter constant values and formulae into a worksheet. A 

constant value is a data that is typed directly into a cell without attaching 

any cell reference name to it. It can be a numeric value; letters, date, 

time etc. 

 

On the other hand, a formula is a sequence set of instruction coded for 

calculation. It is made up of constant values, cell references names, 

functions or operators that produce new values from existing value. 

More of formulas will be seen later. 

 

Let us start by creating a small database to practise how to enter data 

into a worksheet. Please type exactly the way it is. We shall use it for 

our practical exercises in Excel.  

 

AH5:AJ10 

r2:r9 
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In excel, page setup is not necessary at the beginning; you might set up 

the page by the time you are about to print. 

 

Practice 4 

 

How to enter Data into a Worksheet  
 

 Click on any cell you want to enter the data into – in this case, 

 cell A1 to type surname. Then use any of the navigators to move 

 to the next cell you want to type in. 

 

Note that the cursor will not blink until after you have started typing 

unlike MS-Word. Please do not jump any cell even though the entry in 

the preceding cell spreads across the one you want to type in, ignore it 

and continue your typing. 

 

 
 

Fig. 1.7 

 

3.5 Saving, Closing and Opening Books (Documents) 
 

In every windows application programme particularly these ones – MS-

Word, MS-Excel, MS-PowerPoint and MS-Access) that come with the 

Office; the procedures of saving, closing and opening files are the same. 

Therefore refer to MS-Word for the explanations 

 

Just as we did in MS-Word, we shall use a common name to save it for 

the first time for easy reference. The name you must use is: Excel 

Tutor. 
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3.6 Editing the Content of a Cell 
 

MS-Excel is not like MS-Word where you can easily edit text after 

typing. Any attempt to edit cell entry without bringing out the cursor 

first, will delete the entry. However, cell entries could be edited through 

the formula bar for convenience sake. 

 

Practice 5 

 

How to edit cell entries 

 

For example the content of cell B9 is not correct. The content supposes 

to be OMOLARA. Letter O is missing. In order to add the missing 

letter, follow the methods below:  

 

 

 
 

Fig. 1.8 

 

Note: If you want to type a new entry to replace an existing one, just 

click on the cell and start typing. No need for you to look for cursor or 

go to formula bar for editing.  

 

3.7 Columns’ Widths and Rows’ Heights 
 

Worksheet Column Widths and Row Heights can be adjusted to fit the 

content of the cell in a similar way of adjusting table Column Widths 

and Row Heights in MS-Word. You can observe from the Field 

headings above that some of the field headings are not fully displayed 

e.g. ENG. LANGUAGE, MATHEMATICS, and SOCIAL STUDIES 

etc. 

Although there are several methods of adjusting Column Widths and 

Row Height, but we shall restrict ourselves to the simplest method 

Click on the particular cell you 

want to edit (B10 in this case 

that contains OMLARA). It will 

appear on the formula bar 

immediately you click  

 

Move the mouse pointer to the 

formula bar and when it takes 

I-Beam shape, click to edit the 

entry 

 

Optional Method  

After clicking on the cell, press 

F2 key on the keyboard or 

double click the mouse to bring 

out the cursor for editing  
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Practice 6 
 

How to adjust Column Width and Row Height 
 

 
 

 

 

 

Fig. 1.9 
 

Note: The number of inches or pixels of the particular column or row 

will appear as you are dragging. 
 

3.8 Selection or Highlight 
 

Before carrying out most commands and task in Microsoft excel, you 

must first select or highlight the part of the worksheet you want to work 

with. A worksheet selection could be a single cell, worksheet, a range of 

cells etc. 
 

The absence of colour from the first cell in a range of cell does not mean 

that it is not selected. 
 

Note: You will notice a dark or bluish colour on any selected part of a 

worksheet. 
 

Practice 7 
 

How to select the Whole Worksheet  

                           

 

 

 

 

 

 

 

 

 

Fig. 1.10 

Click on the Select 

All Button in order 

to select the Whole 

Worksheet. The 

Select All Button is 

the empty cell the 

arrow is pointing at 

i.e. the cell by the 

left of A and above 

1 

Move the  

mouse pointer to the 

border line between 

the Column headings 

(between D and E as in 

the figure in order to 

enlarge or reduce 

column D i.e. Eng. 

Language field 

heading), and when it 

changes to this cross 

shape, then click, hold 

and drag either to the 

right in order to 

increase or drag to 

the left in order to 

decrease the number 

of inches or pixels of 

the column.  

Move the mouse pointer to the border line between the 

Row headings (between 3 and 4 as in the figure in order 

to enlarge or reduce row 3 and when it changes to this 

cross shape, then click, hold and drag either up in order 

to decrease or drag down in order to increase the number 

of inches or pixels of the row. 
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How to deselect or erase any Selection: 

Click any part of the worksheet or press any arrow key on the 

keyboard.  

 

How to select a Single Cell 
 

 Click on the cell you want to select and that makes the particular 

 cell the active cell (a cell that is currently selected). And the 

 address is always found on the cell reference bar. 

 

Practice 8 

 

How to Select Entire Row 

                         

 
 

 
Fig. 1.11 

 

Practice 9 

 

How to Select Entire Column 

 

   
 

 

Click on the row heading 

i.e. 1,2,3 etc. In this case, 

Row 4 is selected by 

clicking on 4 which is the 

row heading 

 

 

Click on the column heading i.e. 

A, B, C etc. In this case, column 

D is selected by clicking on D 

which is the column heading. 

 

 

In case you want to select 

more than one row after you 

have selected the 

first row, hold down the 

shift key, and then drag 

through the other adjacent 

rows. For example, after 

selecting row 4, hold down 

the shift key, and then drag 

through 8. Vice versa 
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Fig. 1.12 

 

Practice 10 

 

How to select a Range of Cells 

  

 
 

Fig. 1.13 

 

3.9 Clearing and Deleting Cells, Rows and Columns 
 

Clearing and deleting are two ways of removing data from the 

worksheet. Clearing a cell includes clearing the contents, formats, notes 

etc assigned to that cell, but leaves the cleared cell, row or column in the 

structure of the worksheet. Delete key on the keyboard, also performs 

same function with the clear command in the edit menu. On the other 

hand, Delete command in the Edit menu or Shortcut menu, 

completely removes the cell, column, row from the position including 

the content and any format assigned to it.  

Click on the first cell. In 

this case, A2 is the first 

cell. 

 

Hold down the mouse 

button and drag through 

the other cells until you 

get to the last cell; in this 

case, D8. 

In case you want to select more 

than one column after you have 

selected the  

first one, hold down the shift 

key, and then drag through the 

other adjacent columns. For 

example, after selecting column 

D, hold down the shift key, and 

then drag through B. Vice versa. 
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Practice 11 

 

How to clear Cell Contents, Formats, and Notes       

 

 Load the document – Excel Tutor 

 

 
 

 

 

 

 
 

 

Fig. 1.14 

Right click on the 

column, row heading 
or cell. In this case, B 

i.e. column heading is 

used as an example. 

From the pop-up 

menu, locate clear 

contents and click on 

it.  

Alternatively, select 

column B and then 

press delete key on the 

keyboard 
 

The result of the 

database after clearing 

the contents is shown 

below: 

You will notice that 

the contents in all 

the selected cells 

are deleted but the 

column still 

remains intact. 

 

Please remember to 

click the undo Icon 

 on the 

standard tools bar 
or press Ctrl + Z to 

bring back the 

contents. 



EDA742           MODULE 3 

 

313 

 

Practice 12 

 

How to Delete Cell, Columns and Row      

 

 Load the document – Excel-Tutor 

 

 
 

 

 

 

 

 

 

Fig. 1.15 

 

Note: Excel deletes the row or column and shifts other adjacent rows 

and columns in the worksheet to fill the space.          

 

4.0 CONCLUSION 
 

Cell could be edited through the formula bar, pressing the F2 key or by 

double clicking the mouse to get editing mode of the cell. 

 

5.0 SUMMARY 
 

All windows application programmes have common method of 

executing some commands. For instance Cut, Copy, Save, Close, Undo, 

Right click on the column, 

row heading or cell. In this 

case, 4 i.e. low heading is 

used as an example. 

From the pop-up menu, 

locate Delete and click on 

it.  

 

Optional Method 
Select row 4 

Activate the Edit menu 
and then click on Delete 

command from the pop-up 

menu. 

The result of the database 

after deleting the row with 

its contents is shown 

below: 

 
You will notice that the contents 

and the entire row are deleted.  

 

Note: Do not let the 4 which is 

the row heading confuse you. 

Row or column headings are not 

deleted. And to prove that the 

entire row was deleted, check 

the records of Okafor Vivian 

Ada that were in row 5; where 

are they now? They are now in 

row 4.  

Please remember to click the undo Icon  on the 

standard tools bar or press Ctrl + Z to bring back the 

row and the contents. 
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Redo etc., have the same procedure of applying them in every windows 

application programs. 

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. Differentiate between a workbook and worksheet. 

2. Explain the following terms: 

(i) Cell (ii) Row (iii) Column (iv) Range 

3. Mention the keyboard keys you should press if you want to see 

 the last Row and Column of worksheet.  

4. Mention any toolbar that is peculiar to MS Excel in comparison 

 with MS-Word. Compare and contrast the menu bar of MS-Word 

 and Ms-Excel. 

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S (2000). Computer Science. (5th ed.). Gosport Hants: Asfifor 

Colour Press.  

 

Petroleum Training Institute (PTI). (1999). Lecture Manual on Word 

 Processing. Warri. 
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UNIT 2 MS-EXCEL CONTINUED: FORMATTING AND 

  EDITING OF WORKSHEET DATA 
 

CONTENTS 
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 3.2 Inserting a New Worksheet 

 3.3 Renaming Worksheet 

 3.4 Worksheet Protection 

 3.5 Deleting Worksheet 
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7.0 References/Further Reading 

 

1.0 INTRODUCTION 
 

In this unit, you will learn more commands that you can use to edit and 

format a worksheet. Also, you will learn how to save time when typing 

data that have preset fillings in Excel. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 insert rows, columns into a worksheet 

 insert a new worksheet and rename worksheet 

 protect and delete a worksheet 

 hide and unhide columns and rows 

 fill preset data 

 align worksheet data 

 change the Orientation of text.  
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3.0 MAIN CONTENT 
 

3.1 Inserting Rows and Columns 
 

After you have entered data on the worksheet you may want to insert 

blank columns/rows in order to create room for new data or to include 

more empty space in the data area 

 

Practice 1 

 

How to Insert Rows or Columns  

 

 Load the document – Excel Tutor 

We shall insert 3 rows to enter the general headings for the database 

 

 
 

 
 

 
Fig. 2.1 

 

Let us assume that one of the subjects (INTRO TECH) was forgotten, 

and you are required to enter the data between MATHEMATICS and 

SOCIAL STUDIES. The marks, starting from the first student to the last 

 Select the first three rows  

 

 Right click on any part of 

the selected area, and then 

locate Insert command and 

click on it. 

 

The result of the database will 

now be like the immediate one 

below. 

Click on cell A1 and 

type SKY LIMIT 

SECONDARY 

SCOOL 

Click on cell A2 and 

type IGBOBI ROAD, 

YABA, LAGOS 

Click on cell A3 and 

type FIRST TERM 

EXAMINATION  

Result of the database 

after typing the 

general headings 
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are as follows: 40, 36, 67, 72, 44, 28, 39, 50, 81, 84, 72, 49, 33, 74, 49, 

53, 47, 39 and 50. 

 

 
 

 
Fig. 2.2 

 

3.2 Inserting a New Worksheet 
 

At default, Excel provides three sheets, however you can insert more 

sheets as you wish whenever the need arises.  

 

Practice 2 

 

How to insert a Worksheet 

 

 Activate the insert menu 

 Click worksheet 

 

Look at the sheet tabs on the scroll bar, you will notice that they are 

now four, and sheet 1 is no longer the first sheet. Follow the 

procedure below to rearrange the sheets in order. 

 

Result of the 

database after 

inserting a 

column to enter 

the data of Intro 

Tech that was 

forgotten 

Select column F 

that contains 

Social Studies  

Locate Insert 

command and 

click on it. 

 

Enter the data 

supplied above in 

the new column 
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Click on the sheet tab – sheet 4 in this case,  

then hold and drag until where the mouse pointer is at the position you 

want to drop it – i.e. after sheet 3 in this case. You will notice that the 

mouse pointer will change to this shape  as you are dragging. 

 

Fig. 2.3 

 

 
 

Fig. 2.4 

 

3.3 Renaming Worksheet 
 

Worksheets are often renamed based on the data they are holding for 

easy identification. 

 

Practice 3 

 

How to rename worksheet 

 

 

 
 

 

 
 

Fig. 2.5 

Result of the 

database after 

rearranging 

the sheets 

Right click on the sheet tab and  

Click rename option 

 

You will notice a dark highlight on 

the sheet tab. 

 

Type the new name – in this case 

JSS 1 Exams. Press any of the 4 

arrow keys to get the insertion mode 

for editing 

 

Nature of the 

database after 

renaming the 

sheets 
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3.4 Worksheet Protection 
 

Worksheet protection enables user to prevent unauthorized person to 

have access to the worksheet data. Therefore, password is necessary and 

not optional as the computer may suggest. 

 

Practice 4 

 

How to Protect Worksheet 

 

 Open the worksheet 

 Activate the tools menu 

 Locate protection and click worksheet option 

 

 

The protect sheet dialog box such as the one below will come up. 

 

 
 

Fig. 2.6 

 

Attempt to enter data or delete the existing one. What is the message? 

 

Practice 5 

 

How to remove Worksheet Protection 

 

 Open the worksheet 

 Activate the tools menu 

 Locate protection and click unprotect option 

 

Type the password you would like to 

protect the sheet. Please ensure that it 

is written somewhere. 

Click OK. Then the Confirm 

Password dialog box will come up. 

Reenter the 

password 
here again. 

Please 

maintain the 

same case. 

Click on 

OK 
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The unprotect sheet dialog box such as the one below will come up. 

 

                         
Fig. 2.7 

 

Attempt to enter data or delete the existing one again. Is it possible now?  

 

3.5 Deleting Worksheet 
 

This command allows you to remove a worksheet from the workbook. 

And bear in mind that once you execute your command, there is no way 

you can reverse the action.  

If the sheet contains data, the office assistance will bring out a warning 

message of the inherent danger of deleting a sheet. Ignore the warning if 

you really want to delete the sheet. However, bear in mind that there is 

no way you can recover the sheet. 

 

Practice 6 

 

How to Delete Worksheet 

 

 
 

Fig. 2.8 

 

3.6 Hide and Unhide Commands 
 

Columns and rows are hidden in order to bring other columns/rows 

outside the screen view into focus instead of scrolling the scroll bars. It 

makes entries of records within a database very convenient that has 

many field headings that may not be at focus at once even though the 

monitor size is 15 inches and above. However, you can reveal the 

hidden columns or rows anytime you need them by using the unhide 

command. 

 

 

Type the password that you 

have used to protect the sheet 

here. 

Click on OK 

Right click on the sheet tab 

– in this case Sheet 4 that 

contains nothing. 

Choose delete option  

 

You will notice that the sheet 

will be deleted automatically. 
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Practice 7 

 

How to Hide Column(s) or Row(s) 

 

 
 

 

 
 

Fig. 2.9 

 

Optional Method 

 

 Select the column or row 

 Activate the format menu 

 Locate row, column 

 Click on Hide command 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Select the column 

(s) or row(s). In this 

case, columns D, E 

and F are selected 

Right click on the 

selected portion 

Choose Hide 

 
You can see that after 

column C, the next 

one is column G. 

That tells you that 

columns D, E and F 

are hidden.  
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Practice 8 

 

How to Unhide Rows or Columns 

 

  
 

Fig. 2.10 

 

Optional Method 

 

 Select the adjacent row or column by the side of the hidden one  

 Activate the format menu 

 Locate row or column 

 Click unhide option. 

 

3.7 Filling Data 
 

Excel provides easy way of filling the preceding data in the next cell(s) 

instead of typing it. 

 

It saves time that would have been spent on retyping the same entry. It is 

also evident in filling series of data that have preset filling in Excel e.g. 

days, months, serial numbers etc. 

 

Practice 9 

 

Please click on sheet 2 tab for the following practical exercises 

 

How to fill in the Cell with the Contents above it 

 

Select the two 

adjacent 

columns/rows by the 

hidden columns/rows 
– in this case, columns 

C and G. Please if you 

cannot recognize the 

hidden columns/rows, 

select the whole 

worksheet. 

Right click on the 

selected portion 

 

 

 

Choose Unhide 

command 
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Fig. 2.11 

 

Type Good in cell B2 as shown below 

 

                                                            

  
 

Fig. 2.12 

 

 

 

 

 

 

 

 

 

 

 

 

The Fill Handle is 

at the right bottom 

angle of the cursor.  

The Mouse Pointer 

changes to a small cross 

when it gets to the Fill 

Handle. 

The Mouse Pointer 

changes to an arrow when 

you right click to drag and 

fill other cells. 

 

Click, hold and drag the  

fill handle through cells you 

intend to fill the value with. 

As you drag, you will notice 

the  

value at the bottom of the fill 

handle. Immediately you 

release the mouse button, the 

cells will be filled with the 

value as revealed below: 
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Optional Method  
 

Type John in cell B2 and use the following procedures to repeat it in 

cells C2 and B3 respectively. 

 

 
 

Fig. 2.13 

 

Practice 10 

 

How to Fill Days and Months 

 

Let us assume that you want to start typing days from Tuesday to 

Thursday the following week or months from January to August the 

same year; follow the method below to do that. 

 

Type the first value in any cell of your choice – in this case, Tuesday 

and January or the short forms (Tue and Jan). 

 

                                            
 

 

 
 

 

 

 

 

 

 

If you want to type John in cell C2, 

position the cursor in the cell and press 

Ctrl + R. 

 

And if you want to repeat it in the cell 

below, i.e. cell B3, position the cursor 

in the cell and press Ctrl + D.. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Click, hold and drag the fill handle through 

the cells until you reach the desired month; 

then release your mouse  

Click, hold and 

drag the  

fill handle 
through the cells 

until you reach 

the desired day; 

then release your 

mouse  

Result after 

releasing the 

mouse  
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Fig. 2.14 

 

3.8 Series 
 

Series are certain data that have preset filling in Microsoft Excel.  

 

Practice 11  

 

How to fill series of Numbers 

 

Let us assume that you intend to enter students’ serial numbers from 1 to 

90 

 

Type the first number e.g.1in the cell where you want to start 

 

                                                       

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig. 2.15 

 

3.9 Aligning Worksheet Data 
 

By default, texts are automatically aligned to the left in a cell, numbers 

are aligned to the right and logical and error values are centered. 

However, you can format cell entries and text such that the data are 

aligned the way you want – left, right or center of a cell. You can also 

extend characters across range of cells; rotate text across columns etc. 

Result after 

releasing the 

mouse  

Right click on the fill 

handle, then hold and 

drag to select other 

cells you want to fill. 

Release the mouse 

button to see the pop-

up menu such as this; 

then click on  

Fill Series 

 

You will notice that the 

selected adjacent cells 

are now numbered 

serially. This is evident 

from the result of the 

demonstration by the 

right 

 

Please extend your 

selection to many cells 

for more understanding 
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Practice 12 

 

How to Merge and Center Cells Entries 

 

The three general headings of our database are used for the practical 

exercise. Note that the general headings entries are in cells A1, A2 and 

A3 respectively; and the database last column is H. therefore, if you 

want to spread the headings across the columns, select each heading 

starting from the first cell through the last cell, or from the last cell 

through the first cell and click on merge and center Icon  on the 

formatting tools bar. 

 

         
    

  Fig. 2.16 

         

Other alignment buttons  can be used to align text to the 

left center and left of the cell. We have seen these in MS-Word already. 

 

 
    Fig. 2.17 

For example select 

the range of cells 

(A2:H2) and then 

click on merge 

and center Icon 

 on the 

formatting tools 

bar. 

 

Please do not 

select the three 

headings at the 

same time.  

For example select the 

range of cells (D5:H23) 

that contain the numeric 

data and then click on 

Align center Icon  
on the formatting tools 

bar. 
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3.10 Text Orientation  
 

Text orientation is a way of changing the direction of text to any angle 

(0
o
 – 90

o
) of your choice. It is good for field headings when a database 

contains many field headings that are needed in one sheet of a hard 

copy. 

 

Practice 13 

How to change the orientation of text to take different angles 

 

 Select the cells that contain the field headings or select the whole 

row. In this case, row 4 is selected. 

 Activate the format menu 

 Click on Cells 

 

The format cell dialog box like the one below will come up. 

 

 
 

 
 

Fig. 2.18 

 

Click on the Alignment 

tab, if it has not opened 

at default. 

Click on the red button, 

then hold and drag to 

take any angle either up 

(+ve) or down (-ve). 

Note that yours will be at 

0
o
. 

 

Also, you can type or 

scroll to get the required 

angle. 

Click on OK to execute 

your action 

Nature of the 

database after 

orientation 

 

Note: You can take 

any orientation as 

you like. For 

example, take  

-90
o
 and 45

o
 and see 

the result. 

 

Please select row 4 

and center aligned 

the field’s headings  
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3.11 Formatting Text Font, Bold, Italics Colour and 

Underline  
 

The procedures to format text font, bold, italics colour and underline in 

MS-Word is the same in MS-Excel. However, for the longer method, 

activate the format menu, click on cell option and the cell dialog box we 

used above for orientation will come up. Click on Font tab and carry out 

your formats as usual.  

 

Practice 14 

 

i. Select the general headings, apply bold format and increase the 

font size to 14 

ii. Select the fields’ headings, apply bold format and increase the 

font size to 12 

 

 
 

Fig. 2.19 

 

4.0 CONCLUSION 
 

Rows and column could be inserted into a database for more information 

whenever the need arises 

 

5.0 SUMMARY 
 

Excel database could be protected to prevent unauthorized person to 

have access to it. Although password is optional, it is necessary because 

somebody can have access to the database without your knowledge if 

password was not used. The user himself may not be able to have access 

to his data if he forgets the password, therefore you are advised to write 

password in a secret and safe place. 

 

Nature of the 

database after 

applying the 

above 

specified 

formats  
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6.0 TUTOR-MARKED ASSIGNMENT 
 

1. What is the disadvantage of deleting a worksheet from a 

workbook? 

2. Describe the position where the fill handle is located in the mouse 

pointer. 

3. You are asked to number a series from number 1 – 100. Type 1 

(one) in any cell and then use the fill handle to fill the other 

numbers i.e. 2 –100. 

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S (2000). Computer Science. (5th ed.). Gosport Hants: Asfifor 

Colour Press.  

 

Petroleum Training Institute (PTI). (1999). Lecture Manual on Word 

 Processing. Warri. 
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1.0 INTRODUCTION 
 

In addition to what you have known in Ms-Word on how to paste copied 

and cut text, as well as on how to use the paste command in Excel, how 

to position the cursor in the first cell where you want the range of entries 

and then activate the paste command- this unit considers shading and 

formats of selected cells. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 paste copy or cut cells entries 

 sort data either in ascending or descending order 

 assign number formats 

 apply pattern or shading format 

 apply border to selected cells  

 use header and footer for more information. 
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3.0 MAIN CONTENT 
 

3.1 Copying, Cutting and Pasting Data 
 

The same approaches of how to copy, cut and paste text in MS-Word are 

still applicable here. However, the aspect of how to paste copied /cut 

data is highlighted below because of some slight differences. 

 

Practice 1 

 

How to copy or Cut Text  

 

Load your document (MS-Excel Tutor) 

Let us copy the content of cells B1:D9 to sheet 3 to occupy a range of 

cells – starting from cell C3. 

 

 
 

Fig. 3.1 

 

Practice 2 

 

How to paste Copied or Cut Text 

  

Since you were asked to paste the content starting from cell C3, just 

place your cursor in cell C3 as shown below: 

 

 
 

Fig. 3.2 

 

Select the range of cells 

you intend to copy or cut. 

Use any copy or cut 

command known to you 

to copy or cut the selected 

cells. 

Hint: you can use copy 

icon  or cut icon 

 on the standard 

tools bar. 

 

You will notice a shaking 

border around the selected 

cells. Do not panic, if it is 

still there after pasting, 

press Esc (Escape) key. 

Place the cursor in cell C3 and use any 

paste command known to you to paste the 

copied or cut cells 

Hint: You can use paste icon  on the 

standard tools bar. 
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Fig. 3.3 

 

3.2 Undo and Redo Commands 
 

Please refer to the notes on undo and redo commands in MS-Word 

 

3.3 Sorting Data 
 

Sorting data in MS-Excel is similar to sorting Table data in MS-Word. It 

is used to rearrange data in a worksheet either alphabetically or 

numerically in ascending or descending order, for easy retrieval of data 

or reference to data. 

 

Practice 3 

 

How to Sort Data  

 

 Select the range of cells you want to sort. In this case, we shall 

sort the whole database. Therefore start your selection from the 

first field heading and drag to the last cell that contains the data 

of the database. Example of how to select the database before 

sorting is shown below. Please do not include the general 

headings.   

 

Note: Some of the subsequent databases are incomplete because of the 

90
o 

orientation
 
of the fields’ headings. Therefore, you should not follow 

exactly what is in the book whenever the whole database is referred to. 

It is what the screen could display by the time it was copied that you are 

seeing here. 

This is the outcome of the 

pasted cells in sheet 3 

 

The message I want to pass 

across is that you should 

not bother how you  paste 

copied or cut cells; even 

though a whole sheet is 

copied, just place the 

cursor in the first cell 

where you want the copied 

or cut cells to start and 

then paste. 
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Fig. 3.4 

 

 From the data menu choose sort. 

 

The Sort dialog box such as the one below will come up 

 

 
 

Fig. 3.5 

 

The result of the database after sorting it in ascending order is revealed 

below. Have you noticed something? Look at the four surnames – 

Okafor. In line with their first names, who comes first? Benjamin of 

course!  

Click on the down facing arrow 

() arrow by the side of Sort by 

box if you want to use another field 

heading apart from the default one, 

and then  select the field heading 

from the drop down list. 

 

Select either Ascending or 

Descending as the case may be. 

 

Click OK. 

Click on the 

first cell (A4) 
of the range, 

then hold and 

drag until the 

selection gets 

to the last cell 

(H23). 

 

Please do not 

use the row 

heading (4) to 

select. It will 

select the 

whole row. 
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Fig. 3.6 

 

In order to sort the first names in ascending order, select the whole 

database just as you did the first time. 

Activate the Data menu and click on Sort command to give you the sort 

dialog box again. 

 

 
 

Fig. 3.7 

 

The outcome of the database after using First Name field heading to 

sort is shown below. What is the situation of the Okafors now? The first 

names are now in alphabetical (ascending) order. 

 

 

Click on the dropped down arrow 

() arrow by the side of Then by 

box to select the field heading (First 

Name now) from the drop down 

list. 

 

Select either Ascending or 

Descending as the case may be. 

 

Click OK 
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Fig. 3.8 

 

Note: You can still sort the third time in a situation where the surname 

and first name are the same. For instance let us assume that we have the 

following surname, first name and middle name such as:  

 

Ayodele Oluwole Pius 

Ayodele Ahmed Sadiq 

Ayodele Oluwole Babajide 

Ayodele Kemi Shola 

Ayodele Oluwole Femi. 

 

In this case you will notice that after sorting the second time, Ayodele 

Oluwole Babajide will not be properly arranged. Therefore, you have to 

sort the third time as usual in order to arrange the middle name 

 

Optional Method 

 

 Select the range of cells you want to sort as explained under first 

method 

 Click on the Sort Ascending Icon   on the Standard Tools 

Bar in order to sort the rows in ascending order. 

 

 Click on the Sort Descending Icon   on the Standard Tools 

Bar to sort the rows in descending order. 

 

Limitations of the Optional Method 

 

i. It does not provide room for selection of a different Field 

heading. It uses only the default field heading. 

The First 

Name of the 

students 

whose 

Surnames are 

Okafor are 

now in 

ascending 

order 
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ii. There is no room for selection of second or third sort even though 

some of the names are the same.  

 

3.4 Assigning Number Format 
 

In Excel, all cells use the general number format as the default format. 

However, you can format a range to take the format you want in terms 

of numbering, date, currency etc.  

 

Practice 4 

 

How to assign a Number Format 

 

Open MS-Excel Tutor document you have saved. Select sheet 2 or 

sheet 3 to do the exercise. 

 

First, to prove that Excel does not count zero digits before real digits if 

it is not a decimal number, click any cell and type 00001, then press 

Enter key or click any cell. What do you notice? It remains only 1. 

 

Realizing that Excel does not recognize zero (0) digit before the real 

digit, and you want to prepare a database that has numbering such as 

0001, 0002, 0003 etc, format the cells that will take the numbering to 

text. 

 

 Select the empty cells you want to format. In this case column B 

is selected  

 

 
Fig. 3.9 

Activate the Format menu and 

click on cells 

Or right click on the selected 

area and then click on Format 

cells 
 

The format cell dialog box such 

as the one below will come up.   
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Fig. 3.10 

 

3.5 Formatting with Borders  
 

Although Excel Worksheet is in form of a table in MS-Word, it does not 

mean that the line borders between Columns and Rows are printable. 

They are just gridlines to guide the user. Without any border format, you 

will get an output without border.  

 

Click on sheet 1 i.e. J. S. S. 1 Exam sheet and use the database for the 

practical exercise.  

 

Select only the area that contains the data including the general 

headings. Example of such selection is shown below: 

 

 

 
Fig. 3.11 

 

Click on the Number tab, if it has 

not opened at default. 

 

Select any format option. In this 

case, Text format is selected 

 

Click Ok 

 

Type 0001 in cell B1 now and press 

Enter key or click any cell. Is it 

there?  

Place the cursor back in the cell, then 

right click on the fill handle and 

drag through the other cells to your 

desired number. 

Click on Fill Series 

Please ensure 

that your 

selection 

covers every 

part you want 

to format 

with borders 
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Practice 5 

 

How to work with Borders  

 

Activate the format menu choose cells to give you Format Cells 

dialog box like the one below: 

 

 
 

 
 

Fig. 3.12 

 

3.6 Formatting With Pattern or Shading 
 

Patterns are used to apply colour to selected cells in order to lay 

emphasis on certain entries in a database.  

 

Click on borders tab, if it has 

not opened at default. 

Select Line Style – in this case, 

thick line for outside borders 

and single for inside borders. 

 

Click on buttons or picture to 

apply borders just the same way 

we formatted tables with 

borders in MS-Word 

 

Click on Ok command 

Result of the 

database after 

formatting it 

with borders. 

 

Print Preview to 

check whether 

there are borders 

or not.  



EDA742           MODULE 3 

 

339 

 

Practice 6 

 

How to format with Patterns or Shading 

 

 Select the cells you intend to format with patterns/shading – in 

this case, select only the field headings and format them with 

yellow colour. 

 

 
Fig. 3.13 

 

 Activate the format menu and click on Cells or right click on the 

selected Cells and click Format Cells Option. 

The format cells dialog box will come up 

 

 
Fig. 3.14 

 

 

 

 

 

 

 

Selected fields 

headings  

Click on Patterns tab, if it has 

not opened at default. 

 

Select any colour or your choice 

to apply shading. This gives 

ordinary shading colour 

 

Click on the down facing arrow 

by pattern box to select pattern 

colour shading. 

 

Click on Ok command when you 

are through. 
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Fig. 3.15 

 

Optional method  

 

 Select the cell or range of cell(s) 

 Click on the Fill colour icon  either on the formatting toolbar 

or on the drawing toolbar. 

 Click on any colour of your choice.  

 

3.7 Header and Footer 
 

In MS-Word, header and footer was seen to give more information such 

as page numbering, footnotes etc about the document. In Excel the 

method of application is quite different from Word. Also, header and 

footer cannot be noticed on the worksheet except you print preview or 

print the hard copy of the worksheet. 

 

Practice 7 

 

How to format worksheet to have Header or Footer 

 

 Activate the View menu and click on Header and Footer 

command 
 

 

 

 

 

 

 

 

 

 

 

Outcome of the 

Fields Headings 

after formatting with 

yellow shading 

colour. 

 

Mine is on grayscale 

colour because of 

the print out of the 

book 
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The page setup dialog such as the one below will appear 

 

 
 

 
 

 

 

 

 

Fig. 3.16 

 

4.0 CONCLUSION 
 

The line border in excel worksheet, are gridlines lines hence they are not 

printable. Therefore any part of a worksheet where borders are expected 

to show must be formatted into boarder. 

 

5.0 SUMMARY 
 

Worksheet entries could be entered anyhow undermining the 

arrangement, because it is possible to arrange them either in ascending 

or descending order based on any field heading of your choice. 

 

Click on either Custom 

Header or Custom Footer 

to apply the header or footer 

of your choice. 

 

Here, Header is chosen. 

And when you click on it, 

the following header dialog 

box will emerge 

 

It has three sections that can 

be used for different 

headers. Click on any 

section you want to use. It is 

not compulsory that you 

must use the three. 

Click on this font 

button to format 

any of the headers, 

but you have to 

select it first 

Click on this page numbering button to apply page 

numbering. Note that you will not see the numbering in 

figures. What will appear is: & [Page]. You will see the 

real numbers in Print Preview or in hard copy. 

Click on Ok 

in the Header 

dialog box 

before you  

click on OK 

in the Page 

Setup dialog 

box 

Click to type Click on button 

to apply 

Click to type 
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6.0 TUTOR-MARKED ASSIGNMENT 
 

1. State the limitations you encounter if you use the sort icons on 

the standard tools bar to sort a data base 

2. Explain the procedure you would take to format worksheet into 

header and footer information 

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S (2000). Computer Science. (5th ed.). Gosport Hants: Asfifor 

Colour Press.  

 

Petroleum Training Institute (PTI). (1999). Lecture Manual on Word 

 Processing. Warri. 



EDA742           MODULE 3 

 

343 

 

UNIT 4 MICROSOFT EXCEL CONTINUED:   

  DATABASE 
 

CONTENTS 

 

1.0 Introduction 

2.0 Objectives 

3.0 Main Content 

 3.1 What is a Database? 

  3.1.1 Database Management System (DBMS) 

 3.2 Parts of a Database 

 3.3 Editing a Database 

 3.4 Formulae 

  3.4.1 Types of Formula 

  3.4.2 Samples of Excel Formula 

  3.4.3 AutoSum Command 

 3.5 Functions 

 3.6 Filtering a Database 

  3.6.1 Custom AutoFilter 

  3.6.2 Wild Cards 

 3.7 Printing 

4.0 Conclusion 

5.0 Summary 

6.0 Tutor-Marked Assignment 

7.0 Reference/Further Reading 

 

1.0 INTRODUCTION 
 

The usefulness of database in the administration of every organisation 

cannot be over emphasised. In this unit, you will see how a database is 

created and used to get information as fast as possible. 

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 define a database and DBMS 

 identify parts of a database  

 create a database and edit it  

 define format and know types of formula in Excel  

 describe samples of Excel formula  

 state how to use ‘AutoSum’ to sum up.  
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3.0 MAIN CONTENT 
 

3.1 What is a Database? 
 

Database is a comprehensive, consistent, controlled and coordinated 

collection of structured data items. In another form, it is a collection of 

huge amount of data under different fields made up of Records. Excel 

allows you to create a database on a worksheet. By using your 

worksheet data as a database, you can easily store and manipulate 

complex data or large amount of data. 

 

3.1.1 Database Management System (DBMS) 
 

This has to do with a programme which has access to all of an 

organisation’s master files (i.e. database) and which can be used to 

interrogate files and generate required report.   

 

DBMS provide facilities for different types of file processing for 

example, it can  

 

i. Provides a complete file (serially or sequentially). 

ii. Process required records (selective, sequential or random). The 

HOD may specify his requirement by instructing examination 

officer with pseudo-English statement e.g. “show students who 

are below average.” 

 

DBMS also has the function of providing security for the data in the 

base- for instance, protecting data against unauthorised access. 

 

However, apart from the overall database of the entire organisation, 

individuals, departments and faculties can maintain their own database 

on Spreadsheet Management System for accurate and timely 

information acquisition and dissemination. 

 

3.2 Parts of a Database 
 

Before you can create a database, you need to understand and know the 

various parts of a database. 

 

Field: The first row of the database contains the fields. Each column in 

a database is a separate field, and each of the cells within a column is a 

field which stores a basic unit of information e.g. Name Age, sex, etc. 

  

Field name: A field name is a name that identifies the data stored in a 

field. The top row of a database must contain the field names; each 
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column must have a field name. Though field names can take a 

maximum of 225 characters, it is best to keep field names brief. 

 

In the figure below, Name, I. D. Number, Course fee etc are examples 

of field names. 

 

 
 

Fig. 4.1 

 

Data base Range: A database ranges is a rectangular range of a 

worksheet cell used as database;  

 

Record: A record is a single row in a database   

 

Computer Field: is a field that contains formula or functions. 

 

How to create a Database 

 

 Enter the field names.  

 Enter the records in the rows below the field names.  

 

Remember that we have already created one (Excel Tutor) in unit 1 of 

this module, formatted and edited it in unit 2. We shall still continue 

with it. Therefore if you have deleted your own, try to build another one. 

 

3.3 Editing a Database  
 

You can edit a database using any of the editing techniques for 

worksheet, such as adding or deleting rows cutting or copying and 

pasting data. Please refer to unit 1 and 2 of this module. 

 

3.4 Formulae 
 

A formula is a set of instruction coded for calculation. It is made up of 

constant values; cell references names, functions or operators that 

produce a new value from existing value. Formula must be preceded 

with an equal to (=) or plus (+) or at (@) signs e.g. =C7 +B5, @SUM 

(D2:K14), +D5*F5, =PRODUCT (A1, D3, G5, H2), +AVERAGE 
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(A1:E15) etc. In brief, a formula cell must have the sign of equality (=), 

a function e.g. SUM and an argument e.g. M2:Q6 

 

Operations such as addition, multiplication, comparison on the 

worksheet are performed with formulae. A formula combines value with 

operators to produce results.  

 

3.4.1 Types of Formula 
 

There are three types of formula 

 

Arithmetic Formula: It calculates with numeric value using the 

arithmetic operators like +, -, *, ^, / 

 

Text Formula: It calculates with text operator content of a cell. For 

example, the word Kayode in cell D3  

 

Logical Formula: It compares two more values using relational 

operators like > (greater than), < (less than), = (equal to), >= (greater 

than or equal to), <= (less than or equal to),   

 

Operators: These are mathematical symbols such as:  

 

+          Addition 

-           Subtraction 

/ Division 

* Multiplication 

^          Exponential 

%  Percentage 

 

3.4.2 Samples of Excel Formulae 
 

=SUM (A4…K4) or =SUM (A4: K4) Sums up all the value in cells 

A4 to K4      

=SUM (G2, Z10) or =G2+Z10            Sums up all the values in cells 

G2 and Z10 

=AVERAGE (D4: H4)                     Computes the average value of 

all the numbers in cell D4 to H4 

 

Note: Always try to ensure that the cursor is in the particular cell where 

you want the answer to your calculation to appear. Please do not press 

space bar in order to apply space (gap) when typing a formula. No 

space in between characters of a formula. 
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Practice 1 

 

Required: Calculate the total and average 

 

 
 

Fig. 4.2 

 

 Enter the cells entries exactly the way they are in the worksheet. 

If you are using cells range that is different from mine, make sure 

that you use the cell argument accordingly. 

 

 To calculate the total, type =Sum (A2:C2) and press Enter Key 

or click Enter  icon on the formula bar. 

 

 To calculate the average, type =Average (A2:C2) and press 

Enter Key or click Enter  icon on the formula bar. 

 

Practice 2 

 

Required: Calculate gross and tax. Tax is given as 5% of basic salary. 

 

  
 

Fig. 4.3 

 

 To calculate gross, type =C4+D4 and press Enter key.  

 To calculate tax, type =C4*5% and press Enter key.  

 

3.4.3 AutoSum Command 
 

It is used to sum up numbers in a row or column automatically without 

imputing the formula yourself. 

 

Practice 3 

 

How to use the Auto Sum 

 

Type the following data 
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Fig. 4.4   

 

Note: If you double click the AUTO SUM button, the sum value of the 

area in question will be computed automatically.  

 

3.5 Functions 
 

Microsoft Excel provides many other statistical and engineering 

worksheet functions that are of immense assistance when doing 

calculation of any sort. However explanation is given to few that relates 

to our course.  

 

Integer Function: This function truncates the decimal part of a numeric 

entry and returns only the integer part. It does not approximate to the 

nearest whole number. It simply chops off the decimal part. 

 

Round Function: This function approximates a numeric entry to the 

number of decimal place specified in the function argument, i.e. suppose 

cell B4 has entry 34.4772 and you want to round it to 2 decimal places, 

you will just type =Round(B4,2); and press Enter key to get 34.48 as the 

answer. 

 

If Function: It returns one value if a condition you specify evaluates to 

true and another value if evaluates to false 

Place the cursor in the cell where you 

want your answer to be, and then click 

AutoSum  icon on the Standard 

tools bar 

 

The formula that you suppose to type 

will appear on the formula bar 

 

Also, you will notice a wavy selection 

round the range of cells 

 

Press Enter Key or click Enter  

icon on the formula bar. 
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Practice 4 

 

How to round up and find Integers if Numbers 

 

Calculate the integer and round functions of the following entries. The 

decimal places (d.p) to round up to is 2 

 

 

 
 

       

 
 

Fig. 4.5 

 

Note: Supposing you were to round up to 3 decimal places in the round 

function above, then you will type =Round(A2,3).  

 

If Function: Emphasis is laid on the If Function because of its 

importance in analysing logical test. 

 

If you are not practicing with your Excel Tutor document, please load it 

to enable us do our practical exercise with JSS 1 (Sheet 1) database in 

Excel Tutor. 
 

Let us extend our field’s headings to Total, Average and Remarks as 

shown below: 

To calculate the integer of the first number, 

place the cursor in cell B2 and type =Int(A2) 

 

Press Enter Key or click Enter  icon 

on the formula bar. 

 

To calculate the round function of the first 

number to 2 decimal places, place the cursor 

in cell C2 and type =Round(A2,2) 

 

Press Enter Key or click Enter  icon 

on the formula bar 

After gotten the answer to the first 

number, place the cursor back in the 

cell that contains the answer, then 

click, hold the fill handle and drag to 

extend the formula to the adjacent cells 

below.  

 

Please do no waste your time by 

calculating for each number. 
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Practice 5 

 

Required:  
 

1. Calculate the total and average, using any suitable Excel 

formula. 

2. Remarks should show Pass for those students whose average is 

greater than or equal to 50, and Fail for those whose average is 

less than 50.  

 

Hint:  Carry out whatever calculation you intend to do with any record 

in the database, and then use the handfill to extend your formula 

to the others. However, it is suggested that you should practice 

with the first record so that you can easily use the handfill to drag 

down and extend the formula to other records below. 

 

Note: Your database records are more than what you are seeing here. 

 

 
 

Fig. 4.6 

 

i) To calculate total, place the cursor in cell I5 and type 

=sum(d5:g5) and press Enter key or click Enter  icon on 

the formula bar. You can also use the AutoSum command 

here. 

 

ii) To calculate the Average, place the cursor in cell J5 and type 

=Average (d5:g5) and press Enter key or click Enter  icon 

on the formula bar 
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iii) To calculate the Remarks, place the cursor in cell K5 and type 

 and press Enter key or click 

Enter  icon on the formula bar. 

Note: The IF Function is a logical test expression which you use to 

instruct the computer to give remarks as Pass to the student whose 

average in cell J5 is greater than or equal to 50; otherwise the computer 

should output Fail as remarks. 

 

In the formula, Pass and Fail are in double quote because the computer 

has to output them directly. Anything you want to get back as you 

entered it in a formula must be in double quote. Please do not type single 

quote twice to mean double quote. They are not the same. Hold the Shift 

key to type double quote. 

 

For the brackets in a logical formula – count the number of times the 

open bracket was applied, and close the formula with the same number. 

From the example above, open bracket was used twice, therefore the 

formula was closed with two. Please do not use square bracket []. 

 

Please apply Commas (,) instead of space (gap) as indicated in the 

above formula. Remember that there is no space in between the 

characters of a formula.  

 

Nested If Function: When you specify more than 2 (Two) IF Logical 

Test Function, it is then known as nested IF Function. The following 

example will give a clear picture of Nested If Function. The Grades: A, 

B, C, D E, F, were derived by using the Nested If Function as revealed 

on the Formula Bar below: 

 

 
Fig. 4.7 
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Practice 6 

 

Question 

 

A colleague of yours doubts the benefits you will derive from EDA 183. 

Prove to him using the above database to let him know how he can 

reduce or eliminate the problems of errors, fatigue etc, he always faces 

in calculating his student’s records in order to arrive at grades A, B, C, 

D, E, and F; that all he needs to do, is to calculate any of the student’s 

grade and extend it to others within some minutes.  

 

(Department of Educational Administration, University of Lagos, MIS, 

EDA 813 2002 / 2003 Session). 

 

Hint: Know that the normal way of calculating grades is 70-100 A; 60-

69 B; 50-59 C; 45-49 D; 40-44 E and 39 below F. The nested IF 

function is the best function to apply since there is need for multiple 

outcome of the function.  

 

How to use the Nested IF Function to calculate the grades in the 

database. 

 

Place the cursor in the cell where you want the first value to appear – in 

this case, cell G2. 

 

Type the formula like this: 

 

 
Use the Fill Handle to extend the formula to the adjacent cells below. 

Press Enter key or click Enter  icon on the formula bar. 

 

Note: Try to edit the formula through the formula bar in case any 

mistake is made 

 

3.6 Filtering a Database 
 

Most often, a database occupies several rows of records that cut across 

so many pages of the worksheet; therefore there are always difficulties 

in searching for a particular record or group of records. 

 

Filtering a database is a way of systematically searching for records that 

the specific criteria set meet.  

 

Filtration of a database using the AutoFilter or Custom Auto filter will 

reveal all records that match the set criteria at a glance. 
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Practice 7 

 

How to use the AutoFilter  

 

For the practice of filtering a database, we shall create a database like 

the one below for Faculty of Education, XYZ University. You are free 

to create it in any sheet of your choice. 

Fig. 4.8 

 

 Ensure that the cursor is in any cell of the database you want to 

 apply the AutoFilter to. 

 Activate the Data menu to get a pull down of options from the 

 menu.   

 From the options that pop up, locate Filter and click on 

 AutoFilter.  
 

Look at the Fields Headings now. What do you observe? There is a 

down facing arrow at the right hand side of each and every Field’s 

Heading of the database  

 

Names 

I.D.  

Number 

Date of 

 birth Sex State Local Govt Address 

Marital 

status Dept 

Magnus 

Raymond 345 06-Apr-76 M Lagos Epe 10, Alade Street Single Adult Educ 

Jimoh Henry 567 07-Jan-70 M Oyo Ibadan West 23,Apata Street Single Curriculum S. 

Niyi Patrick 743 09-Dec-72 M Ogun Iju 

12th Lane Adegun 

Estate Married Educ Admin 

Bello Sroyis 645 01-Feb-74 M Edo Oredo 103, Akpakpava road Single PHE 

Mamadu Silas 257 02-Nov-68 M Kaduna Samaru 56,  Kufena Road Married Curriculum S 

Olatunde Philip 281 04-Mar-69 M Lagos Oshodi 38,Damode Lane Married Adult Educ 

Yahaya Jumai 423 05-Oct-75 F Kano Sabo Garri 7, Aminu Road Married PHE 

Zachaeus Odion 524 05-Aug-80 F Edo Esan West  92, Campus Street Single Educ Foundation 

Nisikak Idio 624 07-Jun-68 M 

Akwa 

Ibom Esien Udim 49, Uyo Road Married Curriculum S. 

Akpan Comfort 341 08-Jul-70 F 

Akwa 

Ibom Uyo 87, Ekpenyong Street Married Adult Educ 

Edidiong 

Ekeleku 262 11-Mar-81 M 

Cross 

River Calabar Gold Staff Quarters Married PHE 

Mainasara Saliu  422 10-Apr-67 M Kano Chalawa Kabuga Quarters Single Curriculum S. 

Ekpe Oghenane 622 10-May-80 F Edo Estako East 

13,Polythecnic Rd. 

Auchi Married Curriculum S. 

Bala Abubakir 138 06-Feb-68 M Kaduna Zaria North 14, A.B. Way Samaru Single Educ Admin 

Aloy Ihom 124 12-Apr-71 M Benue Gboko 17, J.S. Tarka way Married Adult Educ 

Olawole Ayodeji 625 07-May-82 M Lagos Oshodi 12, Audu Street  Married Adult Educ 

Aziza Ejiro 336 06-Dec-75 F Delta Effurun 106, P.T.I. Road Single Educ Admin 
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Fig. 4.9 

 

Practice 8 

 

How to filter a Database to get One Record 

 

Let us assume for instance that you are asked to bring out Comfort 

Akpan’s information. 

 

You can use any of the Fields Headings to get her record, but use 

NAMES since her name is known  

 

 Click on the down facing arrow by NAMES field heading  

 You will notice a pull down menus of all the names in the 

 database 

 Click on any name you want to view its record. In this case 

Comfort Akpan is chosen.  

 

Her record will show like the one below: 

 

 
 

 

Fig. 4.10 

 

Down facing 
arrows by 

the side of 

the fields’ 

headings for 

Filtration. 

Nature of the 

database after 

applying 

Autofilter 

Position of the database after filtration  
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Practice 9 

 

How to regain the whole Database after Filtration 

 

 Click the down facing arrow by the side of the field’s heading 

used for that particular filtration 

               

 
 

 Click on the All option.  

 

Fig. 4.11 

 

Practice 10 

 

How to view Records sharing Common Elements 

 

For example, let us reveal staffs that are from Edo state. 

Click on the down facing arrow by the side of State i.e. column E, and 

then click Edo. 

       

 
Fig. 4.12: Filtered Database to Reveal Staff from Edo State 

 

3.6.1 Custom AutoFilter 
 

Custom AutoFilter is used to set more complex criteria. Criteria such as: 

equal to, greater than, less than etc could be assigned to a numeric 

field (a field that is made up of a numeric digit); and criteria such as 

begins with, ends with, does not begin with, contains etc could be 

applied to a Text field. There is room to specify more than one criterion; 

also, wild cards could be used to set criteria here.  

 

Practice 11 

 

How to use Custom AutoFilter 

 

We shall use Excel Tutor document you have created for this exercise, 

therefore open it to practice with it. 
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Let us assume that you are asked to search for those students whose 

averages are less than (<) 50 or greater than (>) 60  

 

 Ensure that the cursor is in any cell of the database.  

 Activate the Data menu.  

 Locate Filter and click on AutoFilter. 

 

 
Fig. 4.13 

 

 Click on the down facing arrow by the side of the field in 

question – Average in this case. 

 From the pull down menu, select Custom  

The following Custom AutoFilter dialog box will appear 

                     

                  
   

 

Click on the down 

facing arrow to select 

the first relational 

operator (is less than) 

and type the criteria 50  

Click on Or in order to 

set second criteria 

Click on the dropped 

down arrow to select 

the second relational 

operator (is greater than) 

and type the criteria 60 

 

Click on OK when you 

are through. 
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Fig. 4.14 

 

3.6.2 Wild Cards 
 

Wild Cards are the Asterisk (*) and the Question mark (?). They are 

used to set criteria in situation where you want to use characters alone as 

criteria especially when the information about the particular record you 

want to search out is vague. * is used for multiple character selection, 

while? is used for single character selection.   

 

Practice 12 

 

How to use asterisk (*) and question mark (?) to set criteria  

 

You are required to search for staff whose names start with letter 

(character) M and other character could be anything.  

 

 Click the down facing arrow by the side of the field’s heading – 

in this case, NAMES and click on Custom. 

The Custom AutoFilter dialog such as the one below will come 

out. 

Result of the Database revealing students whose 

averages are below 50 or above 60.  
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Fig. 4.15 

 

Practice 13 

 

How to use question mark (?) to set criteria  

 

You are required to search for staff who are from 5 letters (5 

characters) state.  
 

 Click the down facing arrow by the side of the field heading – 

in this case, STATE and click on custom. 

The Custom AutoFilter dialog such as the one below will come 

out. 

 

 
 

 

Click on the down 

facing arrow to 

select the 

relational operator 

base on the criteria 

you will set. 

Type the criteria 

M*. This means 

that the first 

character must be 

M and others 

could be any 

character 

Click on OK when 

you are through. 

  

Type the criteria 

????? This means 

that any state that 

is 5 characters will 

come out. 

 

Click on OK when 

you are through. 

Result of the 

Database revealing 

staff whose names 

start with character 

(letter) M  
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Fig. 4.16 

 

Practice 14 

 

How to Remove the Arrows by the Side of the Fields’ Headings 

caused by the Auto filter. 

  

 Position the cursor in any of the cells. 

 Activate the data menu. 

 Locate filter and uncheck AutoFilter. 

 

3.7 Printing 
 

There is no much difference between Word Printing and Excel Printing. 

The only area where there is slight difference is: page layout and 

margins. And you must print preview of the worksheet in order to see 

how the document is before printing.  

 

Practice 15 

 

How to Print Preview 

 

 Open the document (Excel Tutor) and click to ensure that the 

cursor is in any of the cells that contain the data. 

 Activate the File menu and click on Print Preview or click on 

Print Preview icon  on the Standard tools bar 

The Print Preview window such as the one below will open  

 

 

Result of the Database 

revealing states with 5 

characters  
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Fig. 4.17 

 

After you have printed Preview and returned to the document, you will 

notice some horizontal and vertical doted lines. These lines indicate the 

margins of each page – left/right and top / bottom. If you are not in 

agreement with the outcome of the Print Preview, click on Page Setup 

from the File menu in order to set the margins. 

 

Practice 16 

 

How to print a document 

 

 Open the document e.g. (Excel Tutor) and click to ensure that 

the cursor is inside the document. 

 Activate the File menu and click on Print or press Ctrl + P on 

the keyboard. Please do not use the Print icon  on the 

Standard tools bar at first printing because it will not give you 

the print dialog box for printing set-up 

 

Click on the 

Zoom button 

to zoom to 

see details of 

the previewed 

page 

 

Click on the 

close button 
to close 

Preview 

window  
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The Print dialog box like the one below will appear  

 

 

 
 

 

 

 

 

 

Fig. 4.18 

 

4.0 CONCLUSION  
 

With excel formula and function, difficult and time wasting calculation 

could be done at ease and the result could be 100% correct. However 

remember the computer slogan   “garbage in, garbage out”. If you coded 

wrong formula, the computer might give wrong answer or no answer at 

all. 

 

5.0 SUMMARY 
 

Excel formula must be preceded with the sign of equality (=) or plus (+) 

or at (@). And there should be no space in formula entries. 

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. It happened that you maintained the records of about 700 students 

with spreadsheet management. One day, at the departmental 

meeting there was a kind of special concern about the mass 

failure of students offering your course. Subsequently, you were 

asked by the HOD to go and adjust the result by adding 5 marks 

to the total of those students who are less than or equal to 39. 

 

Click on the down 

facing arrow to select 

printer, if you have more 

than one printer installed 

 

Click on Properties to 

select orientation under 

Layout i.e. Portrait or 

Landscape. The Paper 

size is also selected 

through this medium if it 

is on automatically 

select 

 

Type or scroll to enter 

the number of copies 

you want a page to 

produce. 

 

 

 

 

 

In Print range section, select All - for all the pages to be printed; select Pages if you 

want to type the particular page number which should be printed first in the edited box 

of From and the last page in the edited box of To. You can repeat the same page 

number, if you want to print out only that page e.g. From 2    To 2. 
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Use the following sample to show how you gave them a big surprise by 

forwarding the adjusted result within 10 minutes while the meeting was 

still going on. 

 

Note that you have to calculate the adjusted total and new grades.    

 

    
 

(Dept. of Educational Admin, Faculty of Education, University of 

Lagos, MIS, EDA 813 2002 / 2003 Session). 

 

Hint: according to the question, you are asked to add 5 marks to the 

Total of those who are Less than or equal to 39 and nothing to those 

who are 40 and above. All you need to do is to use the IF function to add 

the marks and then calculate the new grade based on the adjusted total as 

follows:  

 

Place the cursor in cell H2 and type the formula for the adjusted total 

. 

Also, place the cursor in cell I2 to calculate the new grade with this 

formula

 
You will notice that most of the students have passed now. 

     

2. What are the functions of DBMS? 

 

7.0 REFERENCE/FURTHER READING 
 

French, C.S. (2000). Computer Science. (5th ed.). Gosport Hants: 

Asfifor Colour Press.  
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UNIT 5 MICROSOFT EXCEL CONTINUED: CHARTS 
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 3.2 Parts of a Chart 

 3.3 Chart Selection 

 3.4 Formatting Chart 

4.0 Conclusion 
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6.0 Tutor-Marked Assignment 
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1.0 INTRODUCTION  
 

This unit considers means of representing information in simple charts 

or graphs which are powerful means of disseminating information. With 

Microsoft Excel, you can plot two-dimensional and three-dimensional 

charts types. In excel, you have standard and custom types of chart. 

Custom contains B&W (black and white) and other special charts in 

colour, in addition to types of charts that standard contains.  

 

2.0 OBJECTIVES 
 

At the end of this unit, you should be able to: 

 

 learn how to insert Chart  

 identify the different parts of a Chart  

 select Chart item or part 

 format different parts of a Chart. 

 

3.0 MAIN CONTENT 
 

3.1 What is a Chart? 
 

A chart is a graphical representation of work sheet data, which is also 

called graph.  

 

Excel allows you to create a chart directly in a worksheet or as a 

separate document in its own window. Before you can create chart, you 

must first enter the data to be used to plot the chart in a worksheet. 
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Practice 1 

 

How to create a Chart  

 

We shall use only pie and bar (column) charts for illustrations. 

However try to plot many other chart types on your own, using the same 

information.  

 

You have been asked by the administrator of River Side Grammar 

School to assist him to represent the following students’ population 

information on a pie chart: 

 

JSS 1 455; JSS 2 320; JSS 3 525; SSS 1 240; SSS 2 630; SSS3 150.   

 

 
 

Place the cursor in any of the cells that contain the data or Select the 

range of cells that contain the data. 

Fig. 5.1 

 

 Activate the Insert menu and choose Chart or Click the Chart 

Wizard tool  on the Standard Tools Bar 

A chart wizard dialog box will appear. The Chart Wizard guides you 

through the steps required to create a chart. 

Enter the data either in column form or in 

row form as entered here. 
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Fig. 5.2 
 

Click Standard Type tab 

or Custom Type tab  

 

Select any Chart Type 

of your choice from the 

Chart Type category. 

In this case, Pie is 

selected  

 

Select any Chart sub-

type of your choice 

from the Chart sub-

type category. In this 

case, the first Pie is 

selected  

 

Press and hold the 

mouse to view the 

sample of the chart 

sub-type you have 

selected 

Click on Next tab to go 

to the next step i.e. step 

2 

Step 2 shows you the range 

and series you are using. 

Please do not alter the default 

selection. 

 

My default selection is on 

rows because I used the range 

of cells entries in rows. Yours 

will be in column if you 

entered your data in column 

form. 

 

 

 

Click on Next tab to go to 

step 3  

Please always try to look at the name of 

any selected chart sub-type here. 
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Fig. 5.3 

 

 

Click on Title tab in order 

to type the title. For 

example, RSGS Students’ 

Population Pie Chart is 

typed as the title. 

 

Categories axis X and Y 

may be active when 

plotting other types of 

charts  

Click on Legend tab 

in order to reposition 

the legend. A legend 

is just like a key to a 

map. It shows what 

the chart is all about. 

Here, it is positioned 

by the right of the 

chart.  

 

Unchecked show 

legend in order to 

have more space for 

the chart, then, use 

data labels to depict 

what you want the pie 

sectors to reveal. 

Click on Data Labels tab 

in order to provide more 

information which the 

legend might not provide 

 

I checked category name 

and percentage for the 

information of each sector 

name and percentage   

 

Click on Next tab to go 

the final stage (Step 4). 



EDA742           MODULE 3 

 

367 

 

 

 
 

 

 

 

Fig. 5.4 

 

 
Fig. 5.5 

 You are required to present with a Bar chart the population 

information of Palm Day Private Secondary School for the year 

2001-2006. The data given are as follows: 

 

   2001 2002 2003 2004 2005 2006 

T. Staff    25   27   30   40   35   30 

N. T. Staff     8   14   12   18   10   15 

Students    75  100  120   80  150  115 

 

 

 Enter the data in any sheet, starting from any cell of your 

choice, but do not jump any cell in between the range of cells. 

Example of how to enter the data is shown below:  

 

Click to select As new 

sheet option so that 

the chart will appear in 

its own sheet.  

 

Click to select As 

Object in option so 

that the chart will 

appear in the sheet that 

contains the data you 

used to plot it.  

 

Click on Finish tab to 

execute your action. 

 

Note: It is ideal that you plot the chart on a 

different sheet of its own, therefore choose 

the first option 

 

It will appear as 

chart 1 in a 

separate sheet in 

between the 

sheet tabs on the 

scroll bar  
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 Select the whole range of cells that contain the data or place the 

cursor in any of the cells that contain the data 

 Activate the Insert menu and choose Chart or Click the Chart 

Wizard tool  on the Standard Tools Bar 

 

A chart wizard dialog box like the one in practice 1 will appear.  

 

 
Fig. 5.6 

 

 

Column is selected under chart 

type and  

Clustered Column is selected 

under Chart sub-type. 

 

Click on Next to go to step 2 

 

Step 2 reveals the range of 

the data you are using to plot 

the graph. 

 

As said in practice 1 above, 

nothing is done here. Accept 

the default selection. 

 

Click on Next to go to step 3 
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Fig. 5.7 

 

Note: you can give more information by using other tabs, but it is 

advisable not to load the chart with too much of information. You will 

notice that I did not use data labels here and legend is now left to give 

information with the colour of the bars. 

 

 
Fig. 5.8 

 

 
Fig. 5.9 

 

Click on Title tab so that you 

can enter all the necessary titles 

as follows 

Click and type the chart title – 

Palm Day Private Sec. Sch. 

Population Bar Chat. 

 

Click and type the title – Year 

for X-axis  

 

 

Click and type the title – 

Number for Y-axis  

 

Click on Next to go to the final 

stage – Step 4. 

 

Click to select As new 

sheet. 

 

Click on Finish to 

complete your action. 

 

It will appear as 

chart 2 if you are 

still using the  

same book. 
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3.2 Parts of a Chart  
 

A chart displays different parts peculiar to its type. For example, a 

column or bar chart will display parts as labeled on the chart below. 

Almost every chart has these parts.  

 

 

 

            
 

 

Please point to each labeled part for identification. The name will 

appear when you point at it. 

Fig. 5.10 

 

3.3 Chart Selection 
 

You must first select a chart item before you can format or edit it. If no 

chart item is selected, most of the format menu commands will be 

unavailable and the formatting bar will be blank. 

 

Practice 3 

 

How to select Part or Item of a Chart  

 

 Click once on the particular Item. But if the parts are in series 

like the column chart above, click once to select the whole data 

series (N Staff, N T Staff and Students), then click once again to 

select a particular series e.g. N Staff.  

 

Chart Title 

Plot Area 

Plot Area 

Chart Area 

Legend 

Data 

Series 

Value Axis Title 

Value Axis 

Category Axis Title Category Axis  
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3.4 Formatting Chart 
 

Parts of a chart are formatted to give varieties of colour, font sizes, 

orientation etc. You may wonder that your chart is different from mine. 

Why? I formatted the sectors and bars of my charts to take pattern 

colour, since the output will be on black and white hard copy. I even 

removed the background of the second graph. 

 

Note that you will get peculiar type of format dialog box based on 

whatever part of the chart or item you have selected. For instance the 

format dialog box that will appear when plot area is selected is quite 

different from the one that will appear when chart title is selected. 

  

Practice 4 

 

How to format different Parts of a Chart 

 

 Click to select the particular part or item of the chart you want to 

format. Please click twice (not double clicking) to select the 

particular bar representing the series.  

 Press Ctrl + 1 on the keyboard  

 

The format dialog box such as the one below will appear. 

 

 
 

Click on Pattern tab if it is not 

already opened  

 

Click on any colour of your 

choice to apply colour 

 

Click on Fill Effects to apply 

pattern colour through the dialog 

box that will come up. 

 

Example of such Fill Effect 

dialog box is shown below  
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Fig. 5.11 

  

Note: You can also use the following optional methods to get format 

dialog after selecting the chart part or item. 

 

Optional method 1 

 

Activate the format menu and click on selected xxx (xxx represents 

what ever part or item that is selected. For example, if axis title is 

selected, you will see selected axis title). 

Optional method 2 

Click on the format xxx  icon on the chart tools bar. Please 

remember that xxx represents the name of the selected chart part. For 

instance, from the chart tools bar below, the name of the selected part is  

 

Legend 
 

      
 

 

 

Fig. 5.12 

 

Optional Method 3 

 

Double click on the part on the part you intend to format. Selection 

may not be needed when using this method.   

 

The Chart Tool Bar normally comes out with the inserted chart. However, you can 

reveal it if is hidden with any method of how to reveal hidden tools bar. 

The Chart Tools Bar  

Change the Foreground 

and Background colours 

to the desired ones. In this 

case, Foreground is white 

while Background is black. 

 

Click to select any pattern 

colour 

 

Click on OK to carry out 

your formats. 

Click on OK again on the 

cascaded Format Series 

Data dialog box. 
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Optional Method 4 

 

Right click on the selected part and then click format xxx 

Please use any part e.g. chart title to see whether all the above options 

will give you the same dialog box.  For example: Change default font 

size of chart title to 9.and color to Blue.     

 

4.0 CONCLUSION  
 

There are four steps to take to plot a Chart in Excel and at the final step, 

you have two options to choose from: As new sheet and As object in As 

a new sheet option will make the chart to appear in its own sheet. While 

As object in will make it to appear in the sheet that contains the data you 

use to plot it.  

 

5.0 SUMMARY  
 

Format dialog box of a chart comes up based on the part of the chart or 

items that was select   

 

6.0 TUTOR-MARKED ASSIGNMENT 
 

1. 
Products Jan/Feb Mar/Apr May/Jun Jul/Aug Sep/Oct Nov/Dec 

CPU 20000 10000 16500 10000 15000 1800 

Monitor 15000 8000 19000 11000 20000 7000 

Mouse 12000 18000 20000 17000 9000 15000 

Keyboard  9000 15000 7000 19000 10300 12500 

 

i) Represent the data above on a column chart.  Use the 

standard type 

 ii) Title should be Virgo Praedicanda Computers Bi-monthly 

  Sales. 

 iii) Plot chart on a separate sheet. 

iv) Format all columns (bars) colour to show black and white. 

Note that pattern colours should be used for the purpose of 

distinctiveness. 

 v) Show legend on the right hand side of the chart. 

 

2. NOUN has the following number of students from the six major 

cities in Nigeria – Kano, Kaduna, Abuja, Port-Harcourt, Enugu 

and Lagos.  
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Given the data below: 

 

Kano  45 

Kaduna 28 

Abuja  50 

P. Harcourt 35 

Enugu  20 

Lagos  65 

 

You are asked to plot: 

 

i) Standard type – lines with markers under chart Sub- type 

ii)  Custom type – Cones. 

  

Show cities names on the X- axis and prospective student’s numbers on 

the Y-axis. 

 

7.0 REFERENCES/FURTHER READING 
 

French, C.S (2000). Computer Science. (5th ed.). Gosport Hants: Asfifor 

Colour Press.  

 

Petroleum Training Institute (PTI). (1999). Lecture Manual on Word 

 Processing. Warri. 

 

 


